Copyright Notice

Copyright© 2008 Visure Solutions, S.L.
All rights reserved.

This document may not be reproduced or transmitted in any way or by any electronic or mechanical means, including photocopying, recording, or any other means, without the express permission of VISURE SOLUTIONS, S.L.

All of the material contained in this document has been developed by VISURE SOLUTIONS, S.L. and is the property of VISURE SOLUTIONS, S.L.

IRQA® is a registered trademark of VISURE SOLUTIONS, S.L.
The other products mentioned are the property of their respective companies.

Visure Solutions, S.L.
C.I.F.: B-85080554
Headquarters:
Av. de los Labradores, 1, 4th Floor
28760 – Tres Cantos (Madrid)
Spain
Table of contents

INTRODUCTION ........................................................................................................................................................13

HOW IS THIS MANUAL ORGANIZED? ....................................................................................................................14

INTRODUCTION TO REQUIREMENTS ENGINEERING WITH IRQA®.................................................................16
  Requirements Engineering with IRQA®.............................................................................................................16
  Methodology of IRQA® solution: Meta-IRQA®..............................................................................................17
    Basic Process.................................................................................................................................................17
    Support Processes.....................................................................................................................................17

FIRST STEPS WITH IRQA®......................................................................................................................................18
  How to run IRQA® ..........................................................................................................................................18
  Opening a project...........................................................................................................................................19
  Selecting an active baseline..............................................................................................................................21
  Text views and graphic views............................................................................................................................22
  Users and access partitions...............................................................................................................................23

General tool bars................................................................................................................................................25
  Project button bar .........................................................................................................................................25
  Requirement capture and Analysis button bar ..............................................................................................25
  Blocks button bar .......................................................................................................................................26
  Elements buttons bar .................................................................................................................................26
  Version control button bar ...........................................................................................................................28
  Domains button bar ....................................................................................................................................29
  Tools button bar ..........................................................................................................................................29
  Integrations button bar ...............................................................................................................................29
  Solution specification and Testing button bar ............................................................................................30
  Reusability button bar ...............................................................................................................................30
  General options of the element buttons ......................................................................................................31
  General options of the buttons bars .............................................................................................................31
  Diagram zoom bar ......................................................................................................................................31
  Diagram graphics bar .................................................................................................................................32
  Diagram layout bar .....................................................................................................................................33
  General options in the diagrams ..................................................................................................................34
REQUIREMENTS CAPTURE ....................................................................................................................................36

Requirements view ........................................................................................................................................36
  Default requirement view .............................................................................................................................37

Requirement grid panel ................................................................................................................................38
  Column inclusion and exclusion ..................................................................................................................39
  Ordering requirements ...............................................................................................................................40
  Filter selection ............................................................................................................................................40
  Edit modes on the grid panel .......................................................................................................................41
  Available options on the grid panel ............................................................................................................43
  Special options on the grid panel ..............................................................................................................47
  Document View ..........................................................................................................................................47
  Requirements list filtering ...........................................................................................................................53

Requirements view management ..................................................................................................................53
  Creation of requirements views ................................................................................................................53
  Modification and deletion of requirements views .......................................................................................54
  Selection of requirements views .............................................................................................................55
  Sharing requirements views ......................................................................................................................55

Requirements description panel ..................................................................................................................56
  Advanced edition options ..........................................................................................................................57

Tab panel in the requirements view ..............................................................................................................58
  Details Tab ................................................................................................................................................59
  Blocks and Attributes Tab ........................................................................................................................61
  Related Elements Tab ..............................................................................................................................63
  Related Services Tab ................................................................................................................................64
  Associated files Tab ................................................................................................................................65
  Related Requirements Tab .......................................................................................................................68
  Versions Tab ..............................................................................................................................................70
  Discussion Tab ..........................................................................................................................................71

Manual capture of requirements ....................................................................................................................72
  Automatic assignment of requirements codes ...........................................................................................73
  Inputting requirements .............................................................................................................................73
  Requirements hierarchy .............................................................................................................................75
  Automatic recoding of requirements .........................................................................................................76
  Partial recoding of requirements ...............................................................................................................76

Creation of links in the grid panel .................................................................................................................77
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Services description panel</td>
<td>107</td>
</tr>
<tr>
<td>Services views tab panel</td>
<td>107</td>
</tr>
<tr>
<td>Details Tab</td>
<td>108</td>
</tr>
<tr>
<td>Definition Tab</td>
<td>109</td>
</tr>
<tr>
<td>Related Elements Tab</td>
<td>111</td>
</tr>
<tr>
<td>Blocks and Attributes Tab</td>
<td>112</td>
</tr>
<tr>
<td>Associated files Tab</td>
<td>112</td>
</tr>
<tr>
<td>Related services Tab</td>
<td>112</td>
</tr>
<tr>
<td>Versions Tab</td>
<td>113</td>
</tr>
<tr>
<td>Graphic Description Tab</td>
<td>113</td>
</tr>
<tr>
<td>Fulfilled Requirements Tab</td>
<td>116</td>
</tr>
<tr>
<td>Definition of services</td>
<td>117</td>
</tr>
<tr>
<td>Importing services</td>
<td>117</td>
</tr>
<tr>
<td>Object Oriented Model</td>
<td>118</td>
</tr>
<tr>
<td>Actors</td>
<td>118</td>
</tr>
<tr>
<td>Definition of Actors</td>
<td>119</td>
</tr>
<tr>
<td>Use case diagrams</td>
<td>119</td>
</tr>
<tr>
<td>Events</td>
<td>120</td>
</tr>
<tr>
<td>State Diagrams</td>
<td>122</td>
</tr>
<tr>
<td>Sequence Diagrams</td>
<td>123</td>
</tr>
<tr>
<td>Functional Model</td>
<td>126</td>
</tr>
<tr>
<td>External Entities</td>
<td>126</td>
</tr>
<tr>
<td>Context Diagrams</td>
<td>126</td>
</tr>
<tr>
<td>Processes</td>
<td>127</td>
</tr>
<tr>
<td>Data Flow Diagrams (DFDs)</td>
<td>129</td>
</tr>
<tr>
<td>DFD Consistency</td>
<td>131</td>
</tr>
<tr>
<td>Scenarios</td>
<td>131</td>
</tr>
<tr>
<td>Scenario view management</td>
<td>131</td>
</tr>
<tr>
<td>Details Tab</td>
<td>132</td>
</tr>
<tr>
<td>Related Elements Tab</td>
<td>133</td>
</tr>
<tr>
<td>Precondition and Post Condition Tab</td>
<td>134</td>
</tr>
<tr>
<td>Blocks and Attributes Tab</td>
<td>134</td>
</tr>
<tr>
<td>Versions Tab</td>
<td>134</td>
</tr>
<tr>
<td>Scenario definition</td>
<td>134</td>
</tr>
<tr>
<td>CHANGE IMPACT ANALYSIS</td>
<td>135</td>
</tr>
</tbody>
</table>
ADVANCED ORGANIZATION OF THE SPECIFICATION .....................................................................................169

Workflows ...........................................................................................................................................................191

Blocks..................................................................................................................................................................177

Domains ..............................................................................................................................................................173

Access partitions................................................................................................................................................169

Filters ...................................................................................................................................................................158

Individual element version control...................................................................................................................161

Report generation...............................................................................................................................................167

Advanced reports .............................................................................................................................................168

Access partition views management..................................................................................................................169

Management of access partitions ......................................................................................................................173

Domain views management ..............................................................................................................................173

Active domain selection ..................................................................................................................................176

Domain diagrams .............................................................................................................................................176

Active block selection in a block diagram .........................................................................................................185

Selection of active relation ...............................................................................................................................186

Indirect traceability ..........................................................................................................................................187

Block views management .................................................................................................................................178

Active block selection ......................................................................................................................................183

Block diagrams .................................................................................................................................................183

Locate elements in blocks .................................................................................................................................189

Associate elements to a block ...........................................................................................................................190

Exclude elements from a block .........................................................................................................................190

Move elements to another block .....................................................................................................................191

Workflows ..........................................................................................................................................................191

Managing workflow views ...............................................................................................................................192

Predefined reports ..........................................................................................................................................167

Corporate reports ...........................................................................................................................................167
Workflow definition ........................................................................................................................................... 195
Diagram associated to workflows .................................................................................................................. 196

REUSABILITY WITH IRQA ................................................................................................................................ 200

Introduction ......................................................................................................................................................... 200

Components ........................................................................................................................................................ 201
  Components view management ....................................................................................................................... 201
  Definition of components .............................................................................................................................. 204
  Edition of components .................................................................................................................................. 206
  Deletion of components ................................................................................................................................... 207

Reusable components ....................................................................................................................................... 207
  Managing reusable component views .............................................................................................................. 207
  Managing reusable components ..................................................................................................................... 209
  Importing components ................................................................................................................................... 209
  Managing reused elements ............................................................................................................................. 211
  Updating components ...................................................................................................................................... 212
  Modifying the reuse mode of a component .................................................................................................... 213

Comparing components .................................................................................................................................... 213

INTEGRATION WITH SOFTWARE DESIGN TOOLS ............................................................................................. 215

Export Model UML to XMI 1.0 ............................................................................................................................ 215
Import from XMI 1.0 to model UML ................................................................................................................... 215

Implementation classes ..................................................................................................................................... 216

EXTERNAL ELEMENTS .......................................................................................................................................... 219

Introduction ......................................................................................................................................................... 219

External elements View ...................................................................................................................................... 219
  Default view of external elements .................................................................................................................. 220

External elements grid panel ............................................................................................................................. 220
  Column inclusion and exclusion ..................................................................................................................... 221
  Filter selection .................................................................................................................................................. 222
  External element organization .......................................................................................................................... 222
  Edit modes in the grid panel ............................................................................................................................ 222
  Options available on the grid panel .................................................................................................................. 222
  Special options on the grid panel ..................................................................................................................... 222
### Filtering the list of external elements

- Management of external elements views: 223
  - Creation of external elements views: 223
  - Modification and deletion of external elements views: 223
  - Selection of external elements views: 223
  - Sharing external elements views: 223

- External elements description panel: 223

- External elements views tab panel: 223
  - Details Tab: 224
  - Related Elements Tab: 225
  - Blocks and Attributes Tab: 225
  - Versions Tab: 226

### ADDITIONAL FEATURES

- Language selection: 227
- User interface theme: 227
- Tool bar configuration: 227
- Initial view configuration: 227
- Desktop configuration: 228
- E-mail configuration: 229
- Repository names management: 230
- System check-up: 231
- Changing license server: 232
- List of windows: 233
- Automatic refresh: 233
- Hotkeys: 233
  - Grid panel: 233
  - Tabs panel: 234
  - Description panel: 234
- Copying elements: 235
  - Copying elements: 235
  - Special copy of elements: 236
ANNEX I. IRQA® CONNECTIVITY TO DATA BASES ......................................................................................................................238

Connection to data bases .............................................................................................................................................................238

ANNEX II. IRQA® 4 GOOD PRACTICES ..............................................................................................................................................240

Working with large projects ...............................................................................................................................................................240

Architecture ..........................................................................................................................................................................................240

Client Hardware requirements ...........................................................................................................................................................240

Supported databases ...........................................................................................................................................................................240

IRQA Administration Center .............................................................................................................................................................241

IRQA Client ..........................................................................................................................................................................................241

GLOSSARY .......................................................................................................................................................................................243
Introduction

Welcome to the IRQA® (Integral Requisite Analyzer) User Manual. This is one of the most versatile, powerful Requirements Engineering support tools, developed by Visure. The manual will provide you a complete description of all the features of the tool, as well as how to use it.

IRQA® is a flexible tool that under no circumstance imposes a methodology, but rather provides teams of analysts, users and developers a methodological framework and a set of functionalities that may be adapted in each case to the specific needs.

IRQA® is not only a requirements management tool, but also provides complete support for the Requirements Engineering process, through a series of features that allow the basic activities related to that process to be carried out:

- Requirements capture.
- Requirements analysis.
- Specification of the solution.
- Validation of the specification.

It also provides the necessary support for other complementary activities, such as:

- Traceability.
- Change impact analysis.
- Test definition.
- Report generation.
- Organization of the specification.
- Configuration management.
- Integration with Design.
- Reuse of the specification.

IRQA® includes on-line tutorials to guide the user through the steps to perform a simple project in IRQA®, which is provided with the tool and is directly accessible on completing the software installation.

IRQA® also includes on-line help with the complete content of this manual.

Hardware and software requirements to install IRQA® so that its operation and performance be adequate appear in the document IRQA® Installation Guide.

IRQA® allows access to the projects previously created with IRQA® Administration Center, which characteristics are described in IRQA® Administration Guide.

The IRQA® installation CD contains help documents and user guides for the different IRQA® products in the directory DOC.
How is this manual organized?

This manual is structured following the necessary steps to complete the requirements engineering phases of a project, in order to ensure better understanding of the different functions. Thus, it is not organized as a sequential description of the menu bar and its different options.

The manual consists of the following chapters:

**Introduction to Requirements Engineering with IRQA®**

This section introduces and locates Requirements Engineering as a discipline within Software Engineering. It then lists the features of the tool and locates them within that engineering process.

**First steps with IRQA®**

This chapter introduces the user to handling the tool, describing the necessary actions to access an IRQA® project, with the different options available.

It also provides a first contact with the tool interface the user is to work with. The different user interfaces are shown and the main tool bars to work with are also shown.

**Requirements Capture**

This chapter describes how requirements manual capture is performed, as well as the user interface to manage these.

**Requirements Analysis**

This chapter details everything related to requirements analysis: business concepts models, as well as establishing links between these elements and the requirements.

The chapter ends with a description of the automatic analyzer built into IRQA® to expedite the analysis tasks.

**Specification**

This chapter explains what they are, how they are used and what use the services have as elements to describe the specification of a solution.

As a complement to the specification, other elements will be dealt with, such as actors (if the model is object oriented) or external entities (if it is a functional model), with its diagrams included.

Finally, the meaning and use of the state diagrams, Data Flow Diagrams, scenarios and sequence diagrams will be explained.

**Change Impact Analysis**

This chapter explains the use of the traceability matrix as an instrument to establish relations between the different elements of the specification.

It also explains what establishment of suspect links is and how it is used as a tool to aid change impact analysis.

**Tests**

This chapter describes the test module of IRQA®, using the elements the tool offers: test scenarios and fit-criteria. It also explains the possibilities of integration of IRQA® with the commercial tool TestDirector for Quality Center.

**Management Elements**

This chapter describes the attributes provided by IRQA® to qualify requirements.
It also explains the filtering functions and their power in all the views of the tool. It also details other important features, such as version management of individual elements.

**Advanced organization of the specification**

This chapter explains the use of access partitions, domains and blocks as support elements for organization of the specification. The different views, use and operations options of each one of them are explained. It also includes a description of the workflow function, that allows to control the modification of values of attributes according to specific rules.

**Reusability with IRQA®**

This chapter explains reusability function: component management and reuse.

**Integration with software design tools**

This chapter includes a description of the integration of IRQA® with UML analysis and design tools, through file exchange in standard format XMI (XML Metadata Interchange). This chapter will be of interest to users who wish to create software specifications with IRQA®.

**Additional facilities**

This chapter describes some customization facilities of IRQA®, such as configuration of the user interface appearance and language, choice of tool bars, desktop configuration, etc. Other additional utilities are also described, such as management of repository names, checking versions of the software components of the system on which IRQA® is run, the possibility of changing the license server the tool accesses, shortkeys, copy/paste options for elements and diagrams, etc.

**Annexes**

The annex describes the means of connection of the tool to the data bases containing the projects and the different data base managers that may be used with IRQA®.

**Glossary**

Contains the definition of the concepts used in the tool.
Introduction to Requirements Engineering with IRQA®

Requirements Engineering with IRQA®

Software Engineering is understood as the discipline dealing with the application of systematic methods, tools and techniques to achieve the objective of building an efficient software system. The objective pursued is application of scientific principles to transform a problem into a software solution, its implementation and maintenance until that software ceases to be useful.

As part of this, Requirements Engineering is a discipline that has been developed within the scope of Software Engineering to cover the first stages of the life cycle of a software system. Requirements Engineering covers all the techniques, methods and procedures applied to definition and management of the needs of users/customers of the software system being studied. It is a special discipline as compared with the rest of the techniques, due to the non mechanizable nature it is granted by nearness to the human customer.

Due to the eminently technological nature of software production, the user requirements have traditionally been set aside by the productive party (provider or developer), so that part of the Software Engineering has begun to develop much later than other areas like Design, Configuration Management or Test Management.

IRQA® is a tool developed in order to cover the phases of definition of requirements and analysis, as well as some activities related to them within the process of project management, configuration and quality management, so no other tool is required to cover ALL the activities related to Requirements Engineering.

In this tool, the requirements are considered as information items that are analyzed and managed in order to reduce production costs. The aim is not limited to merely documenting the needs, imposed by the need to comply with a certain standard. In this line, special emphasis is being placed on considering the user as an active part of the Requirements Engineering process (customer orientation) and in considering the requirements as elements of knowledge (information orientation) and not only as manageable elements.

Modern requirements tools, such as IRQA®, provide a new focus with respect to traditional requirements management tools: they deal with requirements as an environment in which these have a meaning. In addition to considering capture and management of requirements to generate specification documents, they deal with facilitating their analysis (through use of descriptive and organizational techniques), specification of the functions of the system to be developed, review of the specification, management of the acceptance tests or communication with design tools.

The main functions of IRQA®, that is, those directly related to construction of the requirements specification, are:

- Capture and classification of requirements.
- Requirements analysis.
- Specification of the solution.
- Validation of the specification.
- Organization of the project.
- Requirement specification quality measures.
- Report generation.

IRQA® also allows other functions to be performed, aimed at allowing integration of the requirements phase within the global framework of the project to which it belongs, facilitating use of the results from this phase in the rest of the project activities. These functions are:

- Validation and acceptance tests.
• Configuration management.
• Estimation of project costs.
• Integration with Design tools.

On the other hand, in order to support the deployment of Requirements Engineering activities in the organizations, IRQA® also provides explicit support to reuse of requirements specification. The tool allows to define sets of reusable requirements, that can be shared among the different projects in an organization.

Based on the functions provided, IRQA® allows specification and development cost saving, facilitates real re-use and maintenance of systems. It allows easier control and administration of the specification, as well as compartmentalization of the projects in an effective manner. It also helps to fulfill the quality standards and centralizes all the problem information. It also provides a visual browser system for the different elements of the specifications and the relations between them.

Methodology of IRQA® solution: Meta-IRQA®

Meta-IRQA® is the methodological framework that defines the engineering activities IRQA® provides support for and that must be adapted to the needs of each organization. Within the software life cycle, Meta-IRQA® covers the process from the first interviews with the customers to acceptance of the solution provided by the analyst.

The final objective of the application Meta-IRQA® on a project is construction of a correct, consistent, complete requirements specification.

The basic issue the application of this methodology is aimed at resolving is that of understanding between the users and developers. That understanding must be approached from two different planes: vision of the problem (user) and vision of the solution (developers). This gives rise to two tasks:

• To define what is asked of the system: seeing the limits to the problem.
• To define what features (services) resolve the problem: the high level solution.

The aim is thus to define the purpose of the system and its external behaviour.

Requirements Engineering processes in Meta-IRQA® follow an iterative, cyclical model. The analyst refines the specification of requirements in successive steps, reviewing the results with the user.

Meta-IRQA® defines engineering activities, each one of them with a defined objective, a set of tasks to be performed to achieve it and techniques to be applied. However, it is a flexible methodology that may be adapted to each specific project and to the degree of maturity of the organization to which it is applied.

The activities covered by Meta-IRQA® may be divided into those that comprise the basic specification process and those related to its support processes.

Basic Process

- **Requirements capture:** Collection of information provided by the users, in a simple, organized way.
- **Requirements analysis:** Understanding the problem presented by the user.
- **Specification of the solution:** Description of the features of the system and its behaviour in relation to the external world.
- **Validation of the specification:** Checking that the solution specified is appropriate for the requirements it must resolve.

Support Processes

- **Requirements Management:** Control over requirements for their operation and evolution in time.
- **Requirements Traceability:** Identification of the requirements that affect or are resolved by each one of the elements of the subsequent phases of the software life cycle.
First steps with IRQA®

How to run IRQA®

After IRQA® is installed, a shortcut to the main program is created on the desktop and in the Setup menu. Click either of them to screen the IRQA® start view:

If you are using the version that runs on a network, the first time you run IRQA®, a dialog box will appear with the following message:

Click “Yes” and the following dialog will appear, to choose the license server:
This shows the computers available on the network. Select one that has an IRQA® license server installed.

Opening a project

The project to open must be selected on the IRQA® start screen. This dialog may also be accessed by clicking either on the Open option on the Project menu, or the button on the tool bar.

In this dialog, the user login and password are input, and then the repository containing the project and the actual project to open are selected.

The desired user validation system must be chosen. There are four possible systems: Active directory, Windows
Domain, LDAP Server or IRQA Users. The first are corporate systems, in which case the data to be input will be that of the network user, and it will be the relevant system that will perform the validation. If the IRQA Users system is used, the user connection data will have been defined specifically for the IRQA® repository and are validated internally by the actual tool. In any of these cases, in order for the user to be able to open the project, he must previously have been assigned to the repository and project from the IRQA® Administration Tool.

If the Current Windows user option is checked, the validation system is automatically Windows Domain, and the user validation parameters do not have to be input. IRQA® will use the connected user's identity in Windows to validate access to the selected project and repository.

The list of repositories contains the option “Filter DSNs” and the type of filtering. If that option is marked, only the DSNs of repositories that contain IRQA® 4 projects we have already connected to on a previous occasion will be shown.

There are three types of DSNs:
- User
- System
- File

To obtain further information on ODBCs and DSNs, see the web page www.microsoft.com for a description of those concepts.

Once a repository is chosen, the project to be opened must be chosen on the fold-down menu provided. The menu shows the list of IRQA® projects in the repository previously selected.

The user should also select the user group with which to connect to the project for the session being started. This menu will show the list of user groups to which the user is assigned in the selected project. Once the project is opened, the access rights over elements the user will find, will be the ones of the group selected in this dialog.

The user Admin can only belong to the Administrators group, so the option to select the connection user group is not active in this case.

Once these options are selected and if the user data input is correct, the view the user has configured as the project initial view will open. The default initial view is the one that shows the project requirements.

The project administrator can configure the project opening mode, which may be:
- Object Oriented
- Functional

The difference in project opening modes lies in the representation of the problem domain model. If class diagrams are used, the “Object Oriented” mode must be set; to represent the problem domain with Entity-Relationship diagrams, the “Functional” mode must be used.

When opening the project, the user will find some options or others according to the project opening mode chosen by the administrator. If the project is opened in Object Oriented mode, in the Requirements Capture and Analysis toolbar, the following options will be available:
- Concepts.
- Concept diagrams.
- Actors.

Instead, if the project is opened in Functional mode, in the Requirements Capture and Analysis toolbar, the following options will appear:
- Entities.
- Entity-Relationship Diagrams.
- External Entities.

Moreover, the integration with Design options will only be available if the project is opened in Object Oriented
mode.
The rest of the tool functions are available in both opening modes.
The project may be closed using the menu Project > Close, or by clicking on the button on the tool bar.

If the project to be opened is in a repository we have never connected to before, it will not be shown on the list of available repositories. To establish the connection, click the button Connect Repository. Then the following dialog box will appear:

![Available ODBC Drivers](image)

This dialog box is used to select the ODBC driver for the manager of the database where the repository we wish to connect to is stored. IRAQ® supports the following drivers: Microsoft Access, Oracle, SQL Server, MySQL.

The name of the DSN we wish to identify the repository with is also input.

The user must also select the type of DSN he wishes to create. When working with IRAQ®, there is no difference whatsoever in the choice of DSN type. IRAQ® automatically adds the prefix “IRQA_” to the DSN name, which is used to filter the DSNs of IRAQ® projects from others the user may have created.

Then click on “Next” and look for the repository to connect to. The details of the connection depend on the ODBC driver selected. A description of this process is provided in Annex I to this document.

**Selecting an active baseline**

When opening a project, its current baseline is shown by default. Users can make modifications of the project elements on this baseline, which depend on their access permissions and on the user group selected when
opening the project.

Users can select a previous baseline of the project. To achieve this, they should use the drop-down menu to this end that can be seen in the Project toolbar. This menu shows all baselines that have been created in the project.

The partial baselines are shown with the symbol (P) before the name of the baseline.

If a previous baseline is selected in this menu, the tool will show the project elements in the versions that were included in that baseline, only for consultation purposes. Users can create views, filter and navigate through the specification exactly the same as when the active baseline is the current one. Nevertheless, it is not possible to modify any data being viewed: all elements will be seen as checked in and cannot be checked out. New elements cannot be added, existing elements cannot be edited or deleted and new relationships cannot be created between them, nor can their existing ones be deleted, etc.

Users can consult elements which version in the active baseline belongs to an access partition in which they currently have at least reading permission; i.e., access rights management that existed when the baseline was created, is not recovered. This could give rise to the user not seeing some elements when the baseline was created but nevertheless, being able to see them afterwards, since reading or writing permission has been given on the partition that they belong to.

Unless otherwise indicated, it will always be assumed that the user has selected the project’s current baseline in chapters contained in this manual related to managing elements.

Text views and graphic views

The user interface of the tool is organized in views, each one of which matches a type of element (requirements, concepts, services, processes etc.). Two types of views are distinguished: text views and graphic views.

There are three panels on text or element detail views:
- List of elements on the left side of the screen.
- Property tabs for the element selected on the right. These tabs contain all the information on the element concerned: predefined attributes and those created by the user, relations with other elements, linked external files, etc.
- Window with the description of the element selected, on the lower left of the screen.

At the top of the screen, there are the menus and tool bars that allow access to the different elements of the project.

The text view described here is the default one provided by IRQA®. However, these views may be configured by the user, who may define as many as wished for each element. Each one of them may show the information the user considers necessary at each moment.

The property tabs as well as the description window may be displayed or hidden as the user wishes. Moreover, the list of elements shown on the left side may be extended by adding columns shown in table format with the attributes of the elements on the list, or elements related to them.

The button bars may also be chosen and the menus configured as the user wishes.

The details of view creation and configuration possibilities will be explained in the following chapters.

The graphic views show the diagrams that are graphic representations of the information contained in the project.

IRQA® supports the following types of diagrams:
- Concept Diagrams.
- Entity-Relationship Diagrams.
- Use Case Diagrams.
- Context Diagrams.
- State Diagrams.
The different views contain common tool bars and context menus that will be described below as a reference. The specific tool bars and menus will be explained in the following chapters.

Users and access partitions

IRQA® supports definition of work groups for projects by creation of user groups. The information contained in the projects is organized in access partitions: each version of the elements of a project (requirements, services, domains, diagrams, etc.) belong to a single access partition. Moreover, only certain types of elements can belong to each access partition, according to how the partition is configured during its definition process.
Within each project, the access partitions are assigned the appropriate rights for each user group. This data regarding access partitions, user groups and access rights is input in the IRQA® Administration Tool.

Each user could belong to several groups in a project. When a user opens a project, he must select the group with which he wants to connect for the session being started. The group selected and the access partition organization determines the information on the active baseline of the project he may see and/or change, as follows:

- On every IRQA® view (lists, tabs and diagrams), the user only sees the elements belonging to access partitions in which he has at least read rights.
- The user may only change elements belonging to access partitions in which he has write rights.
- The user may only add new elements to access partitions in which he has write rights.
- The user may only add an element of a given type to access partitions which are able to contain this type of element.
- To establish links between any two elements, the needed rights depend on the configuration set by the project administrator. There are two options:
  - The user must have rights to write on the access partition to which at least one of the two elements he wishes to link belongs.
  - The user must have rights to write on the access partitions to which both elements he wishes to link belong.

If the user selects a baseline different from the current one, only the first of the previous conditions applies, given that no data of the project can be modified.

Each user is allowed to change his personal data, such as name, surnames, telephone number, e-mail of the user to whom the automatic notification of changes will be sent, e-mail that will appear in the mails sent for automatic notification of changes, and the password used to access the IRQA® project, if it is an IRQA user system. If the project is created with the user systems Windows, Active Directory or LDAP, the password may not be changed, but the other data may. That function may be accessed using the option User Data in the menu Tools or by clicking the button on the Tools bar, to display the following dialog box:
The password change option will not be activated if the user system is Windows, Active Directory or LDAP.

General tool bars

When an IRQA® project is opened, at the heading of the window the following information can be seen:

- Repository.
- Project.
- User connected to the project.
- User group with which the user connected to the project.
- Type of element (requirements, services, blocks, attributes, etc.) or Name of the diagram.
- Number of elements being shown in the list displayed in the navigation tree.
- View selected by the user.

There are tool bars in IRQA® placed below the menu bar. The tool bars are independent of the view one is on, although the active options are different depending on the view and element chosen.

We shall now examine each one of the general tool bars:

**Project button bar**

- Open a project.
- Close the active project.
- Select the active baseline.
- Access to the Access partitions editor.
- Access to the Workflows editor.

**Requirement capture and Analysis button bar**

If a project is opened in O.O. mode, it contains the following options:

- Access to the Requirements editor.
- Access to the Concepts editor.
- Access to Concept Diagrams.
- Access to the Attributes editor.
- Access to the Attribute types editor.
- Access to the Motives editor.

If the opening mode is Functional, only a button differs compared with the Object Oriented mode:
Access to the Entity-Relationship Diagrams.

**Blocks button bar**

- Access to the Block editor.
- Access to Block Diagrams.
- Selects a block diagram as active, so the dropdown menus of active blocks will show only the blocks included in the active diagram.
- Allows a block to be selected as active, that allows only the elements contained in that block to be seen and edited.

- Include elements in a block.
- Exclude elements of a block.
- Move elements from a block to another one.
- Edit common attributes, that allows simultaneous modification of values of a same attribute for a group of elements.

The last four buttons are only accessible from the views of requirements, services, scenarios, test scenarios, external entities/actors (according to the opening mode), concepts/entities (according to the opening mode).

**Elements buttons bar**

- Add an element. Option accessible from any text view, given that any element of IRQA® is created (except diagrams) in the same way.
  To create an element, click on the Add button on the tool bar of the relevant view and the dialog box will appear to create the element.
- Add a child to the selected element. This is only accessible from the requirements or test scenarios view.
- Edit information on the selected element. Option accessible from any text view, given that any element of IRQA® (except diagrams) is edited in the same way.
  To modify an element, click the Edit button on the tool bar of the relevant view and the create dialog box will appear with the current data of the element so it may be modified.
- Eliminate a selected element. Option accessible from any view, given that any element of IRQA® is deleted (except diagrams) in the same way.
  To delete an element, click the Delete button on the tool bar of the relevant view and a confirm message will appear. If accepted, the element will be deleted.
- Restore deleted elements or eliminate them. This option is active on all views. A dialog box will open showing the list of elements of the relevant view that have been deleted. The user must select the element or elements to be restored or definitively eliminated. If there is an element in the project which code
coincides with the code of a deleted element, this is marked as “Repeated” in the dialog of Deleted elements. An element marked as “Repeated” can not be restored.

Cut the text marked. The cut option in IRQA® is used to cut text, for example in the description of an element. To do this, mark the part of the text to delete and click on Cut on the tool bar.

Copy a text or element. IRQA® provides the possibility of copying elements (including diagrams) either in the same project, or between different projects.

To copy elements or text, select the item to copy and click on Copy on the tool bar. A text or element may also be copied by clicking on Copy in the Edit menu, or using the key combination Ctrl + C.

Paste a text or element. IRQA® makes it possible to paste elements (including diagrams) either in the same project, or between different projects.

To paste an element, go to the view where you wish to paste and click the Paste button on the tool bar. An element may also be pasted using the Paste option on the Edit menu, or using the key combination Ctrl + V.

Access to the filters of an element type.

The tool has a very powerful filtering module, that allows simple and compound filters, thus allowing as complex filters as needed to be constructed.

For each element that may be filtered, a menu will appear with its relevant filtering options.

Information on the filter applied in the active view.

Refresh the view with the current information of the project in the data base.

This option must be used to refresh the present view with the possible changes made on other views or by other users.

There is also access to the options of this tool bar from the context menu, shown by right clicking on an element in the text view:
The options “Expand tree” and “Collapse tree” only appear when the view is organized in any one of the tree dispositions.

**Version control button bar**

This button bar has a double use: to manage version control of the elements of IRQA®, and to access the options of the configuration management tools for linked external files.

IRQA® allows several versions of a same element to be saved for all elements. The options active on this button bar are the following:

- ![Check-in](image)
  - Check-in an element.

- ![Check-out](image)
  - Check-out an element.

- ![Undo](image)
  - Undo check-out.

The check-in and check-out mechanisms are used to create versions when protecting and unprotecting an element.

It also allows the user to undo the modifications made, restoring the element to its status before the last check-out.

When an external file is selected that is linked to a requirement or service (view for Requirements/Services, Associated Files tab), as long as the file is under configuration management, all the buttons on this bar will be activated:

- ![Obtain](image)
  - Obtain the latest version of a file.

- ![Check-in](image)
  - Check-in a file.
Check-out a file.
Undo file check-out.
Show the history of a file.
Show differences between files.
Show properties of a file.
Refresh status of a file.
Activate configuration control tool.

These options are the most usual ones of the configuration management tools. The result of these depends on the specific tool that is being used to manage versions of the file selected.

Domains button bar

Access to the Domain editor.
Access to Domain Diagrams.

Allows selection of a domain as the active one, that allows the user to see and edit only the elements contained in that domain.

Tools button bar

Access to the user personal data editor.
Access to the relations editor (view for traceability matrix between elements).
Access to the Reports editor.
Automatic re-coding of elements.
Access to the automatic requirements analyzer.

The automatic re-coding button is only accessible from the requirements, services, scenarios and test scenarios views and the analyzer button is exclusive for the requirements view.

Integrations button bar
Access to the Implementation Classes editor.
Export UML models to XMI file.
Import elements of XMI file.
Access to the External Elements editor.

Solution specification and Testing button bar

Access to the Services editor.
Access to the Actors editor (Object Oriented opening mode) or External Entities (Functional opening mode).
Access to Use Case Diagrams.
Access to Context Diagrams.
Access to the Events editor.
Access to the Scenarios editor.
Access to the Processes editor.
Checking consistency of the project DFDs.
Access to the Test Scenarios editor.
Access to Sequence Diagrams.

Reusability button bar

Access to the Components editor.
Access to the Reusable Components editor.
Import Reusable Component.
Compare Components.
Update Component.
Modify Reuse Mode.

General options of the element buttons

The buttons for access to the elements views (requirements, services, attributes, blocks, etc.), provide a fold-down menu on the arrow to the right of the button.

This menu allows the element view to be displayed to be chosen. Three options are initially presented:

- Predetermined: Opens the element view marked as predetermined by the user. This is also the view that opens if the element view access button is clicked directly.
- View management: Opens the view management dialog, in which new views may be created starting from already existing ones, views may be deleted, etc.
- Default: Opens the view marked by the user as default view of the element. Initially, this is also the predetermined view.

The new views of the element created by the user appear on this fold-down menu to allow selection of the one the user wishes to view at each moment.

General options of the buttons bars

Not all of the toolbars and buttons described earlier are visible by default. Users can customize the interface, adding or hiding buttons or entire toolbars.

Each one of the toolbars can be displayed or hidden using the context menu displayed in the area of the screen where the toolbars are located.

The Customize option included in that menu allows users to configure toolbars and the menus displayed in the header (show or hide toolbars, reorder buttons, create new menus, etc.).

While the Customize dialog is open, it is possible to reorganize and resize the dropdown menus on the toolbars. The steps are as follows:

- Select the dropdown menu, which will be outlined in black.
- Click on the lower edge of the box and a small gray rectangle will appear. Drag this rectangle to the new position to change the order of the menu on the toolbar.
- When the cursor is placed over the left or right edges of the box, a cross appears. Click and drag the cursor to the right or left to modify the size of the box in which the menu is displayed.

By the last button on each one of the tool bars, the arrow on the bottom right may be clicked to display the option “Add or remove buttons”.

This option allows the user to configure the tool bars by showing or hiding buttons.

The user-created configuration of buttons and toolbars is restored when the tool is closed and restarted.

Diagram zoom bar

Accessible from any diagram.
Reduce the diagram size by 10%.

Increase the diagram size by 10%.

×1 Zoom 100%.

×2 Zoom 200%.

Zoom Fit, adjusts the diagram to the screen size.

Zoom selected by the user.

There is also access to these options from the context menu shown by right clicking on the diagrams:

Diagram graphics bar
Accessible from any diagram.

Selection of the elements of the diagram.

Redraw the diagram.

Save the diagram as an image (*.bmp, *.jpeg or *.jpg).

Exclude an element from the diagram without deleting it from the project.

Exclude an element from the project and delete it.

There is also access to these options from the context menu shown by right clicking on the diagram:
IRQA® also includes a powerful diagram copy/paste feature within the same or different projects. If the copy is between different projects and the elements pasted did not previously exist, they will be created in the destination project.

Diagram layout bar

Accessible from any diagram.

There is also access to these options from the context menu shown by right clicking on the diagram:
The specific bars of each type of diagram with their respective features will be duly explained in the section of the manual on each specific diagram.

**General options in the diagrams**

IRQA® includes a function to navigate from the diagrams to text views. Select an element in a diagram and double click it to open the default view for the corresponding element type, with the selected element. This function is available in the following cases:

### Diagram: Navigation to:

- **Concept Diagram**: Concepts
- **Entity/Relationship Diagram**: Entities
- **Use Case Diagram**: Services
- **External Entities/Actors**: External Entities/Actors
- **State Diagram**: Services
- **Sequence Diagram**: Concepts
- **External Entities/Actors**: External Entities/Actors
- **Data Flow Diagram**: Processes
- **External Entities/Actors**: External Entities/Actors
- **Block Diagram**: Blocks
- **Domain Diagram**: Domains

Text views are not available for all of the elements represented in the diagrams (for example, the relations between concepts can be viewed in the Attributes and Operations tab of the Concepts view, but there is no specific view that shows a list of relations). In these cases, when one of the elements in a diagram is double-clicked, the element definition dialog opens to allow the element to be modified. This function is available in the following cases:

<table>
<thead>
<tr>
<th>Diagram:</th>
<th>Modification dialog:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept Diagram</td>
<td>Relations between Concepts</td>
</tr>
<tr>
<td>Entity/Relationship Diagram</td>
<td>Relations between Entities</td>
</tr>
<tr>
<td>Use Case Diagram</td>
<td>N.A.</td>
</tr>
<tr>
<td>Diagram Type</td>
<td>Element</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Context Diagram</td>
<td>Data Flow</td>
</tr>
<tr>
<td>State Diagram</td>
<td>Transitions</td>
</tr>
<tr>
<td>Sequence Diagram</td>
<td>Messages</td>
</tr>
<tr>
<td>Data Flow Diagram</td>
<td>Data Flow, Data Store</td>
</tr>
<tr>
<td>Block Diagram</td>
<td>Relations between Blocks</td>
</tr>
<tr>
<td>Domain Diagram</td>
<td>Relations between Domains</td>
</tr>
</tbody>
</table>

Double-click directly on the name of the element on a diagram to edit and modify the name.
Requirements Capture

Requirements view

IRQA® allows the user to define different views for each one of the elements of the specification, so the information to be displayed is that of most interest according to the operations to be performed at each moment.

To open the requirements view, one may open the menu Engineering Process>Requirements, or click on the fold down menu on the right of the button on the Requirements capture and Analysis bar. In either case, a menu is shown, initially with three options:

- Predetermined: Opens the predetermined requirements view.
- Views management: Opens the dialog box to manage requirements views.
- Default: Opens the requirements default view. Initially, this is also the predetermined view.

If the button on the Requirements capture and Analysis bar is clicked directly, the predetermined view is opened. The user may decide which requirements view to mark as predetermined.

This menu also shows the new requirements views created by the user, to allow selection of the one to be opened.

The requirements views may have up to three panels:

- Grid of requirements with attributes. This panel will always appear.
- Property tabs of the requirement selected.
- Window with the description of the requirement selected.

The grid panel always appears in the upper left of the screen. The other two panels may be resized and placed in the part of the screen the user considers most appropriate. If any of the two panels is placed at the top, the grid panel automatically relocates to display under it.

In order to move those panels to a new position in the screen, the panel must be selected by clicking on its heading (blue bar), and then dragged. Then, a set of arrow buttons appears, as shown in the following screen:
By dragging the panel over these buttons, the interface will display a preview of the docked panel in light blue.

There will be four absolute positioning buttons ( ) at the ends of the screen to dock the panel at the corresponding side of the screen.

In case of dragging over a sub area inside the screen (grid panel, properties panel or description panel), the interface will display four or five additional relative buttons, depending on the area. By dropping the panel on these positioning buttons, it will be docked to the corresponding side of the particular sub area.

In case of dropping the panel on top of the center button , the panel will be docked as a new tab of that sub area (this button appears only in the description panel and in the properties panel).

If the panel is not dropped on an arrow, it will float over the window. In this case, it can be docked again to its previous position by double clicking on its heading.

**Default requirement view**

The default requirement view is shown below:
The requirements list view appears on the left of the screen and has two columns:

- Requirement code.
- Requirement name.

The requirements are shown in alphabetical order of the codes.

The tabs panel is shown on the right, and the description one at the bottom left of the window.

When a requirement is selected, the tabs and description window show the relevant information for that requirement.

The default view cannot be modified or deleted.

**Requirement grid panel**

The panel with the requirements list will appear in all the views the user may define. This panel consists of a series of columns showing attributes and characteristics of the requirements. The default view only has two columns, which provide the code and name of the requirements.

In IRQA the elements are shown in different colors according to their status and the actions that can be performed on them:

<table>
<thead>
<tr>
<th>View colors</th>
<th>Font color</th>
<th>Background color</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>Checked-in element or element on which the user has only read rights.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Element that is checked-out by another user.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The CCC system will allow manual controls to be performed using the manufacturer supplied controls or remote controls for a given appliance.
When an element is selected, the background is dark.

Although an element is checked-out, there may be fields that can not be modified, such as the date of creation or the author, so they are shown on a grey background.

In the columns with attributes, if they are enumerated, the different values of the attribute may appear in different colors. These colors are configured during the attribute type definition process (see section Attribute types).

**Column inclusion and exclusion**

The requirements views shall show at least the code and name columns, which are mandatory. To include new columns, the Configure option must be chosen by clicking the button on the tool bar located directly above the grid panel. The following menu appears:

There are several types of fields that may be included as columns on the requirements grid panel:

- **Predefined attributes.** These are pre-created attributes linked to requirements (date of creation of the element, last user who checked it out, active version, description, description of the change in the active version, discussion, etc.).

- **Organization elements.** These are project organization elements (domains, blocks, baselines) to which the requirements belong.

- **Reusability elements.** These are elements related to the reusability function that only take values for requirements that are reused from other projects.
  - Source element: Code of the source requirement in the source project.
  - Source element version: Version of the source requirement.
  - Component: Name of the reused component to which the source requirement belongs.
  - Component version: Version of the reused component to which the source requirement belongs.
  - Reuse mode: Mode in which the version of the component is reused in the project
(share, copy and link).

This group of elements appears only if the repository supports reusability.

- **Related Requirements.** Displays the requirements related to the requirements displayed in the list. The relation motive for each column of this type must be selected.

- **Related Elements.** Displays other types of elements related to the requirements included in the list. The possible element types are: services, test scenarios, and associated files.

- **Metrics.** Provides a display of the project complexity metrics related to requirements. These are as follows: number of linked concepts, number of linked requirements, number of linked services.

- **Attributes.** The list of fields to select shows all the user attributes defined in the project.

To include a column in the panel, the user must select the attribute, related element, metric or motive from the list on the left and then click . Likewise, to eliminate a column from the panel, the name must be selected from the list on the right and click the button . Columns can also be added or removed from the panel by selecting and double-clicking them.

If an enumerated attribute, or an element associated with multiple possible values (for example, domains or blocks) is selected, the “Show all” option can be selected to show all of the possible values in all of the rows, and not just the ones associated with each requirement.

If a text attribute is selected, the “Show multiline” option can be checked, which will show the complete text of the attribute on several lines, if the width of the column does not allow it to be displayed on a single line.

This function is available for both user attributes as well as for predefined text attributes, such as Name or Comments in the Discussion tab.

If the Description or Change Description fields are shown in the grid panel, they will always be displayed in multiline mode.

Once the columns are included, it is possible to select the order in which they will appear on the panel using the buttons and .

### Ordering requirements

In the panel configuration dialog box it may be decided what criteria is to be used to order the requirements on the list to be shown.

By default, code is the only sorting criteria.

The available order criteria are all attributes, organization elements, or metrics that appear in any column included in the grid view. To use any of them, they must be selected in the list of columns and then the button must be clicked.

Several order criteria may be combined. For each one of them, it can be decided whether the order taken will be ascending or descending, by selecting the sorting criteria and the corresponding option in the menu behind the criteria list.

The order of importance assigned to the selected criteria can also be specified; they can be reordered using the buttons and on the right side of the list.

### Filter selection

It is possible to apply a filter to the requirements list. To do this, the user must click the button in the dialog box for grid panel configuration. The following window will be shown:
This window may be used to create the desired filter and select it so the requirements list shows only elements that fulfill a certain condition.

Once the columns, filter and order are selected, the button is clicked and the grid panel modified with the data just input.

The distribution of columns in the window available for the grid view depends on the option Tools>Configuration>Fit Columns Size to Window Size:

- If this option is activated, the columns are distributed so that all of them are visible and fit the width of the window.
- If this option is deactivated, only the first columns are shown and a horizontal scroll bar appears.

**Edit modes on the grid panel**

The following is an explanation of the edit mode of each one of the fields on the list:

- **Predefined attributes**: Some of these are automatically controlled or calculated by the tool, and therefore cannot be edited, for example author, creation date, or hierarchy level. The Change description field, which is the information entered by the user on checking in a version of the requirement, cannot be edited either.
  - Code, Name, Comments in the Discussion, and Fit-Criteria: These can be edited by double-clicking the desired field. The context menu in the column heading includes the “Show multiline” option, which allows the full text of the attribute to be displayed on multiple lines. The user should press Ctrl-Enter to enter a required line change, regardless of whether or not the column width allows to continue in it. When the user is done editing the attribute, he should press enter, or click anywhere else on the screen.
  - Access Partitions: A dropdown menu will appear, displaying all of the access partitions for which the user has write permission and that can contain requirements.
  - Domains and blocks: To show all of the available domains or blocks, the user should double-click on the desired field. All of the possible values will be displayed, with a scrollbar to access all of them. The context menu in the column heading includes the “Show all” option, which also displays all of the domains or blocks. The ones to which the selected requirement belongs are displayed with a marked box. In both cases, the requirement is included by marking the corresponding box.

In the case of blocks, the user has to keep in mind that if a block inherits from another block, inclusion in the lower-level block automatically implies that the requirement is also included in the higher level block. For the same reason, although the requirement may be excluded manually from the higher
level block only, it is also automatically excluded from the lower level one.

The user should keep in mind that if a block contains all of the elements, manual exclusion will have no effect.

− Baselines: Cannot be edited. Inclusion of elements in baselines is done when they are created and cannot be modified later. The context menu in the column header includes the “Show all” option, which displays all of the baselines (total or partial) created in the project. Those to which the selected requirement belongs are displayed with a marked box.

− Description: Cannot be edited from the grid panel. This is a plain text display of the information included in the Description panel. This means that special options that are available in this panel, such as tables, graphics, font sizes, etc., are not displayed.

• Related Elements:

− When double clicking on a cell containing related elements of a different type from the one in the current view (services or test scenarios in the requirements view), the tool navigates to the predetermined view of the relevant element, with a filter applied showing only the elements in the cell.

− When double clicking on the name of an associated file, the file will be opened.

• Metrics: These cannot be edited; they are values calculated on the basis of the relations input in the project.

• Attributes: These are edited in a different way, depending on the type:

  − Enumerated single-valued: By default the tool shows only the relevant value of the attribute. It may be modified by selecting a value from the possible ones shown on a fold-down menu. The context menu in the head of the column presents the option “Show all”, that allows to show all the possible values of the attribute. In that case, modification of the value is performed on a “radio button” type menu.

  − Enumerated multivalued: By default the tool shows only the relevant values of the attribute, marked with a check. The context menu in the head of the column presents the option “Show all”, that allows to show all the possible values of the attribute. Association/dissociation of a value is performed by checking/unchecking it.

  − Boolean: Appears as a checked box if the associated value is “Yes” and not checked if it is “No”.

  − Integer: May be edited directly. Only allows an integer number to be input.

  − Float: May be edited directly. Only allows a float number to be input.

  − Date: When double clicking on the field, the tool shows a calendar to allow selection of the desired value. If the user does not want to select any value, he should press Escape.

  − Text: May be edited directly. Allows alphanumerical characters. The context menu in the column heading includes the “Show multiline” option, which allows the full text of the attribute to be displayed on multiple lines. The user should press Ctrl-Enter to enter a required line change, regardless of whether or not the column width allows to continue in it. When the user is done editing the attribute, he should press enter, or click anywhere else on the screen.

  − Multivalued attributes (except enumerated): They can not be edited in the grid
panel, only in the Attributes tab (see Blocks and Attributes Tab section).

In the case of integer, float or date type attributes, if limit values have been defined for these, a check is performed to ensure the input values fall within the limits.

Available options on the grid panel

The top part of the screen displays the button bar and fold-down menus to modify the aspect and classification of the requirements. The following default tool bars appear: Configuration Bar, Classification Bar, Filter Bar and Text Filter Bar. All bars may be shown or hidden using the context menu linked to them.

The options described in the General options of the buttons bars section are also available for configuration of these menu bars.

The buttons on the Configuration Bar are as follows:

- **Configure**: Allows modification of the grid panel configuration displayed, that is, the columns that appear, the order of these columns, the filter applied and the order of the rows, as described above.

- **Invert selection**: Inverts the selection of the elements the user has performed manually.

- **Save current configuration**: Allows a new view to be created with the characteristics of the configuration being viewed at that moment.

- **Show/hide Description**: Shows the description panel if hidden, and hides it if visible.

- **Show/hide Tabs**: Shows the properties panel if hidden, and hides it if visible.

- **Export to Excel**: Creates a spreadsheet with the columns of the grid panel sorted out in the same way. This export is a WYSIWYG (What You See Is What You Get) feature, so no configuration prior to export is allowed.

- **Export to Word**: It is only available in the document view (see the Document View section). Creates a Word document with the information on blocks and requirements that is being shown in the view, always including the descriptions in the line below code and name. The attributes shown in columns appear below each requirement with the value corresponding to it. This export is a WYSIWYG (What You See Is What You Get) feature, so it no configuration prior to export is allowed. Formats being applied in the document view are exported. MS Word is limited approximately to 32 Mb. of internal memory (not file size). This entails around 10.000 requirements with descriptions smaller than 8Mb. In order to generate Word documents with information exceeding this size, several smaller document views should be created, exported independently and then joined in a Master document.

- **Show/hide RTF description**: It is only available in the document view (see the Document View section). Shows the description below each requirement if hidden, and hides it if visible...

Columns in the grid panel can be resized manually. If the user wants the tool to do it automatically, the option Tools>Configuration>Fit Columns Size to Window Size must be set, which will distribute optimally the available space between the columns in the grid panel.

The Requirements Classification Bar has the following appearance:

```
| 1st Level: List | 2nd Level: |
```

The bar contains a first fold-down menu for a first level classification, with the following options:

- **List**: Shows the requirements unclassified, in list form, only with the ordering criteria input in the panel configuration.
• **Attributes.** When this option is selected, the fold-down menu on its right shows a list of the enumerated attributes (single and multi-valued). This menu is used to select the attribute to be the sorting criteria. The fold-down menu **Second level** is also activated to allow selection of another attribute as the second level classification criteria.

The following figure shows the list of requirements sorted out according to their association to an enumerated attribute.

• **Access Partitions.** This option orders the requirements of the list according to the access partition where they are included.

• **Services.** Shows the requirements grouped according to the services they are linked to.
- **Hierarchy.** Orders the requirements hierarchically. When this option is selected, the fold-down menu located on its right is activated, where a list appears to select the number of hierarchy levels the user wishes to show.

The requirements view hierarchically ordered appears as follows:

- **Relationships by motive.** Orders the requirements in hierarchical tree format so, below each one, appear all the requirements related to it by the motive selected, as long as the parent requirement is the origin of the relation. When that option is selected, the fold-down menu located on its right is activated, where the user may select the motive of the relation.
In the **Second level** menu, the default selection is *Filter All Levels*. It means that if a filter (general or included in the grid panel configuration) is applied, it will be applied to all requirements, independently of the level to which they are assigned in the relationship hierarchy being shown.

In this menu it is also available the option *Filter First Level*. In this case, the filter will also be applied to the requirements in the first level of the hierarchy of relationships by motive.

Let us see an example: we have a block called User Requirements related to the block System Requirements with a relationship by motive that goes from the User Requirements block to the System Requirements block. If we want to see a list of User Requirements in a tree-like view with their related System Requirements, we should create a view sorted by Relationships by motive, select the motive for the link between them, select the *Filter First Level* option, and apply a filter that identifies the User Requirements. This way, in the first level we will only see the User Requirements.

If the selected option is *Filter All Levels*, when applying the filter, the System Requirements would disappear from the view.

If no filter is applied, the tool will show the System Requirements twice: in the hierarchy of User Requirements to which they are related, and also in the first level, with an arrow indicating that they are the target in some relationship by the selected motive.

- **Document.** When this option is selected, the document view is activated (see the Document View section).

**Note:** The selection of a new sorting criterion has the effect of sorting the elements already being shown, but the view is not refreshed from the database. If the user wants to refresh the information shown, the button in the Elements toolbar must be clicked. The document view is an exception to this behaviour: each time the document view is activated, the requirement list is also refreshed. Similarly, each time that, from the document view, another classification option is selected, the requirement list is also refreshed.

The Filter Bar looks like this:
This bar shows the identification of the filter included in the configuration of the grid panel. The name of the filter, if it has one, is displayed. Otherwise, the filter criteria are displayed. The relevant tooltip always shows the complete filter criteria.

It is also possible to filter the list of requirements through a text search field. This option is available in the Text Filter Bar. To do this, the user must input the text in the text field. The tool will look for the text in all columns currently being shown in the view and will filter away all elements that do not have the input text in any of them.

**Special options on the grid panel**

- **Multi-selection.** It is possible to select several requirements using the Windows Shift and Ctrl buttons. Several operations may be performed on the group of requirements selected, such as deleting, assigning to block, checking-in, checking-out, etc. These options are available both on toolbars and on the context menu available in the grid panel.

- **All of the available tree arrangements in the grid panel (hierarchy, order by attribute, by access partitions, etc.) include the options to expand and collapse the entire tree in the context menu.**

- **Drag&Drop of columns for ordering:** Columns on the grid panel may be dragged for re-location. To drag a column, the user should click on its head and drag it to the new position desired.

- **Resizing columns:** It is possible to change the width of the columns using the mouse by placing the pointer on the column edge and moving it to one side or the other.

- **Tooltips:** When the cursor is placed on a field, a tooltip is shown in the following cases:
  - When the cursor is placed on the code of a requirement, its author, creation date and description are shown.
  - When the cursor is placed on a text or numerical field that is not completely visible due to the size of the column, the whole value is shown.

**Document View**

This type of view is shown when the **Document** option is selected in the 1st level menu in the Requirements Classification Bar.

This option means a special sorting of elements in the grid panel and a filtering of the elements shown in the view. The Description and Properties panels can be visible or hidden, and the columns shown will be the ones selected by the user in the grid configuration dialog.

The Document sorting of elements in the grid panel has the following characteristics:

- **It is a hierarchical sorting with the blocks of requirements defined in the project at the first level, and the hierarchy of requirements (see Requirements hierarchy section) assigned to each of the blocks in the lower levels.**

- **Blocks may have hierarchical links (for instance, there can be a Requirements block with two child blocks: User Requirements and System Requirements).** In this case, the hierarchy of blocks is also seen in the document view. In the first level we will have the Requirements block, in the second level the User Requirements and System Requirements blocks, and starting from the third level, the hierarchy of requirements will appear. (For more details on blocks, see Blocks section).

- **Requirements that do not belong to any block in the view are not shown.**
• The column to the left is called Sorting number. This is a number automatically assigned by the tool, that reflects the hierarchy of blocks and requirements inside them (and also the requirements hierarchy). The format is: 1, 1.1, 1.1.1, etc.

• On the left there appears a panel called Hierarchy. In it we can see the hierarchical tree with the block names and requirement codes. When clicking on an element in this tree, this element is also selected in the grid view.

• In the Hierarchy panel, branches of the tree can be expanded or collapsed by clicking on the square to the left of the block or the requirement that is the origin of the branch. This allows a summarized view of the whole hierarchy and a quick navigation to any element on it by selecting it in the hierarchy tree.

• There could be more than one hierarchical group of blocks for a parent block. For instance, the Requirements block may have two child blocks, User Requirements and System Requirements related by the motive Level, and other two child blocks, Functional Requirements and Non-Functional Requirements related by the motive Classification.

This classification implies that every requirement must be categorized as a user or system requirement and, additionally, as a functional or a non-functional one. In the document view these two criteria will appear nested:

Requirements

User Requirements

Functional Requirements

UR010

UR020

Non-Functional Requirements

UR030

UR040

UR050

UR060

System Requirements

Functional Requirements
SR070
SR080

Non-Functional Requirements

SR090

The sorting of these criteria can be modified in the document view configuration option explained below. The sorting in the above list corresponds to the following sorting of the motives for hierarchical links:

- **Level**
- **Classification**

- In case of nested blocks hierarchy, requirements that are categorized according only to the first level but not to the second one (for instance, a user requirement that is not categorized as functional or non-functional) appear at the same level as the child blocks, and after them, with the corresponding sorting number.

- There could be more than one hierarchical level of blocks. For instance, the Requirements block may have two child blocks, Functional Requirements and Non-Functional Requirements, and, on its turn, the Non-Functional Requirements block may have its own hierarchy (Performance, Interface…).

In the document view these blocks will appear nested like this:

**Requirements**

Functional Requirements

- UR010
- UR020
- UR070
- UR080

Non-Functional Requirements

Interface

- UR030

Performance

- UR040
- UR050
- UR060
- UR090

**Selection of block diagram:**

- On the drop-down menu to the right of 1st level menu, when the Document option is selected, it is possible to select a block diagram. In this case, only the blocks of requirements and the block hierarchy in this diagram will appear in the sorting hierarchy of the document view. For instance, we may have a diagram with the classification in user requirements and system requirements and another diagram with the classification in functional and non-functional. This way, it is possible to view the requirements sorted according to each point of view separately by selecting the relevant diagram. If no diagram is selected, both points of view are automatically combined in the default document view.

- It must be kept in mind that when a block diagram is selected, a filter is applied on the requirements list. That is, requirements are sorted according to the blocks in the diagram, but if there are requirements that do not belong to any of them, they will disappear from the list.
Selection of block:

- In the 2nd level menu a block can be selected. If a block diagram is selected in the left drop-down menu, the list of blocks shows only the blocks belonging to this diagram. When the user selects a block, the document view shows only the hierarchy of blocks starting from the selected one. For instance, if the user selects the non-functional block, the view will show a tree starting with this block and with the types of non-functional requirements below.

- Same as in the selection of a block diagram, there is a filter applied. The requirements not belonging to any block shown in the view, will disappear from the list.

Configuration options

The configuration options for the document view are available by clicking on the Format button available in the grid view configuration dialog.

The available options are:

- For block name and its sorting code:
  - Font and size.
  - Bold, Italic, Underline options.
- For requirement code, name and its sorting code, it is possible to select the same options as for blocks.
  These options are available for up to seven hierarchical levels of blocks and requirements. If there are more than seven levels, the options for the 7th will be applied to the lower ones.
- Motives sorting when there are several hierarchical groups of blocks for the same parent block. For instance, the Requirements block may have two child blocks, User Requirements and System Requirements related by the motive Level, and other two child blocks, Functional Requirements and Non-Functional Requirements related by the motive Classification. In this case, there can be two sorting possibilities according to the sorting of motives in this dialog.
  If the sorting of motives is:

  Level
  Classification

the block hierarchy in the document view will be:
Requirements

User Requirements

Functional Requirements
Non-Functional Requirements

System Requirements

Functional Requirements
Non-Functional Requirements

On the other hand, if the sorting of motives is:

Classification
Level

the block hierarchy in the document view will be:

Requirements

Functional Requirements

User Requirements
System Requirements
Non-Functional Requirements

User Requirements
System Requirements

Drag&drop of requirements

When selecting one or several requirements, it is possible to drag them to a different position in the list. There are several possibilities:

- If the requirements are dropped right below the block to which they belong, they will just change their position and sorting code in the document view.

- If the requirements are dropped below another requirement inside the same block, the dragged requirements may become child of the requirement below which they are dropped, or have the same parent requirement. The user may decide which of these options will apply in each case; when the requirements are dropped, a menu for this purpose appears. In order to cancel the drag&drop operation, the user must click on Escape.

- If the requirements are dropped right below a block different from the one to which they belonged, the user may decide if the requirements will be excluded from the previous one, or if they will belong to both blocks; if they are dragged clicking on Ctrl at the same time, the requirements will belong both to the original block and to the new one. In any other case, the requirements will be excluded from the original block and included in the new one.

- If the requirements are dropped below another requirement inside a different block, the dragged requirements may become child of the requirement below which they are dropped, or have the same parent requirement. Besides, they are moved from the original block to the new one.

Note: When several requirements are selected and dropped below another one, all of them will have the same parent requirement; if there were hierarchical links between them, they will be lost.

In any case, the new position of the requirements also implies:

- A change in position: The requirements are situated in the new position in the list. If the requirements become child of another requirement, they will appear starting from the first position right below the new parent.
- A change in the sorting code: The numbers will be the ones corresponding to the new position of the requirements in the list.

**Note:** Requirements drag&drop in the document view is only available if no sorting criteria for requirements are selected in the grid view configuration dialog.

**Drag&drop of blocks**

It is also possible to drag a block to a different position in the list. If the block is dropped above or below another block in the list at the same hierarchical level, the block sorting changes to the new one. In any other case, no action is taken.

For instance, in the sorting:

Requirements  
- Functional Requirements  
  - User Requirements  
  - System Requirements  
- Non-Functional Requirements  
  - User Requirements  
  - System Requirements

it is possible to drag the System Requirements block under Functional Requirements on top of the User Requirements block. Then, the sorting will become:

Requirements  
- Functional Requirements  
  - System Requirements  
  - User Requirements  
- Non-Functional Requirements  
  - System Requirements  
  - User Requirements

But if the user drags the System Requirements block on top of the Functional Requirements block, the sorting does not change. That is, it is not possible to modify the hierarchical sorting through drag&drop. This modification can only be done in the Configuration dialog.

It is not possible to drag several blocks at the same time.

**Note:** Blocks drag&drop in the document view is only available if no sorting criteria for requirements are selected in the grid view configuration dialog.

**Creation of new elements**

The position of a newly created element in the Document view depends on the position of the cursor when selecting the create element option:

- If the cursor is situated on a block, the new requirement will automatically be assigned to the block (or to the hierarchy of blocks if the one selected is in a low level of the tree of blocks).
- If the cursor is situated on a requirement and the button is clicked, the new requirement will be positioned right below the selected one, with the same parent requirement and will belong to the same blocks.
- If the cursor is situated on a requirement and the button is clicked, the new requirement will be positioned as the first child requirement of the selected one, and will belong to the same blocks.

Requirements list filtering

The requirements list displayed may be filtered by clicking the button on the tool bar.
The same dialog is presented as in the case of configuration of the filter for the grid panel described above.
Note that this filter is temporary, that is, it is only applied while the user decides not to deactivate it, but it is not part of the panel configuration.
For further information on this filter option, see the Filters section.

Requirements view management

The user may create requirements views, modify or suppress them, using the options described below.

Creation of requirements views

To create a new requirements view, the desired configuration must be created using the options of the Configuration and Classification Bars on the grid panel, and then pressing the button on the Configuration Bar.
The following dialog box then appears:

An existing configuration may be selected, that in this case is modified with the new parameters, or a new one may be created. The tool does not allow to modify a view configuration whose owner is not the user connected to the
project. In this case, a new name has to be input (see the Sharing requirements views section).

The configuration saved consists of the following parameters:

- Configuration of the grid panel: columns included and their order, filter, order criteria of requirements in rows. In the case of elements with enumerated values, the configuration also includes the possibility of selecting Show all possible values. In the case of text attributes, the configuration also includes the possibility of selecting Show multil ine.
- Column width (only if the Fit Columns Size to Window Size option is deactivated).
- First and second level of row ordering.
- Collapsed or expanded trees and branches.
- Visible or hidden tab panel.
- Minimized or open tab panel.
- Visible or hidden description panel.
- Minimized or open description panel.
- Positions of the three panels on the screen.
- Size of the screen and the three panels.

The new configuration created may be established as the predetermin ed view by marking the appropriate option in the dialog box.

**Modification and deletion of requirements views**

To modify or delete requirement views it must be selected the option Views Management on the menu Engineering Process>Requirements, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar. The following dialog will appear:

![Views Management dialog box](image)

The **Owner** column shows the user that owns the view. The **Shared with** column shows the user groups with which a view belonging to the user is shared. If the column is empty, the view is not shared with other users groups (see the Sharing requirements views section).

The following options are available:

- **Open views in the same window** check box: If this box is checked, each time a requirements view is open, it is
shown in the same window. This implies that each view substitutes for the previous one. In this case, it is only possible to open one requirement view at a time. If this box is not checked, then each time a requirements view is opened, a new window is created. This way, it is possible to work with several windows opened at the same time, with the same or different requirements view in each of them. This function can be helpful to compare requirements or to create links between them (see Creation of links in the grid panel section).

Set Pref.: Allows the selected view to be established as the predetermined one.

Rename: Allows the name and description of the selected view to be changed. It is not possible to rename the Default view or views whose owner is not the user connected to the project.

Share: Allows users to share a requirement view with other users belonging to the same or different user groups (see the Sharing requirements views section).

Stop sharing: Allows users to stop sharing a requirement view with other users belonging to the same or different user groups (see the Sharing requirements views section).

Delete: Deletes the selected view. It is not possible to delete the Default view or views whose owner is not the user connected to the project.

Duplicate: Allows to create a new requirements view same as the one selected, to simplify the process of creating views that are similar to each other.

Selection of requirements views
To open a requirements view that has already been created, the user must select that view on the menu Engineering Process>Requirements, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar.

Another possibility is to select the option Views Management also shown on that menu. Then, in the view management dialog box, select the one to open and click the button.

Note: Changing the view does not imply refreshing the list of elements. That is, on opening a view, the columns being shown are changed but the requirements are not. In order to refresh the requirement list, the button in the Elements bar must be clicked. There is an exception to this rule if the newly selected view has a different filter from the one being shown. In this case, the requirement list is refreshed with the most updated information in the database and the filter is applied.

Sharing requirements views
Requirements views belong to the user that creates them, but all users can make views available to other users.

To share a requirement view, the Views management option must be selected in the Requirements>Engineering Process menu, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar.

In the views management dialog, the view to be shared must be selected and the Share button clicked on.

If the user does not belong to the Administrators group, the view is automatically shared with the other users belonging to the group with which the user is connected to the project.

If the user belongs to the Administrators group, the tool shows a dialog to select the user groups for which the view will become available.
The user must select one or several user groups and click the button OK.

From this moment on, users belonging to the groups with which the view has been shared will find an additional view in their requirement views list. In the Owner column it will appear the user to whom the view belongs. If some user with whom the view is shared has another view with the same name, then the name will appear twice, with different owner.

If the user checks the option Establish as predetermined, the shared view will appear as the predetermined one for all users belonging to the groups with which the view is shared, who have the Default view as predetermined (usually, new users). In case another Administrator is sharing a predetermined view with the same user group, the initial view will be stopped being shared.

If the user with whom the view has been shared, already has or establishes a view of his own as the predetermined, this one will be the predetermined for him, not taking into account that the administrator established a shared one as such.

If, after the view was shared as the predetermined, the administrator opens this dialog and unchecks the Establish as predetermined option, the view will still be shared with other users, but will stop being the predetermined view for those having it as such. In those cases, the default view will become predetermined.

If an administrator shares a view with other user groups, he must be sure that the view filter (if it has any) includes data on which the other groups have at least read rights. Otherwise, the users with whom the view is shared, will not see the data of the filter being applied.

If the owner of the view modifies it, users with whom the view is shared will also have the modified view.

Users who are not the owner of the view cannot modify it in any way or delete it. They could save it with a different name and then make the desired modifications on this new one.

If a new user is assigned later to a group with which a view is shared by any user, the shared view will also be available for the new one.

If the owner of a shared view decides to stop sharing it, all users with whom the view was shared stop having the view in their list of view configurations. If the view was also the predetermined one, for those users the default view will become predetermined.

Requirements description panel

The description panel allows viewing and modification of the description of a requirement selected on the grid panel.
On the default view, this panel is shown at the bottom left of the screen. However, the user may change the size of the window and/or move it to another place on the screen. This panel may also be hidden using the button on the Grid panel Configuration Bar.

This panel may also be minimized by clicking the button shown in the top right corner of the panel. The panel is replaced by a tab that opens to show the complete panel when the pointer is placed on it.

The requirements description panel provides a series of advanced edition options that allow the use of such Microsoft Word options as fonts, paragraph alignment, numbered or bullet lists, tables, etc.

The default font and size in this panel can be configured through the Tools>Configuration>Description Format option.

This panel has a bar with the following options:

- Shows the advanced tool bar if hidden, and hides it if visible. This option also appears in the context menu linked to the bar.

- Saves the changes made in the description field. It is not essential to press this button, as the changes are also saved when selecting any other field or button that is visible on screen.

Advanced edition options

The advanced edition options available in this panel are as follows:

- **Font.** Allows selection of the type of letter to be used (font, size, bold, underlined, capitals, font colors and background, etc.). The most common of these options are provided as quick access buttons on the description panel bar.
• **Paragraph.** Allows selection of the paragraph characteristics, such as alignment, indent, bullets, list numbering, tabulations, etc. The most common of these options are provided as quick access buttons on the description panel bar.

• **Table Management.** Allows tables to be inserted as part of the description of the requirement and to give them the desired format.

• **Edit.** Includes the options Cut/Copy/Paste, select text, edit sections, edit Ole objects, etc.

• **Insert.** Allows insertion of page or section separations, drawings, frames, etc. Also allows insertion in the description of the requirement of external elements, such as images and Ole objects. In the following table graphical formats supported in IRQA are shown. You can see that not all formats available in the RTF editor are supported by the description field shown in the Document view or the Report Manager.

<table>
<thead>
<tr>
<th>FORMAT</th>
<th>RTF EDITOR</th>
<th>DOCUMENT VIEW</th>
<th>REPORT MANAGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIF</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>JPG</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIF</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PNG</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OLE OBJECTS</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BMP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EMF</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WMF</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

• **View.** Allows help elements to be shown, such as the ruler, status bar, etc. The options Show markers and Zoom are also provided as quick access buttons on the description panel bar.

• **Tools.** Includes options like search, replace, insert background picture, etc.

The Insert option includes the possibility to insert hyperlinks to external files or even to specific paragraphs inside files. In order to do this, the user should follow these steps:

- Insert a bookmark at the beginning of the paragraph in the file.

- Insert a hyperlink in the description of the requirement with the text to be enhanced in the **Link text** field. In the **Link Code** field, the user should write the path to the file, and the name of the file followed by the characters #name of the bookmark (for instance, C:\File.doc#Bookmark1).

Then, when clicking on the hyperlink, the tool will open the file and the pointer will go directly to the position of the bookmark inside the file.

When descriptions of requirements are captured from Word files and when Word documents are generated from IRQA®, the characteristics of the relevant requirements descriptions are maintained corresponding with these advanced edition options.

---

**Tab panel in the requirements view**

On the right of the requirements default view, it appears the information panel for the requirement selected from the list on the left. As in the case of the description panel, this may be hidden, its size and location changed on screen, or it may be turned into a tab that opens to show the complete panel when the pointer is placed on it.

This panel is formed by a set of tabs that show the information in an organized way. These tabs are as follows:

- Details.
- Blocks and Attributes.
- Related Elements.
- Related Services.
- Related Requirements.
- Associated files.
- Versions.
- Discussion.

There follows a description of the function of each one of these tabs.

**Details Tab**

Shows us the following information concerning the requirement selected:

- User who created the requirement.
- Date and time of creation.
- User who created the version of the requirement that is now active.
- Date and time of creation of the active version.
- User who has the requirement checked-out at the moment. If the requirement is checked-in, that field will be blank.
- Parent requirement according to the hierarchical structure.
- Level of the requirement in the hierarchy. Level 0 indicates that the requirement has no other as its parent.
- Access partition the requirement belongs to.
- Fit-Criteria of the requirement.
Clicking on the button on the right of the user fields, information on the project user appearing in the field may be seen.

Data related to users and dates can not be modified manually.

Access partition and fit-criteria may be modified as long as the requirement is in “Checked-out” mode. If the requirement is checked-in (it is grey shadowed on the list on the left), no data can be modified. The only data that could be modified in this case is its parent requirement, as long as the project administrator allows it in the project configuration options.

The parent requirement can be selected in the corresponding dropdown menu, which will show a complete list of the project requirements (for which the user has at least read permission), regardless of the current position that the selected requirement occupies in the hierarchy.
If you want the selected requirement to occupy level 0 in the hierarchy, select the option *Orphan Requirement.* To modify the data of a requirement, the user must also be authorized to write in the access partition the requirement belongs to.

**Blocks and Attributes Tab**

Shows information concerning the blocks to which the requirement belongs and the values taken for the requirement by the attributes linked to it.

In the upper part of the tab, the blocks to which the requirement belongs are shown. When they are child blocks of any other block, the way they are shown is the following: motives being used in any generalization link between blocks are shown on the left; on the right you will see the blocks that are child blocks in any generalization link for that motive and to which the selected requirement belongs.
For instance, there might be a Requirements block containing all requirements in the project that has two child blocks, User Requirements and System Requirements related by the motive Level, and other two child blocks, Functional Requirements and Non-Functional Requirements related by the motive Classification. In this case, in the tab there would be two motives:

- Level
- Classification

If the requirement does not belong to any of the child blocks, double clicking on the field to the right of the motive, you will see the following data:

- Beside the Level motive, the blocks User Requirements and System Requirements will be shown.
- Beside the Classification motive, the blocks Functional Requirements and Non-Functional Requirements will be shown.

The user may assign the requirement to the blocks by checking them.

In the case of the blocks that are not child blocks of any other, the label in the left column will be 1st Level Blocks.

The table in the lower part shows the list of attributes in which scope the requirement is included, and the values of the attributes for the requirement. It also shows the type of the attribute. When the requirement is assigned to a block in the upper part of the tab, the list of attributes is refreshed and shows the attributes which scope includes the checked block.

These values are modified in a different way according to the type the attribute belongs to. If the attribute is not multivalued, modifications are performed as explained below:

- Enumerated: Only shows the relevant value. It may be modified by choosing a value from the possible ones displayed on a fold-down menu.
- Boolean: It is marked if the linked value is “Yes”, and unmarked if it is “No”.
- Integer: May be edited directly. Only allows an integer number to be input.
- Float: May be edited directly. Only allows a float number to be input.
- Date: May be edited directly, but bearing in mind that it must have DD/MM/YYYY format.
- Text: May be edited directly. Allows alphanumerical characters. They are displayed in multiline mode. The user should press Ctrl-Enter to enter a required line change, regardless of whether or not the column width allows to continue in it. When the user is done editing the attribute, he should press enter, up or down arrow, or click anywhere on the screen.

If the attribute is multivalued, to modify values assigned to the requirement, the following buttons are available:

- Add Value: It becomes active on selecting a multivalued attribute in the tab. When clicking on this button a dialog is shown where the user can write or select a value of the attribute that will be added to the values the requirement takes for this attribute. If the attribute is enumerated, the new value will be selected from a list. In any other case, the new value will be written directly.
- Delete Value: It becomes active on selecting a value of a multivalued attribute. When clicking on the button, the selected value is deleted from the list of the values of the attribute assigned to the requirement.

If the attribute takes a value different from the default one, the option Reset to default becomes active, to allow the user to reset the value/s of the attribute to the default one/s.

In the case of integer, float or date type attributes, if limit values have been defined for these, they are checked to ensure the value input falls within those limits.

In order to be able to modify the value an attribute takes for a requirement, the requirement must be checked-out by the user, which implies that the user must have write access on the access partition to which the requirement belongs. Besides, the user must have write access or write (own) access on the access partition to which the attribute belongs, according to the configuration options enabled by the administrator.
When an attribute is used in a workflow, the tool only allows modifications according to the workflow rules: the possible new values shown by the tool are only the ones defined in the workflow, and the user has to be authorized in the workflow definition to modify the value of the attribute. The Reset to default button will not be active in this case.

**Related Elements Tab**

Allows other elements of the specification to be linked to the requirement selected, except requirements and services that due to their special importance, are shown on other independent tabs.

At the top of the Related Elements tab there is a fold-down menu on which the user may select the type of elements. The available options are:
- Actors (External Entities, in functional mode).
- Implementation Classes.
- Concepts (Entities, in functional mode).
- Domains.
- External Elements.
- Processes.
- Test scenarios.

Once the type of element is selected, the list of elements of that type available in the specification is shown: the bottom table shows those that are related to the requirement and the top those that are not.

If the type of elements selected is Actors, Concepts or Test scenarios, the Blocks fold-down menu is activated. This menu allows selection of a block from those that contain the element type concerned (as long as there are any). If a block is selected, on the two elements lists, related and unrelated, only those belonging to the block concerned will be shown.

If a block diagram is selected as active in the Blocks toolbar, the dropdown menu will show only the blocks of elements included in the selected diagram.

The buttons and may establish or eliminate relations with the elements shown.

If the elements selected are Implementation Classes or Concepts, relations may be established with the actual element, or with any of its attributes or operations. In the latter case, the name of the class or the concept is grey shadowed on the list of related elements.

If the element type selected is Test scenarios, the options are activated for treatment of suspect links (see the section Management of suspect links).

If an element of either of the two lists, related or unrelated, is selected, its description is shown on the bottom of the tab.

It is possible to establish or eliminate links with other elements, regardless of whether that requirement is in “Checked-in” or “Checked-out” status. However, depending on the configuration set by the project administrator, the user must have the following rights:

- Writing rights, at least, on the access partition one of the two elements to be linked belongs to.
- Writing rights on the access partitions both elements to be linked belong to.

In case the corresponding option in the Administration Center is chosen, it will only be possible to establish the links that appear in the block diagrams that define the specification structure. This restriction only applies to the elements that can belong to blocks (requirements, services, actors, concepts, test scenarios and scenarios).

This allows project administrators to restrict the relationships that users can establish between elements or subsets of elements.

In any case, the tab will only show as available the elements that can be linked with the selected requirement.

If there exists any link with an element that does not comply with the restrictions of block diagrams, this element will appear in the list of related elements. This could happen if the link was created before the project administrator activated the option of restricting links according to block diagrams. If this link is eliminated, it will not be possible to create it again, given that the element will not appear anymore in the list of available elements in the upper part of the tab.

By double clicking on an element on either of the two lists, IRQA® opens the relevant view, with the element concerned selected.

**Related Services Tab**

Allows the user to link the service or services that solve it to the requirement selected.
This tab works in a similar way to that described for the Related Elements tab.

The option is provided to select a block of services, so the tab shows only the services that belong to that block. If a block diagram is selected as active in the Blocks toolbar, the dropdown menu will show only the blocks of services included in the selected diagram.

The options for treatment of suspect links are active (see the section Management of suspect links).

**Associated files Tab**

This tab allows external files of any kind to be linked to a requirement, whether these are images, documents, etc. IRQA® stores the reference to the external file, not the actual file.
The button **Associate** is used to select the file to link. That file may be in any folder on the net which is accessible. It may also be a Web address (URLs).

The stored information is the reference to the associated file, just as it is selected by the user. This means that if the user has a mapped network unit or selects a file on the C disk, other users cannot open the file because their machines will not recognize the address. For all users to be able to directly open associated files, they must be selected using the common names that identify the machines on the network.

It is also possible to link a specific paragraph inside documents to a requirement through the use of bookmarks. The steps to follow are:

- Insert a bookmark at the beginning of the paragraph in the file.
- In the dialog to select the file to be linked, write the path to the file, the name of the file, and the
characters #name of the bookmark (for instance, C:\File.doc#Bookmark1).

Then, when opening the file, the pointer will go directly to the position of the bookmark inside the file.

It may also be a file that is under configuration control in any Configuration Management tool that is compatible with API SCC (Microsoft Source Code Control Interface). In that case, first it is necessary to establish the connection to the tool and open the project where it is stored the file to be linked. After performing these steps, the file may be selected.

For each external file under configuration management, it shows the name, status and project (or directory where the Configuration Management tool saves the file). The user may access the configuration management options using the Versions Control tool bar:

When selecting a linked file that is under configuration management, the following operations may be performed:

- **Get latest version**: The file saved in the Configuration Management tool repository is copied in the local work directory, with the property read only activated.

- **Check-out**: When a file is checked-out, the users obtain a local copy of its last version. That copy may be edited and modified.

- **Check-in**: When a file is checked-out and modified, the protection action allows the user to update the configuration of the configuration management repository with the changes made in the file.

- **Undo check-out**: When a linked file is checked-out and is modified, this action allows the user to undo all the changes made since the last protection, leaving the file checked-in.

- **Show history**: Shows the history of the file versions. This history saves detailed information on the changes made in the files, such as the date and time of the changes, the user who made them, the list of modifications performed, and linked remarks.

- **Show differences**: This action allows the user to obtain a list of differences between the local version of a linked file and the last version of the same file saved in the repository of the configuration management tool.

- **Show properties**: This action allows the user to obtain the configuration management properties of the file. The properties shown depend on the configuration management provider.

- **Refresh status**: Updates the file status that may have been modified by other users.

- **Source control**: This action opens the configuration management tool that maintains the linked file.

The button **Dissociate** eliminates the link between the requirement and the external file, after requesting confirmation.

The button **Edit** allows modification of the description of the link input by the user when establishing it.

The button **Open** allows the document concerned to be edited with the application associated with the
document extension. This option may also be accessed by selecting the file and double clicking it.

If the files linked to the requirements are image files, these may be included in the Word reports. In any other case, the Word report will show only the name of the file. If the files are under configuration management, there must be a local copy of the file in the working directory for the file to be included in the reports.

To be able to link or unlink external files to a requirement, the requirement must be in “Checked-out” state.

The links between requirements and external files may be suspect, so this tab has the options for treatment of suspect relations open (see the section Management of suspect links).

**Related Requirements Tab**

The objective of this tab is to allow creation and viewing of relations “for free motives” between requirements.

The top box shows the list of requirements that are not related to the requirement selected and the bottom one those that are.

On the right, there is the Blocks fold-down menu. This menu allows selection of a block of requirements. In this case, the two lists only show the requirements that belong to the block concerned.

If a block diagram is selected as active in the Blocks toolbar, the dropdown menu will show only the blocks of requirements included in the selected diagram.

The buttons ![link](image1.png) and ![unlink](image2.png) may be used to establish or eliminate relations with the requirements shown.
Relations between requirements for free motives have two properties that are shown on this view:

- **Direction**: Shows which requirement is the origin of the relation. It is represented by an arrow. If the arrow points right, it indicates that the origin of the relation is the requirement selected on the list on the left. If the arrow points left, it means that the origin of the relation is the requirement shown on the tab.

  When a new relation is created between requirements, the origin is the requirement selected on the list on the left. To change the direction, the user should click on the arrow and select the opposite direction on the fold-down menu shown.

  The relations shown may be filtered by these criteria using the fold-down menu Direction shown under the bottom box. The default option is Both, that shows all the relations, regardless of the direction.

- **Motive**: Indicates the reason why both requirements are linked. It is a user defined free text. To be able to relate two requirements by free motive, at least one motive for relation must have been defined. By
clicking on the **Motives Editor** button, the tool will open the motives view, where motives for links are defined or modified (see the Motives view section).

When a new relation is created between two requirements, the desired motive must be selected from the fold-down menu shown beside the name of the motive.

The relations shown may be filtered by these criteria using the Motive fold-down menu shown under the bottom box. The default option is All, which shows all the relations, regardless of the motive.

The motive and direction filters may be used simultaneously.

Relations between requirements may be suspect, so this tab has the options active for treatment of suspect links (see the section Management of suspect links).

If a requirement is selected from either of the two lists, related or unrelated, its description is shown on the bottom of the tab.

It is possible to establish or eliminate relations between requirements regardless of them being in “Checked-in” or “Checked-out” status. However, depending on the configuration set by the project administrator, the user must have the following rights:

- Writing rights, at least, on the access partition one of the two requirements to be linked belongs to.
- Writing rights on the access partitions both requirements to be linked belong to.

In case the corresponding option in the Administration Center is chosen, it will only be possible to establish the links that appear in the block diagrams that define the specification structure. This means that the motive for the link between two requirements will be restricted according to the blocks to which the requirements belong and the motives for the links between them that appear in the block diagrams.

The tab will only show as available the requirements that can be linked with the selected requirement.

If there is any link with a requirement that does not comply with the restrictions of block diagrams, this requirement will appear in the list of related elements. This could happen if the link was created before the project administrator activated the option of restricting links according to block diagrams. If this link is eliminated, it will not be possible to create it again, given that the requirement will not appear anymore in the list of available requirements in the upper part of the tab.

**Versions Tab**

Shows information on the versions of the requirement selected and the differences between them (see section Individual element version control).
**Discussion Tab**

The objective of this tab is to allow creation and viewing of a discussion (such as proposals for modification, warnings, etc.) associated to a requirement.
Comments can be entered by any user, even if he only has read rights on the requirement. The requirement can be in checked-in status.

To add a comment, the user should click on the Add button and write the text in the dialog to this end. The tool shows the text, the user that input it and the date and time in which it was input.

To delete a comment, the user should select it and click on the Delete button. Once a comment is input, no user is allowed to delete it except project administrators.

### Manual capture of requirements
Automatic assignment of requirements codes

In IRQA®, each requirement has a unique code that is used as an identifier for it. IRQA® provides a utility for automatic assignment of those codes to the requirements. The format of those codes is completely configurable, and a code generation pattern may be provided in the option “Requirements Codes” in the menu Tools>Configuration>Codes:

Configuration of the format of the codes that will be assigned to the requirements is performed in the preceding dialog box. We may configure a prefix, a numerical code and a suffix. For this numerical code, we may establish the first to be generated, the increment and the number of digits it is to occupy (filled out with zeros on the left if necessary).

**Note:** If the *Project code configuration* option has been enabled in the Administration Center, the code configuration menu will be disabled for all users.

Inputting requirements

To input a requirement, click the button on the tool bar of the requirements view. This option may also be accessed in the context menu of the requirements list or in the Edit>Add Element menu. After clicking on the button, the following dialog box appears:
In the Predefined attributes section we can input the code of a requirement, its name, the access partition it belongs to and the fit-criteria. The fold-down menu for access partitions will show only those which may contain requirements and in which the user inputting the new requirement has write rights.

When a new requirement is input, by default, the latest access partition in which the user added an element in the project will appear selected. If this cannot contain requirements or the user no longer has write permission, the default partition will be the first one among the possible partitions in alphabetical order by name.

The code appears automatically, following the configuration rule the user has established or the one established for the project in the Administration Center, as long as the code corresponding to that rule does not yet exist in the project (or in any project in the repository if it supports reusability). If this is the case, the tool proposes the first available code it can find, following the configuration rule. In any case, the proposed code may be modified in the preceding dialog box.

If the code appears deactivated in the requirement creation dialog, it means that it cannot be modified because the project administrator does not allow it.

When the user clicks on the OK button, the tool checks that no requirement with the same code exists in the project. If the repository supports reusability, the tool checks that the code does not yet exist in any project in the repository.

In order to input a fit-criteria, the user can write directly on the field to this end. It is also possible to write the fit-criteria in the expandable field that appears by clicking on the arrow to the right. In this dialog it is possible to write multiple lines using the Enter key. To finish inputting the fit-criteria, the user should click Ctrl-Enter.

In the Mandatory User Attributes section, it appears the list of attributes which scope includes the type of elements Requirements and that are marked as mandatory. The default values are proposed and can be modified by the user.

If the attribute is not multivalued, the edition depends on the type of the attribute:

- Enumerated: A drop-down menu appears where the user can select a value.
- Date: When clicking on the arrow to the right, a calendar is shown.
- Integer or Float: The user can input a number in the field. If the input does not start with a number, the tool will assign the value 0 to the attribute.
- Text: The user can input any text in the field.
- Boolean: A drop-down menu with the Yes and No options appears.

If the attribute is linked to a workflow, it will take the default value and it is not possible to modify it in this dialog.

If the attribute is multivalued, the following dialog is shown when clicking on the button to the right of the field:

To add a new value to the list of values of the attribute taken by the requirement, the user should click on the Add button.
value button and write the value in the dialog to that end.

To delete values from the list, the user should select the values and click on the Delete button.

If the user clicks on the Reset to Default button, the values will be the default one/s.

When the user finishes the modification of the list of values, the OK button should be clicked. If all values have been deleted and no one has been assigned, the tool will automatically assign the default values again.

To edit an existing requirement, the user must select it and click the button. This option may also be accessed in the context menu of the requirements list or in the Edit>Edit Element menu.

The tool shows the same dialog as in the creation of requirements, but only with the Predefined attributes section. The user is allowed to modify code, name, access partition and fit-criteria in this dialog.

If the code appears deactivated when an existing requirement is edited for modification, it means that it cannot be modified because the project administrator does not allow it.

By clicking the button, the requirements selected are deleted, after asking the user for confirmation.

When a new requirement is inputted, it is in checked-out mode and belongs to the user that inputted it. This means that only this user is able to modify its attribute values (both predefined and user attributes). Nevertheless, other users may establish links between this requirement and other specification elements, as long as they have the needed rights on access partitions.

The requirements view also has the feature of copying one or several requirements and pasting them into a word processor, or on the requirements view in the same or another project, using the Copy and Paste buttons, for which it will ask the user to state whether he wishes to copy the last active version or the whole history of the versions of the requirement or requirements selected. There is the possibility of selecting multiple requirements using the different combinations of keys <Alt>, <Shift> and the mouse left button (see the Copying elements section).

Requirements hierarchy

The requirements can be grouped hierarchically. To make a requirement child of another, the following steps are followed:

a) Creation of child requirement. If the parent requirement has already been created, the user must just select the parent requirement and click on the button (or use the Shift+INS hotkey). Thus, the new requirement created will be child of the requirement selected.

b) Selection of the parent item on the Details tab: If both requirements have already been created, the one to be child of the other is selected. On the Details tab on the right, the requirement to be the parent is selected on the fold-down list of Parent requirements. From that moment on, the requirement chosen on the fold-down list will be the parent of that selected from the list on the left.

c) Drag & drop: To drag requirements, it is required that in the 1st level menu, the selected sorting is Hierarchy. The user must select a requirement and drag it. When the requirement is dropped under another, the requirement dropped becomes child of the other. The requirement can be dropped to any new position in the hierarchy. Should the requirement dragged have child requirements, these shall be maintained as such and thus shall also be dragged.

To make an orphan requirement, it must be dragged to the head of the list.

d) Requirement selection when creating a new requirement: There is a special configuration option in the menu Tools > Configuration > Automatic hierarchy when creating element. If this option is checked, there is another possibility to create hierarchy: when a new requirement is created, it belongs to the same hierarchical level as the one that was selected when the Add button was clicked, and has the same parent requirement. This occurs regardless of the order in which the requirements are displayed in the list (in hierarchy, ordered by attribute, by access partition, etc.).

It is possible to assign a requirement as parent to a group of requirements by following these steps:
- Select the group of requirements to which the same parent is to be assigned in the list of requirements on the grid panel.

- Then, select the parent requirement on the fold-down list of Parent requirements in the Details tab.

It is also possible to modify the parent requirement using the drag & drop feature, by dragging the selected requirements and dropping them on the parent one. Same as for one requirement, if any of the selected requirements have other child requirements, they are kept as such. That is, the whole hierarchical tree is dragged.

**Note:** It must be taken into account that the same parent is assigned to all requirements selected in the list, that is, if other hierarchical relationships were established before between these requirements, they will disappear.

---

### Automatic recoding of requirements

Once the requirements are input in the project, its coding may be changed for a group of them at the same time. To do this, the user must:

- Select the elements the recoding is to be applied to.

- Select the Automatic recoding function, available on the menu Edit, or from the button on the Tools bar.

A dialog box will open, like the one shown in the section on automatic code configuration:

![Element codes dialog box](image)

The new coding established will be applied to the set of requirements selected, and it will become the new code configuration rule for creation of new elements.

If the option and button are not active, it is due to the fact that the administrator does not allow the modification of element codes.

---

### Partial recoding of requirements

It is also possible to change only the prefix or suffix of a requirement or group of them, maintaining the rest of the code unaltered. To do this, the user must:

- Select the elements to which recoding is to be applied.

- Select the function, Edit>Automatic recoding>Partial recoding menu option, or the option Automatic recoding, available in the fold-down menu of the button on the Tools bar.

Then the following dialog box will open:
The user must mark the box Prefix, Suffix, or both, according to the part of the code to be modified. Then the present prefix and/or suffix must be input in the Search field, and the new ones in the Replace with field.

The change will be applied to the set of requirements selected, as long as they have those indicated by the user in the partial re-coding dialog box as their prefix or suffix. The prefix must begin at the first character of the code and the suffix must end at the last character of the code.

If the option and button are not active, it is due to the fact that the administrator does not allow the modification of element codes.

Creation of links in the grid panel

IRQA® provides the possibility of creating traceability links between elements of the same or different types showing two grid panels at the same time.

In order to use this function, the steps to follow are described below:

- Open at least a view of each of the elements to be linked. If links between elements of the same type are going to be created (for instance, between requirements by free motive), then the Open views in the same window option must be unchecked previously (see the Modification and deletion of requirements views section).

- Configure the screen so that both views are shown at the same time. Clicking on the Restore window button in any window, it will be made smaller and it will be possible to see all windows open at that moment. This way, it is possible to select two windows containing the elements to be linked, and arrange them both on the screen, so that the user has a good visibility of them.

- Select the element or elements that will be the origin of the links to be established, in the corresponding window.

- Select the Start relationship option in the context menu.
Select the elements to be linked in the second window.

- Select the Set relationship option in the context menu. In this menu, the Start link option will also be active. The use of this option implies to start the process again, where now the origin of the link will be the elements selected in the second window.

- If the link is established between elements of the same type, it will be necessary to select the type of link (motive for free motive links between requirements, extend or include for links between services, etc.).
This function is available for all types of links allowed by the tool, except the following:

- Requirements hierarchy.
- Test scenarios hierarchy.
- Relationships between concepts.
- Relationships between domains.
- Inclusion of elements in domains.
- Relationships between blocks.
- Inclusion of elements in blocks.

Importing requirements

IRQA® provides the possibility of including requirements in a project automatically, as long as these are available in electronic media in any format that can be processed by IRQA® Import Tool.

For further information on the use of this tool, see the IRQA® Import Tool User Guide.
Requirements Analysis

Introduction

Requirements Analysis is the process aimed at understanding the problem posed by the user.

To perform this process, IRQA® provides a set of features, among which the most important is modeling the business concepts.

In IRQA®, the term business concepts is used for the modeling elements that represent the relevant entities in the domain of the problem one aims to solve. The tool may also locate the requirements in the context of the problem domain, linking them to the business concepts.

Another function set that IRQA supplies to help users analyse and classify requirements, is the establishment of direct relationships between them for motives defined by the user. There is a specific view option in which the tool makes it possible to define different motives for relationships between requirements. Examples of relationship motives between requirements can be: derive into (user requirements derive into system requirements), contradicts (a requirement given by a user contradicts a requirement given by another user), affects (a non-functional requirement affects a functional requirement). These direct relationship motives can also be used to relate test scenarios.

Concept View (Object Oriented)

When the project is opened in Object Oriented mode, we find the option Concepts on the menu Engineering process>Analysis and the button on the Requirements capture and Analysis bar. In either of the two cases, a menu is presented, initially with three options:

- Predetermined: Opens the predetermined concepts view.
- Views management: Opens the dialog box to manage concepts views.
- Default: Opens the concepts default view. Initially, this is also the predetermined view.

If the button of the Requirements capture and Analysis bar is clicked directly, the predetermined view is opened. The user may decide what concepts view to mark as predetermined.

This menu will also show new concepts views created by the user, to allow selection of the one to open.

The concepts views may have up to three panels:

- Grid of concepts. This panel will always appear.
- Tabs with properties of the concept selected.
- Window with the description of the concept selected.

The grid panel always appears in the top left of the screen. The other two panels may be resized and placed wherever on the screen the user considers most appropriate. If any of the two panels is placed at the top, the grid panel will automatically relocate to appear below it.

Default concept view

The concepts default view is shown below:
The concepts grid panel appears on the left of the screen and has a column with the name of the project concepts, in alphabetical order.

The tabs panel is on the right, and the description one on the lower left of the screen.

When a concept is selected, the tabs and description panel show the relevant information for that concept.

The default view may not be modified or deleted.

**Concept grid panel**

The concept grid panel will appear on all the views that may be defined by the user. This panel consists of a series of columns showing the attributes and characteristics of the concepts. The default view has only one column, showing the name of the concepts.

The concepts are shown with the color configuration explained in section Requirement grid panel.

In the columns with attributes, if they are enumerated, the different values of the attribute may appear in different colors. These colors are configured during the attribute type definition process (see section Attribute types).

**Column inclusion and exclusion**

The concept views shall at least show the name column, which is obligatory. To include new columns, select the option Configure by clicking button [ ] on the tool bar located right above the grid panel. The following menu appears:
There are three types of fields that may be included as columns on the concepts grid panel:

- **Predefined attributes**.
- **Organization elements**.
- **User attributes**.

The options available for configuring the concept grid panel are the same as in the case of requirements (see the section on Column inclusion and exclusion for the requirements grid panel).

**Filter selection**

It is possible to apply a filter to the concepts list. To do this, click button in the grid panel configuration dialog box. The following window will be shown:

This window may be used to create the desired filter and to select it so the concepts list shows only the elements that fulfill a certain condition.

**Concept organization**

The grid panel configuration dialog box may be used to decide what criteria are to be used to order the concepts on...
the list to be displayed.

The available options are the same as for requirements (see the Ordering requirements section).

**Edit modes on the grid panel**

They are the same as the ones available for requirements (see the Edit modes on the grid panel section in the requirements chapter).

**Available options on the grid panel**

The buttons tool bar for modification of the concepts view is the same as the one available for requirements (see the Available options on the grid panel section in the requirements chapter).

The Concepts Classification Bar has the following appearance:

```
<table>
<thead>
<tr>
<th>1st Level</th>
<th>List:</th>
<th>2nd Level</th>
</tr>
</thead>
</table>
```

The bar contains a first fold-down menu for a first level classification, with the following options:

- **List.** Shows the unclassified concepts, in list format, only with the order criteria input in the configuration panel.

- **Attributes.** When this option is selected, it activates the fold-down menu located on its right, where a list of the enumerated attributes (single and multivalued) appears. This menu is used to select the attribute to be the sorting criteria. The fold-down menu on **Second level** is also activated to allow selection of another enumerated attribute as 2nd level classification criteria.

- **Access Partitions.** This option orders the concepts on the list according to the access partition they are located in.

- **Requirements.** Shows the concepts grouped according to the requirements they are linked to.

- **Services.** Shows the concepts grouped according to the services they are linked to.

- **Attributes, Operations and Relationships.** Shows the concepts in tree format where, under the name of each concept, there appear its attributes, operations and relationships with other concepts.
The Filter Bar shows the identification of the filter included in the grid panel definition.

**Special options on the grid panel**

They are the same as the ones available for requirements (see the Special options on the grid panel section in the requirements chapter).

**Filtering the concepts list**

The concepts list on display may be filtered using the button on the tool bar.

The same dialog box appears as in the case of the grid panel filter configuration described above.

Note that this filter is temporary, that is, it is only applied while the user decides not to deactivate it, but does not form part of the configuration panel.

**Management of Concepts view**

The user may create views of concepts, modify or suppress them, using the options described below.

**Creation of concept views**

To create new concepts views, the user must create the desired configuration using the options of the Configuration and Classification Bars of the grid panel, and then click the button on the Configuration Bar. Then the dialog box to save views appears, with the same options as described for requirements (see the Creation of requirements views section in the requirements chapter).

The parameters saved in the configuration are the same as described for requirements (see the Creation of requirements views section in the requirements chapter).

**Modification and deletion of concept views**

To modify or delete concept views it must be selected the option Views Management on the menu Engineering process>Analysis>Concepts, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar. A dialog will appear with the same options as the ones available for requirements (see the Modification and deletion of requirements views section).

**Selection of concept views**

To open a concept view that has already been created, that view must be selected on the menu Engineering process>Analysis>Concepts, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar.

Another possibility is to select the option Views Management also shown on that menu. Then, in the view management dialog box, select the one to open and click the OK button.

**Sharing concepts views**

To share a concept view the Views management option must be selected on the menu Engineering process>Analysis>Concepts, or on the fold-down menu to the right of the button of the Requirements capture and Analysis bar.

The process to follow to share a view and the behaviour of the tool as a consequence of this process is the same...
as in the case of requirements (see the Sharing requirements views section).

Concept description panel

The description panel allows viewing and modification of the concept description selected on the grid panel. The available characteristics and options in this panel are the same as described in the section Requirements description panel.

Tab panel in the Concept view

On the right side of the concepts default view there is an information panel for the concept selected on the list on the left. As in the case of the description panel, this may be hidden, the size and location on the screen changed, or it may be transformed into a tab that will fold down when the pointer is placed on it.

This panel is formed by a set of tabs showing information in an organized way. These tabs are as follows:

- Details.
- Blocks and Attributes.
- Related Elements.
- Attributes and Operations.
- Synonyms.
- Diagrams.
- Versions.

The function of each one of these tabs is described below.

Details Tab

We are shown the following information on the concept selected:
The meaning of these fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

**Blocks and Attributes Tab**

It shows information on the blocks to which the concept belongs and the values taken for the concept by the attributes linked to it.

The characteristics and options available on this tab are the same as shown in the Blocks and Attributes Tab of the requirements view.

**Related Elements Tab**

Allows the concept selected to be linked to other elements of the specification.
At the top of the Related Elements tab there is a fold-down menu where the user may select the type of elements to view. The available options are:

- Implementation Classes.
- Domains.
- External Elements.
- Requirements.
- Services.

The characteristics and options available on this tab are the same as the ones available for requirements (see the Related Elements Tab section in the requirements chapter).

The links between Concepts and Implementation Classes is a special type of association, which means that the implementation classes that are imported from a Design tool, derive from IRQA® concepts. These relationships can not be modified manually in this tab, so the buttons and are not active in this case.

The relationships of Concepts with Services introduce a special property: if the selected concept is included in any sequence diagram associated with a service, the relationship between the service and the concept cannot be eliminated in this tab.

**Attributes and Operations Tab**

This tab may be used to define attributes, operations and relations for the concept (same as a UML class) selected on the grid panel.
Four folders may be seen on the tab: Attributes, Operations, Relationships and Types. To create one of these elements, the appropriate folder must be selected and the button clicked. The following dialog box appears to create a new operation:

![Add Operation Dialog Box]

The name of the operation must be input in it. One may also select the type, which is optional. This dialog box is the same in the case of adding an attribute.

Arguments may be linked to the operations. To do this, one must select the Arguments folder for the operation and click on New. A dialog box like the one shown above appears, to input the name of the argument and, optionally, select the type.

Creation of types for attributes, operations and arguments may be performed by selecting the Types folder and
clicking on **New**. The following dialog box will appear:

![Add Type Dialog](image)

where the type name is input.

The types creation dialog box may also be accessed as follows: in the dialog box for creation or edition of attributes, operations or arguments, select the option “--- New Type ---” on the fold-down menu to select the type.

The Relations folder contains the relations between each concept and the other ones. New relations between concepts may be created, selecting the folder and clicking on **New**. The following dialog box will pop up:

![Relationship Dialog](image)

In this dialog, the second class participating in the relation is selected (the first is that selected on the grid panel) and one may specify the name, description and type of relation, in addition to the cardinal numbers and role of each concept participating in it.

The relations between concepts may also be defined in the concepts diagrams.
To modify or delete an attribute, operation, argument, relation or type, the element must be selected and buttons **Edit** and **Delete** be clicked respectively.

It is also possible to modify any of these elements by selecting and double clicking it.

**Synonyms Tab**

The objective of this tab is to allow creation, modification and deletion of Synonyms of the concepts included in the project. These operations are performed using the buttons New, Edit and Delete shown on the tab. It is also possible to modify a synonym by selecting and double clicking it.

These synonyms will be identified by the Automatic Analyzer like the concept to which they are linked (see the Automatic Analyzer section).

**Warning:** Functions in Synonyms tab are not available in IRQA 4 version 1.

**Diagrams Tab**

This tab shows the list of concept diagrams and sequence diagrams the concept selected on the grid panel is included in.
To include concepts in diagrams, see the sections Concepts diagrams (Object Oriented) and Sequence Diagrams.

**Concepts definition**

To add, edit and delete concepts in the Concepts view, the options available are the same as described in the Inputting requirements section.

The only difference is that concepts only have name and access partition as predefined attributes.

**Concepts diagrams (Object Oriented)**

When the project is opened in Object Oriented mode, we find the option Concept Diagrams on the menu Engineering process>Analysis and the button 📊 on the Requirements capture and Analysis bar, that allow us to access the concepts diagrams management dialog box:
This dialog box shows a list of the concept diagrams in the project that belong to an access partition in which the user has, at least, read rights.

In this dialog the following options appear:

- **Check In**: Allows to check-in the selected diagram.

- **Check out**: Allows to check-out the selected diagram.

- **Undo Check Out**: Allows to check-in the selected diagram going back to the previous version.

For more details on diagrams versions, see Individual element version control.

- **Delete**: Allows to delete the diagram selected, after requesting user confirmation. If the diagram is check-in it is not possible to delete it.

- **Edit**: Allows to modify the name, description and access partition of the selected diagram. If the diagram is check-in it is not possible to edit it.

- **Restore**: Allows to recover a deleted diagram or to eliminate it from the project.

- **Ok**: Allows to open the selected diagram or to create a new one. It is also possible to open a diagram just by double clicking on it. If the opened diagram is checked-in, it is not possible to modify it.

- **Cancel**: It closes the concept diagrams dialog.

To create a diagram, the user must select the element “New” on top of the list of diagrams and click on “OK”. The dialog box in the following figure appears, to input the name, an optional description and the access partition to assign the concept diagram to. The access partition menu will only show those partitions that may contain concept diagrams and in which the user has write rights.
The "OK" button is clicked once this data is input. An empty diagram is then shown with the relevant tool bar, the functions of which are as follows:

- Create a concept and include it in the diagram.
- Include a concept (already existing in the model) in the diagram.
- Create and include a relation of association between two concepts.
- Include a binary association relation (already existing in the model) in the diagram.
- Create and include a relation of inheritance between two concepts.
- Include a relation of inheritance (already existing in the model) in the diagram.
- Create and include a relation of aggregation between two concepts.
- Include a relation of aggregation (already existing in the model) in the diagram.
- Create and include a relation of association between three concepts.
- Include a ternary relation of association (already existing in the model) in the diagram.

To see the detail of the common tool bars of all the graphic editors, see the sections Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams.

The concept diagram editor is shown in the following screen:
When creating a new concept in the diagram, depending on the configuration set by the project administrator, there are two possibilities:

- The user is given the option of automatically including this concept in the domains to which the diagram belongs.
- The concept is automatically included in the domains to which the diagram belongs.

To create an association relation between two concepts, the user must click on \( \text{\textbullet} \) \( \text{\textbullet} \). The pointer changes to \( \text{\textbullet} \) \( \text{\textbullet} \), which indicates that you must click on the first concept to link. Once that concept is selected, the pointer \( \text{\textbullet} \) \( \text{\textbullet} \) appears; the mouse must be dragged without releasing the left button to the second concept to link. Once this is done, the dialog box in the following figure appears, to input the details of the relation to be created: name, description, cardinal numbers and role, none of which is obligatory.

After clicking on “OK”, the new relation created will appear on the diagram.
When an element of the diagram is selected, whether a concept or a relation, a context menu is shown by right clicking. In this menu it is possible to choose one of the graphic options also shown on the button bar. This menu may also be used to access specific information on the element selected, to view or modify it. The menu shown by selecting one of the concepts is as follows:

- Graphics
- Layout
- Zoom

Select all

- Save Image
- Display associated requirements
- Properties

If either of the options Display associated requirements or Properties is chosen, the tool opens the concepts text view where the properties requested are displayed.

The menu concerning the relation between two concepts is as follows:

- Graphics
- Layout
- Zoom

Select all

- Save Image
- Tighten
- Properties

The option Properties brings up the relations definition dialog box where the properties of the relation may be changed. A Related Requirements tab also appears, where it may be seen the list of linked requirements with the relation selected.

**Entities View (Functional)**

When the project is opened in Functional mode, we find the option Entities on the menu Engineering process>Analysis and the button on the Requirements Capture and Analysis bar. In either of the two cases, the entities view menu is presented, with the same options and characteristics as those in the concepts view.

**Entities default view**

The entities default view is shown on below:
The characteristics of this view are the same as on the Default concepts view. The elements defined on the concepts view may also be seen and managed on the entities view when the project is opened in functional mode. Likewise, when the project is opened in object oriented mode, the concepts view shows the elements defined as entities in the functional mode.

**Grid panel of entities**

The panel with the list of entities has the same characteristics and properties as the Concept grid panel. The only difference is on the Classification Bar. In the fold-down menu for classification of the first level, the last option is *Attributes and Relationships*. When it is selected, it shows the entities in tree format where, under the name of each one, their attributes and relationships with other entities are shown. On the concepts view, the operations are shown as well.

**Management of entities view**

The user may create views of entities, modify or suppress them, as long as the project is opened in functional mode. The entities view management options are the same as available for Management of Concepts view when the project is opened in object oriented mode.

**Entities Description Panel**

The description panel allows viewing and modification of the entity description selected on the grid panel. The characteristics and options available on this panel are the same as described in the section Requirements description panel.

When Word documents are generated from IRQA®, the description characteristics of the entities are maintained matching the advanced editing options available on that panel.

**Tab panel on the entities view**

On the right of the entities default view, there is the information panel for the entity selected on the list on the left. As in the case of the description panel, this may be hidden, the size and location on screen changed, or it may be turned into a tab that opens when the pointer is placed on it.

This panel is formed by a set of tabs that show the information in an organized way. These tabs are as follows:

- Details.
- Attributes.
- Related Elements.
- E-R Attributes.
- Synonyms.
- Diagrams.
- Versions

The information shown and the options available on these tabs are the same as the Tab panel in the Concept view, except for some small differences that are shown below.

**Related Elements Tab**
The types of elements that may be displayed on this tab are:
- Domains.
- External Elements.
- Requirements.
- Services.

That is, these are the same as on the concepts view, except for the implementation classes, that may not be linked to the entities, as they are inherent to object oriented modeling.

**E-R Attributes Tab**
The entities attributes may be defined on this tab.
The available options on this tab are the same as on the Attributes and Operations Tab on the Concepts view, except that operations may not be defined on the entities view.

As to relations, the only type of possible relation between entities is binary link.

**Diagrams Tab**
This tab shows the list of the Entity-Relationship diagrams in which the entity selected on the grid panel is involved.
To include entities in Entity-Relationship diagrams, see the section Entity-Relationship Diagrams (Functional).

**Definition of entities**
To add, modify and delete entities when opening the project in functional mode, there are the same options as for Concepts definition on opening the project in object oriented mode.

**Entity-Relationship Diagrams (Functional)**
When the project is opened in Functional mode, we find the option ER Diagrams on the menu Engineering process>Analysis and the button on the Requirements capture and Analysis bar, that allow us to access the Entity-Relationship management dialog.

This dialog works the same way as this for Concepts diagrams (Object Oriented).
The specific tool bar for the Entity-Relationship diagrams is as follows:

- Create an entity and include it in the diagram.
- Include an existing entity in the Entity-Relationship diagram.
Create a relation and include it in the Entity-Relationship diagram.

Include an existing relation in the Entity-Relationship diagram.

To see the detail of the common tool bars of all the graphic editors, see the sections Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams.

The Entity-Relationship diagram editor is shown on the following screen:

![Entity-Relationship diagram]

The way to create relations and the available options on the context menus of entities and relations are the same as in the case of the Concepts diagrams (Object Oriented).

**Automatic Analyzer**

**Definition**

The Automatic Analyzer is a feature of IRQA® that allows, based on the description of a requirement, to obtain the possible relations that requirement may have with other elements of the model.

That feature is available in the option Automatic Analyzer on the menu Engineering Process>Analysis, and on the button on the Tools bar.

The Analyzer takes each word of the description, obtains its root and compares it with the concepts/entities and services. It is not only a comparison of words, but rather of their root, that is, it includes grammatical rules that take into account the verb endings, plurals, etc.

As to possible relations that may be established, the Analyzer studies the concepts (with their attributes and operations)/entities (with their attributes), and the names of the services.

The relations proposed by the analyzer will be shown with a red mark, and a black one for those already established. The user is allowed to eliminate the relations proposed as well as those previously established, or to establish new ones (the latter marked in black) by checking the relevant box:
The button **Set relationships** performs the following actions on the elements of all the tabs of the analyzer:

- Establishment of all the relations marked on the analyzer, whether these are new relations proposed by the user, or relations proposed by the analyzer.
- Elimination of all the relations not marked by the analyzer.
- Re-initializing the automatic analyzer so the relations proposed by the analyzer that have not been unmarked by the user will be shown in black.

These relations established using the Establish relations button will remain, regardless of whether the OK or Cancel button is then clicked.

The button **Unselect all** will automatically delete all the boxes marked in red as well as black of the elements of the active tab at that moment. That action will not affect the rest of the trees on other tabs.

Default, on the trees shown in the field "Relations Proposed" only shows the root nodes. To see the complete tree, the **Expand tree** button must be clicked.

The **Cancel** button closes the dialog box without performing any other action. The **Ok** button closes the dialog box establishing all the relations marked on the trees at that moment, regardless of whether they have been proposed by the Analyzer or the user.
It is important to emphasize that if all the attributes and operations of a concept are marked, the concept will also be related.

If the grid panel has more than one requirement selected for the automatic analyzer application, a dialog will appear in which the tool gives the operation of confirming the relations proposed requirement by requirement.

If the non confirmation option is chosen, the tool will automatically establish the relations identified as requirements with concepts and services.

If the confirmation option is chosen, the following window will be shown:

![Possible relationships dialog box](image)

The button **Next >>** may be used to view the relations proposed and existing ones for the next requirement. When we reach the last requirement of those selected, the button will be deactivated.

The button **<< Back** allows us to return to display the existing and proposed relations for the previous requirement. If we are on the first requirement, the button will be deactivated.

The button **Set relationships** allows us to establish the relations that are marked at that moment, whether proposed by the analyzer or those established manually by the user. The relations proposed by the analyzer, which are shown in red, will be shown in black once they are already established.

If the button Next is clicked, if the button Establish relations is not used for the previous requirement, the relations of the previous requirement will not change.

The button OK on the exterior window establishes all the relations proposed, for the present requirement as well as the remaining ones that have not yet been viewed, and ends the process. If the button Cancel is clicked, no change will be made either in the present requirement, or in those that have not yet been viewed.

The Cancel button on the exterior window ends the process and the relations proposed for the requirements that
have not yet been viewed are left unchanged, from the one presently on screen to the last on the list selected.

**Requirements for the analyzer to operate**

For correct operation of the analyzer, a DSN must be created to point to the data base `normalizer.mdb`, a special data base that contains the grammatical rules used to deduce the existing relations between the words that define the concepts and their possible linguistic relations (increasers, plurals, diminutives, etc.). This data base is provided with the tool and the installation process of IRQA® automatically creates the relevant DSN.

Should that DSN not exist, the Automatic Analyzer is not activated. To create that DSN from IRQA®, one must select the option Tools>Configuration>Configuration of the Automatic Analyzer. The following dialog box is obtained:

![Image of configuration dialog box]

In this dialog, one must click the button `Create DSN Analyzer`.

**Configuration**

There is a version of the automatic analyzer of IRQA® in English and Spanish. By default, the Analyzer is configured on running IRQA® in the application language. If a project is opened in another language that is not the one used in the IRQA® installation, it must be reconfigured. To do this, the Automatic Analyzer option is selected in the menu Tools>Configuration, that activates the previous dialog box, where the new language must be chosen.

**Warning**: In IRQA 4 version 1 the Automatic Analyzer is not available.

**Motives view**

Motives are used to identify the reason that there is a relationship between requirements, between test scenarios or between blocks (both direct or a generalization link). These types of relationship can be set, either in the traceability matrix, or in the tabs of related elements (see the Related Requirements Tab section), or in block diagrams.

**Managing motives views**

To open the motive views, the user should display the Engineering process>Motives menu, or alternatively press the menu available to the right of the button of the Requirements Capture and Analysis bar.

This menu gives the same options as for other IRQA® elements (see the Requirements view section).

The default view of motives is as follows:
Motive views are made of up to three panels:

- Grid panel: A column with the name of the motives can always be seen. The options available to manage this panel are similar to those of other IRQA® elements (see the Requirement grid panel and Requirements view management sections); although in this case only columns with predefined attributes and organization elements (baselines) can be added.

- Description panel: This shows the description of the motive selected in the grid panel (see the Requirements description panel section).

- Tabs panel: The following tabs appear; they show information about the motive selected in the grid panel.
  
  - Details
  - Versions

Next, the function of each of these tabs will be described.

**Details Tab**

The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

**Versions Tab**

This tab shows information about the versions of the selected motive and the differences between them (see the Individual element version control section).

**Motives definition**

To add, edit and delete motives in the Motives view, the options available are the same as described in the Inputting requirements section.

The only difference is that motives only have predefined attributes that are name and access partition.
Specification

Introduction

Specification of the solution consists of establishing a description of the system functions and their behaviour in relation to the exterior.

In IRQA®, the central element for specification of the solution is the service. A service is a set of activities carried out by the system to perform a specific function. The set of services will comprise the high level specification of the solution.

The services provided by the system are aimed at resolving the user requirements.

To provide the description of the system behaviour in IRQA®, functional or object oriented modeling may be used.

To represent the interaction of the system with the exterior, IRQA® allows use diagrams to be used, in which the services are represented as use cases and the actors with which they interact. These actors are shown as external entities when using functional context diagrams.

The services in IRQA® may be described in detail using state diagrams, sequence diagrams (both with UML notation), Data Flow Diagrams or scenarios.

Services View

To open the services view, the user can open the menu Engineering Process>Specification>Services, or click on the fold-down menu to the right of the button on the bar for Solution specification and Testing. In either of the two cases, a menu is displayed, initially with three options:

- Predetermined: Opens the predetermined services view.
- View management: Opens the services view management dialog box.
- Default: Opens the services default view. Initially, this is also the predetermined view.

If you click directly on the button on the bar for Solution specification and Testing, the predetermined view opens. The user may determine what services view to mark as predetermined.

This menu will also show the new views of services created by the user, to allow him to select the one he wishes to open.

The services views may have up to three panels:

- Services list. This panel will always appear.
- Property tabs of the service selected.
- Description window of the service selected.

The grid panel always appears at the top left of the screen. The other two panels may be resized and placed in the place on the screen the user considers most appropriate. If either of the two panels is placed at the top, the grid panel automatically relocates itself under it.

Default view of services

The default view of services is shown on the following screen:
The services grid panel is displayed on the left of the screen and has two columns: code and name of the project services, arranged in alphabetical order by codes.

The tab panel is displayed on the right, and the description one on the lower left of the screen.

When a service is selected, the tabs and the description panel show the information for that service.

The default view cannot be changed or deleted.

Services grid panel

The panel with the services list will be displayed in all the views the user may define. That panel consists of a series of columns showing attributes and characteristics of the services. There are only two columns in the default view, showing the code and the name of the services.

The services are shown with the color configuration for versionable elements explained in section Requirement grid panel.

The attributes columns, if listed, may show different values of the attribute. These colors may be configured when defining the attribute type (see section Attribute types).

Column inclusion and exclusion

In the services views, at least the columns code and name will be displayed, which are obligatory. To include new columns, the user must select the option Configure clicking the button on the tool bar located directly above the grid panel. The following menu is displayed:
There are several types of fields that may be included as columns on the services grid panel:

- **Predefined attributes.**
- **Organization elements.**
- **Reusability elements.**
- **Related elements.**
- **Diagrams.**
- **Attributes.**

The available options for configuration of the service grid view are the same as for requirements (see the Column inclusion and exclusion section in the requirements chapter).

For services, there is an additional type of elements that can be shown in the grid panel: use case diagrams and state diagrams in which each service is included.

**Filter selection**

A filter may be applied to the services list. To do so, click on the button in the configuration dialog box of the grid panel. The following window will be displayed:
This window may be used to create the filter desired and to select it so a services list shows only the elements that fulfill a certain condition.

**Service organization**

In the configuration dialog box of the grid panel, the user may decide what criteria are to be used to organize the services on the list to be displayed.

The available options are the same as in the requirements view (see the Ordering requirements section).

**Edit modes in the grid panel**

They are the same as in the requirements view (see the Edit modes on the grid panel section in the requirements chapter).

**Options available on the grid panel**

The buttons tool bar for modification of the service view is the same as in the requirements view (see the Available options on the grid panel section in the requirements chapter).

The Services Classification Bar has the following appearance:

<table>
<thead>
<tr>
<th>List Level:</th>
<th>List:</th>
<th>2nd Level:</th>
</tr>
</thead>
</table>

The bar contains a first fold-down menu for a first level classification, with the following options:

- **List.** Shows the unclassified services, in list format, solely with the order criteria input in the panel configuration.

- **Attributes.** When this option is selected, the fold-down menu on its right is activated, showing a list of the enumerated attributes of the project. The menu is used to select the attribute for ordering. The fold-down menu **Second level** is also activated to allow selection of another enumerated attribute as second level classification criteria.

- **Access Partitions.** This option organizes the services on the list according to the access partition where they are included.

- **Requirements.** Shows the services grouped according to the requirements they resolve.

- **Hierarchy.** Organizes the services in hierarchical order, according to their organization in the state diagrams. When this option is selected, the fold-down menu located on its right is activated, displaying a list to select the number of hierarchical levels one wishes to show. Service hierarchy can not be created manually in the service view. This hierarchy reflects the organization in state diagrams: child services of each service are the ones included in the state diagram (or diagrams) directly linked to the parent.

The Filter Bar shows the identification of the filter included in the definition of the grid view.

**Special options on the grid panel**

They are the same as the ones available for requirements (see the Special options on the grid panel section in the requirements chapter).

**Filtering the list of services**

The list of services on display may be filtered by clicking the button ![Filter Button](image) on the tool bar.

The same dialog box is shown as in the case of configuring the filter for the grid panel as described above.

Note that this filter is temporary, that is, it only remains active while the user decides not to deactivate it, but it is not
Management of services views

The user may create services views, modify or suppress them using the operations described below.

Creation of services views

To create a new services view, the user must create the desired configuration using the options of the Configuration and Classification Bars of the grid panel, and then click the button on the Configuration Bar. Then the dialog box to save views appears, with the same options as described for requirements (see the Creation of requirements views section in the requirements chapter).

The parameters saved in the configuration are the same as described for requirements (see the Creation of requirements views section in the requirements chapter).

Modification and deletion of services views

To modify or delete services views one must select the option View management shown on the menu Engineering process>Specification>Services, or on the fold-down menu on the right of the button on the bar for Solution specification and Testing. A dialog will appear with the same options available as the ones available for requirements (see the Modification and deletion of requirements views section).

Selection of services views

To open a services view that has already been created, that view must be selected on the menu Engineering process>Specification>Services, or on the fold-down menu on the right of the button on the bar for Solution specification and Testing.

Another possibility is to select the option View management that also appears on that menu. Then, in the views management dialog box, select the one to open and click on the .

Sharing services views

To share a service view the Views management option must be selected on the menu Engineering process>Specification>Services, or on the fold-down menu on the right of the button on the bar for Solution specification and Testing.

The process to follow to share a view and the behaviour of the tool as a consequence of this process is the same as in the case of requirements (see the Sharing requirements views section).

Services description panel

The Description panel allows viewing and modification of the description of the service marked on the grid panel. The characteristics and options available on this panel are the same as described in the section Requirements description panel.

Services views tab panel

On the right side of the services default view, there is the information panel of the service marked on the list on the left. As in the case of the description panel, this may be hidden, the size and its location on screen changed, or it may be turned into a tab that opens up when the pointer is placed on it.
This panel is formed by a set of tabs that show the information in an organized manner. These tabs are as follows:

- Details.
- Definition.
- Related Elements.
- Blocks and Attributes.
- Associated files.
- Related Services.
- Versions.
- Graphic Description.
- Fulfilled Requirements.

A description of the function of each one of these tabs is now provided.

**Details Tab**

This shows us the following information about the service selected:
The meaning of these fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The Responsibilities field is an attribute specific for services. It is a free text field where the user may explain the responsibilities of the system performed by the service.

**Definition Tab**

It allows to see the description of a service from the point of view of its definition as a use case: actors using it, triggering events and associated scenarios.

Below the sections on actors and events, the following buttons appear:

- ![Create button](image)
  - It shows the dialog for creation of actors or events (see the sections Actors and Events). It allows to create a new actor or event in the project and to link it to the selected service.

- ![Delete button](image)
  - It allows to delete from the project the selected actors or events. The user is asked for confirmation before actually performing the deletion.

- ![Associate button](image)
  - It allows to associate existing actors or events to the selected service. In order to do that, the actors or events must be selected in the dialog and the OK button must be clicked.
It allows to delete the links between the service and the selected actors or events.

To edit already defined elements or to input their description, it is necessary to open the view of the relevant element. When double clicking on the name of an actor or event, the tool navigates to the relevant view and selects the element.

In the lower part of the tab there is a section showing the scenarios linked to the selected service. Operations that can be done on them are the following:

- It shows a dialog to create scenarios. It allows to create a new scenario in the project and to link it to the selected service.
- The Description field in this dialog only allows free text. If any special format is to be added, it will be done later in the scenarios view in the Description panel.
- It allows to delete from the project the selected scenarios. The button becomes active only when the line with code and name of the scenario is selected. The user is asked for confirmation before actually performing the deletion.
- It allows to associate existing scenarios to the selected service. In order to do that, the scenarios must be...
selected in the dialog and the OK button must be clicked.

: It allows to delete the links between the service and the selected scenarios. The selection must be done on the line with the code and name of the scenario.

: It allows to add new steps to the selected scenario. The selection must be done on the line with the code and name of the scenario. The new steps are always added after the already existing ones. The options available in the dialog for definition of steps are described in the Details Tab section in the scenarios view description (this dialog is the same that appears when the Insert button is clicked).

: It allows to modify steps in a scenario. A step must be selected for this option to become active. Then, the selected step is edited to be modified, but in the dialog that it is shown, it is also possible to edit previous or subsequent steps. The options available in this dialog are described in the Details Tab section in the scenarios view description (this dialog is the same that appears when the Edit button is clicked).

To edit already defined scenarios, to modify their description, precondition or postcondition, or the sorting of steps, it is necessary to open the scenarios view. When double clicking on the line with the code and name of an scenario, the tool navigates to the relevant view and selects the scenario.

**Related Elements Tab**

Allows the service selected to be associated with other elements of the specification, except for requirements and services that, due to their special importance, are included in other independent tabs.

A fold-down menu is displayed at the top of the Related Elements tab that may be used to select the type of elements to be viewed. The available options are:

- Actors (External Entities, in functional mode).
- Implementation classes (only if the project is opened in object oriented mode).
- Concepts (Entities, in functional mode).
- Concept diagrams (Entity-Relation Diagrams, in functional mode).
- Domains.
- External Elements.
- Scenarios.
- Test Scenarios.
- Events.
- Processes.

The characteristics and options available on this tab are the same as the ones available for requirements (see the Related Elements Tab section in the requirements chapter).

The association between Services and Implementation classes is a special kind of relation, the meaning of which is that the implementation classes, which are imported from a Design tool, originate in the IRQA® services. These relations cannot be modified manually on this tab, so the buttons and are not activated in this case.

The relationships with Actors and Concepts introduce a special property: if an actor or concept is included in any sequence diagram associated with the service, the relationship between the service and the actor or concept cannot be eliminated in this tab.

If the type of element selected is Test Scenarios, the options are activated to manage suspect links (see the section Management of suspect links).
Blocks and Attributes Tab

It shows information concerning the blocks to which the service belongs and the values taken for the service by the attributes associated with it.

The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view.

Associated files Tab

This tab allows external files of any kind to be associated to a service.

The characteristics of this tab and the available options it presents are the same as those shown on the Associated files Tab of the requirements view.

Related services Tab

This allows relations to be established of the “extend” and “include” type (the same as relations between use cases in UML) between the service selected and other project services.

Operation of this tab is the same as described for the Related Elements tab.

It also provides the option of selecting a block of services, so the tab shows only the services belonging to that block. If a block diagram is selected as active in the Blocks toolbar, the dropdown menu will show only the blocks of
services included in the selected diagram.

For related services, the type of relation is shown:

- The service selected is extended by that shown in the tab.
- The service selected extends that shown in the tab.
- The service selected includes that shown in the tab.
- The service selected is included in that shown in the tab.

When a relation between services is established, it is the first type by default.

The type of a relation between services may be modified by selecting it on the fold-down menu displayed when the pointer is placed on it.

Only relations of one type may be displayed, by selecting it on the fold-down menu Show Type that appears under the box with the related services. The default is to show all.

**Versions Tab**

Shows information on the versions of the service selected and the differences between them (see section Individual element version control).

**Graphic Description Tab**

This tab allows the elements describing them to be associated to a service; these may be of four kinds:

- Data Flow Diagrams (DFDs).
- State diagrams.
- Sequence diagrams.
- Scenarios.

When the option State diagrams is selected on the menu Type, displayed on the right of the tab, the following information is displayed:
The tree displays the state diagrams associated with the service selected. By picking the DFDs option, the tree shows the Data Flow Diagrams associated with the service.

When the Sequence Diagram option is selected in the Type menu, the following information is displayed:
The project’s sequence diagrams appear in the tab. They can be associated to the selected service using the $\text{}^\uparrow$ and $\text{ }^\downarrow$ buttons.

When the user associates a sequence diagram to the selected service, the actors and concepts included in the diagram are also automatically associated to the service.

When the user eliminates the association of a sequence diagram to the selected service, the dialogue box below is shown; in it the user can select the concepts and actors included in the diagram for which the relationships with the service are also to be eliminated. When there are actors and concepts with which the service has a relationship in some use case or sequence diagram, they cannot be selected in this dialogue box.
If [Cancel] is selected, the relationship between the service and the diagram is deleted, but not the ones between the service and the elements included in it.

If the user selects one or several concepts and actors, and presses the [Unrelate] button, the relationship of the service with the selected elements, as well as the relationship with the diagram will be eliminated.

In these cases, the available options are the following:

- **Diagram Management**: Shows a dialog box that allows to manage the diagrams belonging to the type selected in the Type menu. The options available are the same as in the concept diagram management (see Concepts diagrams (Object Oriented) section). The dialog shows all diagrams of the relevant type, linked or not to the selected service. If the [New] button is clicked in this dialog, the newly created diagram will be associated to the selected service.

- **New**: Allows creation of a new state diagram, sequence diagram or DFD associated with the service selected. The name of the diagram must be input in the dialog box displayed and, optionally, a description. The access partition the diagram belongs to is shown, which is the same one the service it is associated with belongs to.

- **Open**: This is activated when a diagram is selected. It opens the diagram selected with the relevant diagrams editor.

If you double click on the name of a diagram, IRQA® will open it with the relevant editor.

When the option Scenarios is selected on the menu Type, the tab shows the scenarios of the project that may be associated with the service selected using the buttons [▲] and [▼].

The options available on the tab are as follows:

- **New**: Allows a new scenario to be created, associated with the service selected. The dialog box shown is used to input the code, name and access partition of the scenario.

By double clicking on a scenario, IRQA® opens the scenarios view with the scenario selected.

**Fulfilled Requirements Tab**

It allows the service selected to be associated with the requirement or requirements solved by it.
Operation of this tab is the same as that described for the tab Related Elements.

It presents the option of selecting a block of requirements, so the tab shows only the requirements that belong to that block. If a block diagram is selected as active in the Blocks toolbar, the dropdown menu will show only the blocks of requirements included in the selected diagram.

The options for management of suspect links are active (see the section Management of suspect links).

**Definition of services**

To add, edit and delete services in the Services view, the options available are the same as described in the Inputting requirements section.

As in the case of requirements, the services code may be configured by selecting the option Tools>Configuration>Codes>Service codes (see section Automatic assignment of requirements codes). The user may also change the coding of a group of services that have already been input (see section Automatic recoding of requirements), or change only the prefix or suffix of the code (see section Partial recoding of requirements).

**Importing services**

IRQA® provides the possibility of including services in a project automatically, as long as these are available in electronic media in any format that can be processed by IRQA® Import Tool.

For further information on the use of this tool, see the IRQA® Import Tool User Guide.
Object Oriented Model

Actors

To access the views of actors, the project must be opened in object oriented mode. The user may access the menu Engineering process>Specification>Actors, or click on the fold-down menu to the right of the button on the bar for Solution specification and Testing.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of actors is as follows:

The views of actors are formed by a maximum of three panels:

- Grid panel: A column always appears with the name of the actors. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management).

- Description panel: Shows the description of the actor selected on the grid panel (see section Requirements description panel).

- Tab panel: The following tabs appear, showing information on the actor selected on the grid panel:
  - Details.
  - Blocks and Attributes.
  - Related Elements.
  - Versions.

Details Tab

Shows information concerning the actor selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).
**Blocks and Attributes Tab**

Shows information concerning the blocks to which the actor belongs and the values taken for the actor by the attributes associated with it.

The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view.

**Related Elements Tab**

Allows the actor selected to be associated with other elements of the specification.

At the top of the tab Related Elements a fold-down menu is displayed where you can select the type of elements to be viewed. The available options are:

- Domains.
- Requirements.
- Services.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view. In the case of actors there is no management of suspect links. The menu Blocks is activated if the type of element selected is Requirements or Services.

The relationships of Actors with Services introduce a special property: if the selected actor is included in any sequence diagram associated with a service, the relationship between the service and the actor cannot be eliminated in this tab.

**Versions Tab**

Shows information on the versions of the actor selected and the differences between them (see section Individual element version control).

**Definition of Actors**

To add, edit and delete actors in the Actors view, the options available are the same as described in the Inputting requirements section.

The only difference is that actors only have name and access partition as predefined attributes.

**Use case diagrams**

These diagrams represent the services of the system and their interaction with the actors.

These diagrams may be accessed by clicking the button on the bar for Solution specification and Testing, or from the option Use Case Diagrams of the menu Engineering process>Specification. Then a dialog box appears showing the list of use case diagrams available in the project and that belong to an access partition in which the user has, at least, read rights.

The options available are the same as described for concept diagrams (see the Concepts diagrams (Object Oriented) section).

Once a diagram is open, the specific options available in the tool bar are the following:

- Create and include actors.
- Include actors (already existing in the project) in the diagram.
- Create and include use cases (services).
- Include in the diagram use cases (services) already existing in the project.
Create and include a relation between an actor and a use case, or between use cases.

Include in the diagram relations existing in the project.

Relationship between use cases of the use (include) type.

Relationship between use cases of the extend type.

To see the detail of the common tool bars of all the graphic editors, see the sections Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams.

The use case diagram editor displays the following screen:

The relations between actors and use cases must be created by taking the actor as first element and the use case as second. Otherwise, the relation is not created.

To create a relation between use cases, first the type must be selected by clicking on the buttons \( \text{Use} \) or \( \text{Ext} \). If there is already a relation of either type between two use cases, no other type may be established.

**Events**

To open the views of events, the user must access the menu Engineering process>Specification>Events, or click on the fold-down menu to the right of the button \( \text{Events} \) on the bar for Solution Specification and Testing.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view). The default view of events is as follows:
The views of events are formed by a maximum of three panels:

- **Grid panel:** A column always appears with the name of the events. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management), although in this case one may only add columns with predefined attributes, as events in IRQA® may not have attributes.

- **Description panel:** Shows the description of the event selected on the grid panel (see section Requirements description panel).

- **Tab panel:** The following tabs appear, showing information of the event selected on the grid panel:
  - Details.
  - Related Elements.
  - Versions

**Details Tab**

Shows information concerning the event selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

**Related Elements Tab**

Allows association to the event selected of other elements of the specification, in this case, only services. The menu Blocks is activated, which allows the services to be viewed to be filtered.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view.

The relations between events and services can not be marked as suspect.

**Versions Tab**

Shows information on the versions of the event selected and the differences between them (see section Individual element version control).
Definition of Events

To add, edit and delete events in the Events view, the options available are the same as described in the Inputting requirements section.

The only difference is that events only have predefined attributes that are name and access partition.

State Diagrams

State diagrams are used in IRQA® for detailed description of the behaviour of the system when a service is performed.

Access to these diagrams must be obtained from the services view, on the tab Graphic Description. The management utilities of the state diagrams are described in the section Graphic Description Tab.

The state diagrams editor has the tool bar described below:

- Create a new state (service) in the diagram.
- Include already existing states (services) in the project in the diagram. All the diagrams may include the states Beginning and End, which are not project services but just auxiliary states to indicate where execution of the state diagram begins and ends.
- Create a new transition between states in the diagram. Each transition has the following data associated: event, condition, action. The event is obligatory; by default, the event selected appears as “End of activity”. This event simply states that, on completion of the service the transaction originates in, execution of the service end commences. If that event is selected, its name is not shown in the state diagram. This event is also not shown on the list of events in the project. If the event one wishes to associate to the transition does not exist in the project, it may be defined through the create transition dialog box. The name of an event can be modified in this dialog by selecting the event and the Edit button, or by double clicking it.
- Include a previously created transition between states in the diagram.
- Open a parent diagram of the present diagram. This hierarchy may be multiple, that is, a state (service) may have various child diagrams associated. Moreover, a same state (service) may be included in the state diagrams children of different parent states (services). Due to this, a list is shown of diagrams to select the parent diagram one wishes to open.
- Creates a child state diagram of the state selected. Asks for the name and description for the child diagram and opens a new diagram editor to create the child state diagram. A symbol appears on the state selected showing it has a child state diagram.
- Shows the child state diagram of the state selected. As the hierarchy may be multiple, it shows the list of child diagrams to select the one to open.
- Deletes the child state diagrams of the state selected. Due to the fact that the hierarchy may be multiple, it shows the list of child diagrams to select those to delete.
- Displays selected state history symbol. It is only possible to display this symbol if the state has a child state diagram. It means that the state remembers the state in the child diagram in which it finished last time. It is possible to create transitions between the history and other states in the diagram, meaning that the transition starts directly in the state of the child diagram in which it finished last time.
Hides selected state history.
In the state selected it shows the states (services) included in the child diagrams.
Adds an internal transition in the state selected. The internal transitions must have an event associated (if the event is End of Activity, it is not shown in the diagram), and these may also have a condition and an action.
Edits the internal transitions of the state selected to modify the event, condition or action.
Deletes the internal transitions in the state selected.

To see the detail of the common tool bars of all the graphic editors, see the sections Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams.

The state diagrams editor displays the following screen:

On the transitions contextual menu, the option Properties displays the transition definition dialog box where the properties of the transition may be changed: event, condition, action.
By selecting the option Properties on the states contextual menu, IRQA® opens the services view with the element selected. By selecting the option Display Associated Requirements, IRQA® opens the services view and the tab Fulfilled Requirements, to show the requirements associated with the state selected in the diagram.
In the services view, the tab Graphic Description displays the state diagrams associated with the service selected in tree format, so it shows the hierarchy of diagrams built up with the graphic editor.

**Sequence Diagrams**

Sequence diagrams are used in IRQA® to describe the interaction between the actors and business concepts.
when performing a service. It is also possible to define sequence diagrams as a description of business processes, not directly linked to a service.

These diagrams can be accessed in various ways:

- Services view, Graphic Description tab. The sequence diagram management utilities are described in the Graphic Description Tab section.
- Engineering process>Specification>Sequence diagrams menu.
- button of the Solution Specification and Tests bar.

The following dialogue box can then be seen:

In this dialogue box, it is shown the list of existing sequence diagrams in the project that belong to an access partition in which the user has at least reading permission. The options available in this dialogue box are the same as those for concept diagrams (see the Concepts diagrams (Object Oriented) section).

When a sequence diagram is deleted, the tool will ask for confirmation from the user for whether or not the relationships of the elements with the services that the diagram is associated with, are also to be eliminated. If the user does not confirm deleting the relationships, the relationships of the services with the actors and concepts that were in the diagram are still maintained, even though the diagram is deleted. When there are actors and concepts with which some service has a relationship in some use case diagram or in another sequence diagram, the relationships with these services can not be eliminated.

The sequence diagrams editor has a tool bar that we shall now describe:

- Create a new concept in the diagram.
- Include concepts in the diagram that already exist in the project.
- Create a new actor in the diagram.
- Include actors in the diagram that already exist in the project.

The tool represents the life line of each one of those elements.

- Create a new message in the diagram. It asks for the name (obligatory) of the message being sent from the first selected element to the second. A description can optionally be entered. Messages can be created between any of the elements included in the diagram, including the possibility of messages that have the same element as the source and target.
Include in the diagram messages that exist in the project.

To see the detail of the tool bars common to all graphic editors, see the Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams sections.

The sequence diagram editor appears in the following screen:

To modify the order in which the actors and concepts are shown in the diagram, the user should select one of them and drag it to the new position desired. The element will be moved horizontally through the screen.

To modify the sequence in which the messages in the diagram are shown, the user should select one of them and drag it to the new position desired. The message will scroll vertically on-screen.

In the message context menu, the Properties option produces the messages definition dialogue box, in which the message properties can be changed: name and description.

The user should select the Properties option in the concepts and actors context menu to have IRQA® open the corresponding view with the selected element.

If the sequence diagram that is being created or modified is associated to one or several services, the following should be taken into account:

- The actors and concepts that are created or included in the diagram are also automatically associated to the services.
- If a concept or an actor is excluded from the diagram and it is not also related with the services in a use case diagram or in another sequence diagram, the tool will request confirmation from the user of whether or not to also eliminate the relationship of the element with the services that the diagram is associated with. If the user does not confirm deletion of this relationship, the element is excluded from the diagram but the relationship is maintained.
- If the actor or concept to be excluded is related to any of the services through another
diagram, this relationship is not removed.

In services view, in the Graphic Description tab the project's sequence diagrams can be seen; both the ones associated and the ones not associated to the selected service. The association can be set and/or eliminated in this tab (see the Graphic Description Tab section).

Functional Model

External Entities

To access the views of external entities, the project must be opened in functional mode, accessing the menu Engineering process>Specification>External Entities, or clicking on the fold-down menu to the right of the button on the bar for Solution specification and Testing.

The views of external entities show the same elements as in the views of actors when the project is opened in object oriented mode. Likewise, the external entities are shown as actors when the project is opened in object oriented mode.

The views of external entities display the same information and are managed in the same way as the views of actors (see section Actors).

Context Diagrams

The system context diagram is the level 0 Data Flow Diagram which shows the system as a process that interacts with the external entities, exchanging data flows.

These diagrams may be accessed by clicking the button on the bar for Solution specification and Testing, or from the option Context Diagrams of the menu Engineering process>Specification. Then a dialog box appears showing the list of context diagrams available in the project and that belong to an access partition in which the user has, at least, read rights.

The options available are the same as described for concept diagrams (see the Concepts diagrams (Object Oriented) section).

Creation of several context diagrams on a same project is allowed due to usability reasons: to avoid excessive complication of the diagram in the case of complex systems, and to allow division of the project into subsystems with independent context diagrams.

Once a diagram is open, a process that represents the system always appears. Its name may be edited and modified by double clicking on it.

The specific options available in the tool bar are the following:

- Create and include external entity.
- Include in the diagram external entities that already exist in the project.
- Create and include a data flow between an external entity and the system.
- Include in the diagram data flows between external entities and the system that already exist in the project.
- Check the consistency of the context diagram. Allows the following inconsistencies to be detected:
  - There being no data flows into the system. This is marked with a warning.
  - There being no data flows out of the system. This is marked with a warning.
• The existence of an external entity without flows in or out. This is marked as an error.

**Note:** This graphic editor is the same as the DFDs editor, but the buttons to add and include processes and data stores are deactivated as no more than one process may be shown in this diagram and data stores may not appear on this level either. The child DFD creation buttons are not active either, as in IRQA® the context diagram is not connected to the rest of the DFDs.

To see the detail of the tool bars common to all graph editors, see the Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams sections.

The context diagram editor displays the following screen:

To create a data flow between an external entity and the system, click on the button \[ \text{button} \]. The pointer changes to \[ \text{pointer} \], showing one must click on the original element of the data flow. Once it is selected, the pointer appears \[ \text{pointer} \]; hold down the mouse left key and drag the element to the one the data flow reaches. Then a dialog box appears to give a name, and optionally a description, to the data flow.

The context menu of external entities also shows the option Properties, in which IRQA® opens the view of external entities with the element selected.

**Processes**

To open the processes views, the user may access the menu Engineering process>Specification>Processes, or click on the fold-down menu to the right of the button \[ \text{button} \] on the bar for Solution specification and Testing. This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of processes is as follows:
The views of processes are formed by a maximum of three panels:

- **Grid panel**: A column always appears with the name of the processes. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management), although in this case one may only add columns with predefined attributes or organization elements (baselines), as the processes in IRQA® may not have attributes.

  The list of processes may be organized in tree format showing the hierarchy of DFDs by selecting the option (Services) on the fold-down menu which appears, above the list of processes. Each parent node on the tree is the service to which the first DFD of the hierarchy is associated.

- **Description panel**: Shows the description of the process selected on the grid panel (see section Requirements description panel).

- **Tab panel**: The following tabs appear, showing information of the process selected on the grid panel:
  - Details.
  - Related Elements.
  - Versions.

**Details Tab**

Shows information concerning the process selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

**Related Elements Tab**

Allows other elements of the specification to be associated with the process selected.

At the top of the tab Related Elements a fold-down menu is displayed where you can select the type of elements to be viewed. The available options are:
Requirements.

Services.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view. In the case of processes there is no management of suspect links.

Versions Tab

Shows information on the versions of the process selected and the differences between them (see section Individual element version control).

Definition of Processes

To add, edit and delete processes in the Processes views, the options available are the same as described in the Inputting requirements section.

The only difference is that processes only have predefined attributes that are name and access partition.

Data Flow Diagrams (DFDs)

If the structured analysis methodology is used, the services may be described in detail using DFDs.

Access to these diagrams must be obtained from the services view, on the tab Graphic Description. The DFD management utilities are described in the section Graphic Description Tab.

The DFD editor has the tool bar described below:

- Create and include processes.
- Include processes that already exist in the project in the diagram.
- Create and include a data flow between two processes.
- Include a data flow between two already existing processes in the diagram.
- Create and include external entity. This option is only available in the first DFD of the chain, which is associated directly to the service.
- Include external entities that already exist in the project in the diagram. This option is only available in the first DFD of the chain, that which is associated directly to the service.
- Create and include data stores.
- Include data stores already created in other DFDs.
- Open the DFD the parent process of the present one belongs to. This hierarchy is unique, that is, a process may only have one child DFD and a DFD may only have one parent process. Moreover, each process may only appear in one DFD.
- Create child DFD of the process selected.
- Open the child DFD of the process selected.
- Delete the child DFD of the process selected.
- Includes the inward or outward flows from the parent DFD. This button is only activated when
selecting a process in a child DFD. A dialog box is shown to select the flows of data from the parent DFD. The flows selected in this dialog box are linked directly to the process selected, in the relevant inward or outward direction. A same flow of data from a parent DFD may be linked to several processes in the child DFD. This option is also available on the contextual menu associated with processes with the name “Link with external flows”.

Check the consistency of the DFD. Allows detection of the following inconsistencies in the diagram displayed:

- Non existence of input flows to any process.
- Non existence of output flows from any process.
- The existence of an external entity without input or output flows.
- The existence of a data store without input or output flows.
- Non existence on a child diagram of any of the input or output flows of the parent process.

To see the detail of the tool bars common to all graph editors, see the Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams sections.

The DFDs editor displays the following screen:

To create a data flow between two elements click on the button 1. The pointer changes to 2, showing one must click on the original element of the data flow. Once it is selected, the pointer appears 3; the mouse must be dragged without releasing the left button to the element the data flow reaches. Then a dialog box appears that must be given a name, and optionally a description, to the data flow.

The contextual menu of data flows and data stores, with the option Properties, displays the dialog box for definition of the element, where its name and description may be changed.

By selecting the option Properties on the contextual menu of processes and external entities, IRQA® opens the relevant view with the element selected.

In the services view, the tab Graphic Description shows a tree format of the DFDs associated with the service selected, so it shows the hierarchy of diagrams built up with the graphic editor.
DFD Consistency

This option is available in the option DFD Consistency, on the menu Engineering process > Specification and the button on the bar for Solution specification and Testing.

When that option is activated, it checks the consistency for all the DFDs and context diagrams included in the project. It allows the following inconsistencies to be detected:

- Non existence of input flows to any process.
- Non existence of output flows from any process.
- The existence of an external entity in any diagram without inward or outward flows.
- The existence of a data store in any diagram without inward or outward flows.
- Non existence on a child diagram of any of the inward or outward flows of the parent process.

Scenarios

Another alternative to describe the services in IRQA® in detail is to use scenarios.

Scenario view management

To open the views of scenarios, the user may access the menu Engineering process>Specification>Scenarios, or click on the fold-down menu to the right of the button on the bar for Solution specification and Testing.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of scenarios is as follows:

The views of scenarios are formed by a maximum of three panels:

- Grid panel: There are always two columns with the code and name of the scenarios. The options
available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management).

- Description panel: Shows the description of the scenario selected on the grid panel (see section Requirements description panel).
- Tab panel: The following tabs appear, showing information of the scenario selected on the grid panel:
  - Details.
  - Related Elements.
  - Precondition and Post Condition.
  - Blocks and Attributes.
  - Versions.

**Details Tab**

Shows information concerning the scenario selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

In the lower part of the tab, the sequence of steps in the scenario are shown.

To add a new step to the scenario, the user must click on the button **Insert**. IRQA® displays the following dialog box:

![Dialog box for adding a step](image)

The step consists of four elements:

- Direction of the event that triggers the step. It is selected on a fold-down menu with the following options:
  - **System Destination →**: The event is started by an actor, which sends it to the system.
  - **System Origin ←**: The event is started by the system and addressed to an actor.
  - **Reflexive ↔**: The event is started by the system, that performs an internal action, without communication with any actor.

- Actor participating in the step. This is selected on a fold-down menu with a list of actors available in the project. There is the possibility of defining an actor by selecting the option New. If the System is...
selected as the actor, IRQA® automatically selects the direction Reflexive ↔. Likewise, if that direction is selected, the actor becomes System.

- Event that triggers the step. This is a free text (do not confuse with the events classified in the project, that have their own view and participate in the state diagrams). This is not obligatory, that is, it may be left blank.

- Step description. This is a free text field, it may be left blank.

The number to the right indicates the order occupied by the step in the step sequence of the scenario. IRQA® assigns this sequential number and may not be modified manually.

After filling in all the step data, click the button Add step, which stores the step just defined and allows to input data for the next step. By default, the tool proposes the following data:

- Direction. It is proposed the opposite one to the direction in the previous step (System Destination if it was Origin and viceversa). If the previous step was reflexive, then it is proposed as reflexive again.

- Actor. The default one is the same as in the previous step.

- Event and description. The default value is blank.

After filling in all the steps, click the button OK. The last input step is stored in the sequence of steps and the dialog closes.

If the Cancel button is clicked, then the last step being defined is not input, but the previous ones were already saved with the Add step button.

The order of the step sequence may be modified: to do so, the user must select a step and raise or lower it a place on the list using the buttons and .

To modify the data of a step, the user must select and click on . It then shows the same dialog box as for step creation and allows the data in it to be modified.

In this dialog it is possible also to modify the previous and subsequent steps using the buttons and . It is only possible to navigate until step 1 or until the last step already defined. To add new steps, the dialog must be closed and the Insert button clicked. If the Cancel button is used, only the data of the last step being modified are not saved.

To delete a scenario step, the user must select the step and click on .

Related Elements Tab

Allows the scenario selected to be associated with other elements of the specification.

At the top of the tab Related Elements, a fold-down menu is displayed to select the type of elements to be viewed. The available options are:

- Domains.

- Services.

The characteristics and options available on this tab are the same as those shown on the Related Requirements Tab of the requirements view. In the case of scenarios, there is no management of suspect links. The menu Blocks is activated if the type of element selected is Services.
**Precondition and Post Condition Tab**

This tab may be used to input information on the conditions prior to execution of the scenario (precondition) and the conditions of the system after execution of the scenario (post condition). In both cases, the information is input as free text.

**Blocks and Attributes Tab**

Shows information on the blocks to which the scenario belongs and of the values taken for the scenario by the attributes associated with it.

The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view.

**Versions Tab**

Shows information on the versions of the scenario selected and the differences between them (see section Individual element version control).

**Scenario definition**

To add, edit and delete scenarios in the Scenarios views, the options available are the same as described in the Inputting requirements section.

As in the case of requirements and services, the scenarios code can be configured by selecting the option Tools > Configuration > Codes > Scenario codes (see the section on Automatic assignment of requirements codes). The coding of a group of scenarios that has already been entered can also be changed (see the section on Automatic recoding of requirements), or just the code prefix or suffix (see the section on Partial recoding of requirements).

If the options for code modification appear deactivated, it means that they cannot be modified because the project administrator does not allow it.
Change Impact Analysis

Introduction

Requirements specification is a live element throughout the life of the project that may undergo modifications at any time, due to requests from the customer, technical and design restrictions, or other circumstances.

As the actual elements of the requirements specification are related to each other and to the elements of the next phases of construction of the system, it is important to explicitly establish these relations and to maintain them updated during the life of the project, to be able to evaluate the impact of the changes it may be necessary to perform and which are the elements affected in each case.

IRQA® provides different alternatives for establishing relationships between elements, and for later review and modification. Among them, the most simple and intuitive is the traceability matrix.

To provide the impact analysis of the changes between the main elements of the requirements specification, IRQA® provides a feature called management of suspect links.

A relationship becomes suspect if any of the elements participating in it is modified.

There is also the possibility to establish suspect links manually, if the user wishes. This allows the user to evaluate the impact of the change on an element of the specification before performing it.

Traceability matrix

The traceability matrix shows the relations between elements in matrix form, showing one type of elements in the rows and another in the columns of the matrix, with a mark on the boxes that represent the relation between an element in the row and the one in the column. It is possible to establish filters on the elements of the matrix. The following table shows the traceability matrixes we may obtain in green.
<table>
<thead>
<tr>
<th>Domains</th>
<th>Events</th>
<th>Implementation Classes</th>
<th>Implementation Classes Elements</th>
<th>Processes</th>
<th>Requirements</th>
<th>Scenarios</th>
<th>Services</th>
<th>Test Scenarios</th>
</tr>
</thead>
</table>

**Concept Elements:** Attributes, operations or relationships.

**Implementation Classes Elements:** Attributes or operations.

**Diagrams:** Use case diagrams, concept diagrams, context diagrams or block diagrams.

The traceability matrix view may be accessed from the button on the Tools bar, or using the option Traceability Matrix on the menu Tools.

The traceability matrix is editable, that is, it is also possible to establish or eliminate relations by clicking on the relevant box.

Inside the matrix view, one must select the two types of elements between which one wishes to view the relations; these elements must be selected from the fold-down menus of Rows and Columns. These two menus are inter-related: the list of available elements to select on the Columns menu depends on the element selected in that of Rows.
If Requirements and Requirements are chosen, then one must select the motive of the relation between those shown on the fold-down menu: hierarchy, services, concepts, or any free motive defined by the user. The relations between requirements and services or concepts are indirect; their meaning is that the requirements are related to each other because they are related to the same services or concepts, respectively.

If Services and Services are chosen, one may also select the type of relation, that may be Extended or Use (Include).

If Test Scenarios and Test Scenarios are chosen, as in the case of requirements, one may also select the motive of the relation, which may be hierarchy or any free motive defined by the user.

It is possible to view the matrix in different presentation modes:

- **“Info” Menus:** Allow the user to select whether we wish to show the name or code of the element as the title of rows and columns. That is valid for requirements, services, scenarios and test scenarios, which are the elements of IRQA® that are identified with a code. In the rest of the cases, the title of rows and columns always bears the name of the element.

- **“Tooltip” Menus:** Allow the user to choose whether to show the name, the code or the description when the pointer is placed on the elements of rows and columns. It is also possible to hide the Tooltip by selecting the option “Nothing”. As in the previous case, the possibility of selecting the codes is only available for elements that are identified with a code in IRQA®.

- **“See” Menus:** Allow the user to choose whether to show all the elements of the type chosen, only those that have relations to show on the matrix, or only those that do not have these.

It is also possible to select a filter for the elements of rows and/or columns. To do so, the user must click on the button and select or define the desired filter.

After performing changes in any of these options, including the menus of Rows and Columns, the user must click on the button to view the new matrix.

By default the traceability matrix will be shown with the column headings in horizontal mode. Clicking the right button of the mouse in any of the cells in this heading, the option Vertical mode will appear. This way, it is possible to commute between both modes to visualize the column headings.
If the table is too large to display all of it on the screen, scrollbars will appear to allow you to move the table on the screen, keeping the header in the same place.

Rows and columns can be resized using the mouse. To do this, position the mouse on the edge of the row or column and move it to the desired position. The F5 key allows all of the rows and columns to be resized to the default size.

If the following possibilities are selected in the rows and columns:

- Requirements-Requirements by hierarchy or for a free motive,
- Services-Services,
- Test Scenarios-Test Scenarios,

in the boxes of the traceability matrix, arrows are shown (üş) instead of the symbol (✓), showing the direction of the relation in each case. In relations of hierarchy, the arrow goes from the parent element to the child.

The boxes marked in grey may not be edited. That may be due to some of the elements being checked-in, to the user not having write rights on it, or to the type of relation shown not being possible to establish between the relevant elements of the box. For example, if two services have a use type relationship, it cannot have an extend type relationship at the same time.

There might also be non-editable links due to the fact that the project administrator has decided that it will only be possible to establish the links that appear in the block diagrams that define the specification structure. This restriction only applies to the elements that can belong to blocks (requirements, services, actors, concepts, test scenarios and scenarios).

If there is any link with an element that does not comply with the restrictions of block diagrams, this link will appear as active in the traceability matrix. This could happen if the link was created before the project administrator activated the option of restricting links according to block diagrams. If this link is eliminated, it will not be possible to create it again, given that, from this moment, the box will be marked in grey.

The relationships of hierarchy between requirements and between test scenarios cannot be modified in the traceability matrix.

If one wishes to add, eliminate, or change the direction of any relation, one must click on the desired box: if there is no relation, it appears, and if it there was already one, it disappears. In the case of relations shown with arrows, clicking once changes the direction of the arrow and the second click makes the relation disappear. Once the desired modifications are made, the user must click on the button to save the changes in the database.

If the user tries to leave the traceability matrix view or clicks the button with unsaved changes, a message is shown to the user warning that the changes can be lost and asking for confirmation before going ahead.

If you have Microsoft Excel installed, it is possible to export the matrix to an Excel spreadsheet by clicking the button.

### Traceability matrix configuration management

IRQA® allows the user to save configurations of the traceability matrix so that it is possible to recover them later.

To do so, the user must click on the button, that will open the following dialog box:
The options in this dialog box are as follows:

- **Current configuration**: Allows the present configuration to be saved by inputting the name and, optionally, a description. The configuration consists of all the elements defined in the traceability matrix menus:
  - Elements in rows and columns.
  - Motive of the relation.
  - Info in rows and columns.
  - Tooltip in rows and columns.
  - Relations filter in rows and columns.
  - Elements filter in rows and columns.

- **Rename**: Allows the name and description of the configuration to be changed.

- **Duplicate**: Allows creation of a new configuration that is a copy of the configuration selected.

- **Delete**: Allows the configurations selected to be deleted.

To choose a saved configuration to visualize the relevant traceability matrix, one must select the configuration and click on the button “OK”.

### Browsing from the traceability matrix

IRQA® provides a browser function from the traceability matrix that allows the user to browse to any element which appears, in the rows or columns of the matrix. That feature is activated from the contextual menu which appears, by right clicking on the cells of the matrix.

In the traceability matrices, the contextual menu of the cells shows the following options:

- **Go to the element of the row**.
  
  Takes the user to the relevant view of the element type located in the row with the element selected.

- **Go to the element of the column**.
  
  Takes the user to the relevant view of the type of element located in the column with the element selected.

In matrixes between elements for which there are suspect links, the contextual menu also provides other suitable options for that type of relations, which are explained in the section Management of suspect links.
Management of suspect links

Management of suspect links is not available when a project is created. It must be activated manually by the administrator when he considers it necessary, through IRQA Administration Center.

The types of relations that may be marked as suspect are:

- Direct relations between requirements by hierarchy.
- Direct relations between requirements for free motives.
- Relations between requirements and associated files.
- Relations between requirements and services.
- Relations between requirements and test scenarios.
- Relations between services and test scenarios.
- Relations between services and associated files.

As of the moment when the project administrator activates management of suspect links, the relations stated will automatically be marked as suspect when the following operations are performed:

- Create a new version of a requirement, service or test scenario.
- Modify the description of a requirement, service or test scenario.
- Add/eliminate a file associated to a requirement or a service.

Moreover, the user may establish suspicions on those relations manually.

Suspect links on tabs

Management of suspect links may be performed on the tabs in which Related Elements information is displayed.

In cases in which the relations may be marked as suspect, the Related Elements tab provides options to perform that management:
There is an additional column on the list of Related Elements that indicates whether the relation is suspect or not.

When the option `Edit Link` is selected on the contextual menu associated with the element related, the following dialog box is shown:
In this dialog box one may see and modify a text explaining the reason why the relation is considered suspect. When the suspect has been established automatically, the text indicates the reason that has triggered establishment of the suspect.

If the relation is not suspect, this dialog box presents the option to mark it as such. To do so, click on the button **Select Suspect** and then the button **OK**.

If the relation is marked as suspect, this dialog box provides the option to eliminate the suspect. To do so, click on the button **Clear Suspect** and then the button **OK**.

Suspects may also be established or eliminated manually by clicking on the box that appears in the column “Suspect”. When a relation is marked as suspect, the dialog box shown above is automatically displayed, to input the reason for the suspect.

Under the Related Elements table there is the fold-down menu “Show Type”, in which the options may be chosen to see all the relationships, only those that are suspect, or only those that are not.

**Suspect elimination**

Suspects in relationships of one or several elements may be eliminated in a block.

To do so, one must select the elements on the grid panel for which the suspicions must be eliminated and select the option Edit>Delete suspects.

This option eliminates all suspects in the relations of the elements selected, whether manual or automatic and with any other type of elements.

**Suspect links filter**

Those elements that can have suspect links (requirements, services and test scenarios), can be filtered by their suspect relationships.

This option must be selected from the filter window accessed clicking on . Once in this window, when clicking on the Add button a contextual menu will appear, with a Suspect links option.

This filter provides four different filtering options:

- **All**: Shows all the elements with at least one suspect link.
- **With requirements**: Shows all the elements with at least one suspect link with a requirement.
- **With services**: Shows all the elements with at least one suspect link with a service.
- **With associated files**: Shows all the elements with at least one suspect link with an associated file.
- **With test scenarios**: Shows all the elements with at least one suspect link with a test scenario.

**Suspect links in the traceability matrix**

The suspect links are viewed in the relevant traceability matrixes, where they are all marked in red, had they been established manually or automatically.
When the pointer is placed on a cell of the matrix in which there is a relation, one may view a contextual menu with the following options available:

- Establish as suspect: Establishes the relation selected as suspect, showing it in red from that moment on.
- Eliminate suspect: Eliminates the suspect, so the relation is displayed in black again from that moment on.
- Establish row as suspect: This option establishes all the relations in the relevant row as suspect.
- Eliminate suspects from the row: This option eliminates the suspect from all the relations that appear in the relevant row.
- Establish column as suspect: This option establishes all the relations in the relevant column as suspect.
- Eliminate suspects from the column: This option eliminates the suspect of all the relations in the relevant column.
- Edit relation: The following dialog box is displayed:
The user may see or modify the reason why the relation is suspect. The suspects may also be established and eliminated.

If the cursor is placed on a cell of the matrix in which there is no relation, the contextual menu presents the same options as in the previous case, except Establish as suspect, Eliminate suspect and Edit relation.

In addition to these options, the contextual menu provides browser options that allow navigating to the element from the row or column, which are common to all the traceability matrices. In the case of relations that have direction, these options appear in the following format:

- **Go to the origin.**
  Takes the user to the relevant view of the type of element located at the origin of the relation with the element concerned selected. If there is a relationship in the cell, the original element is indicated by the origin of the arrow. If no relationship exists, the origin is considered to be the element that appears in the row.

- **Go to the destination.**
  Takes the user to the relevant view of the type of element located at the destination of the relation with the element concerned selected. If there is a relationship in the cell, the destination element is indicated by the end of the arrow. If no relationship exists, the destination is considered to be the element that appears in the column.

**Suspect links in the indirect traceability matrix**

Suspect links are also displayed in the indirect traceability matrices. Indirect relations in which at least one of the direct relations involved is suspect are marked in red.
Tests

Introduction

IRQA® provides two features for definition of acceptance and validation tests:

- Test Scenarios, defined and managed in IRQA®.
- Integration with the commercial test management tool Mercury TestDirector/Quality Center.

Use of one method or another to define tests in a project must be decided by the administrator at the time it is created and may not later be modified.

In relation to the definition of acceptance tests, IRQA® allows definition of acceptance criteria or fit-criteria for the requirements. These criteria allow the user to establish the conditions that must be fulfilled to determine whether the system fulfils a requirement or not, in a precise, unambiguous way.

Fit-Criteria

The creation of fit-criteria is performed in the Details Tab of the requirements view.

This is a free text field, that may be changed whenever the requirement is checked-out and the user has write rights on the access partition the requirement belongs to.

Test Scenarios

Test scenario view management

To open the test scenario views, the user may access the menu Engineering process>Tests>Test Scenarios, or click on the fold-down menu to the right of the button on the bar for Solution specification and Testing.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of test scenarios is as follows:
The views of test scenarios are formed by a maximum of three panels:

- **Grid panel**: There are always two columns with the code and name of the test scenarios. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management).

- **Description panel**: Shows the description of the test scenario selected on the grid panel (see section Requirements description panel).

- **Tab panel**: The following tabs appear, showing information on the test scenario selected on the grid panel:
  - Details.
  - Related Elements.
  - Related Test Scenarios.
  - Blocks and Attributes.
  - Test case.
  - Precondition and Post Condition.
  - Associated files.
  - Versions.

**Details Tab**

Shows information concerning the test scenario selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The definition of the sequence of steps is performed in the same way as in the Details Tab of the scenarios view.

**Related Elements Tab**

 Allows the test scenario selected to be associated with other elements of the specification.

At the top of the tab Related Elements, a fold-down menu is displayed where you can select the type of elements to be viewed. The available options are:

- Domains.
- External Elements.
- Requirements.
- Services.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view.

The menu Blocks are activated if the type of element selected is Requirements or Services.

If the type of element selected is Requirements or Services, the options are activated for management of suspect links (see the section Management of suspect links).

**Related Test Scenarios Tab**

The objective of this tab is to allow creation and view of relations due to free motives between test scenarios.

The definition and management of these relations is performed in the same way as in the case of relations for free motive between requirements (see section Related Requirements Tab of the requirements view).

The relations between test scenarios may be suspect, so this tab has the options for management of suspect links active (see the section Management of suspect links).
Blocks and Attributes Tab
Shows information concerning the blocks to which the test scenario belongs and the values taken for the test scenario by the attributes associated with it.
The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view.

Test case Tab
Shows management information on the test defined by the test scenario:
- Responsible: Indicates the person in charge of execution of the test.
- Location: Indicates the place where the test is performed.
- Date: Indicates the date when the test is performed.
- Physical environment: Contains the description of the physical environment needed for the test.
- Logical environment: Contains the description of the logical environment needed for the test.

Precondition and Post Condition Tab
This tab may be used to input information on the prior conditions for execution of the test scenario (precondition) and the conditions of the system after execution of the scenario (post condition). In both cases, the information is input as free text.

Associated files Tab
This tab allows external files of any kind to be associated to a test scenario.
The characteristics of this tab and the available options it presents are the same as those shown on the Associated files Tab of the requirements view.

Versions Tab
Shows information on the versions of the test scenario selected and the differences between them (see section Individual element version control).

Test scenario definition
To add, edit and delete test scenarios in the Test scenarios views, the options available are the same as described in the Inputting requirements section.
As in the case of requirements and services, the test scenarios code can be configured by selecting the option Tools > Configuration > Codes > Test Scenario codes (see the section on Automatic assignment of requirements codes). The coding of a group of test scenarios that has already been entered can also be changed (see the section on Automatic recoding of requirements), or just the code prefix or suffix (see the section on Partial recoding of requirements).
If the options for code modification appear deactivated, it means that they cannot be modified because the project administrator does not allow it.
Definition of the relations of hierarchy between test scenarios may be performed in several ways: by direct creation of the child test scenario or by selection of the parent in the tab Details. If the Tools > Configuration > Automatic hierarchy when creating element is checked, each time a new test scenario is created, it will be in the same position in the hierarchy as the test scenario that was selected when the option Add was clicked. These procedures are the same as used in definition of the hierarchy of requirements (see section Requirements hierarchy).
Importing test scenarios

IRQA® provides the possibility of including test scenarios in a project automatically, as long as these are available in electronic media in any format that can be processed by IRQA® Import Tool.

For further information on the use of this tool, see the IRQA® Import Tool User Guide.

Integration with TestDirector for Quality Center

IRQA® provides an interface for the integration with the test management tool called TestDirector for Quality Center.

The project administrator decides if tests will be defined using IRQA® test scenarios or using TestDirector for Quality Center. This decision is made during the project creation process. When the administrator configures the project for the use of TestDirector for Quality Center, he must select a TestDirector for Quality Center project with which the IRQA project will be synchronized.

For further information on how to create IRQA® projects with TestDirector for Quality Center integration, please refer to IRQA Administration Guide.

The use of this feature is described in full detail in the document “Integration IRQA® & TestDirector”.

Management Elements

Attributes

An attribute is understood as a characteristic that makes it possible to classify and characterise a project's requirements and specification elements.

These attributes can be general aspects that are oriented to requirement or other elements management, and they can also be aspects directly related with the problem that is being analysed.

IRQA attributes can be of any of the following types:

- Real numbers.
- Integer numbers.
- Date.
- Text.
- Boolean.
- Enumerated.

Enumerated attributes can be defined as multi-valued. This means that the values are not exclusive, i.e. an element can take on several different values of the attribute at the same time.

The attributes in IRQA can be used to characterise the following element types of the specification:

- Requirements.
- Services.
- Concepts.
- Actors.
- Scenarios.
- Test scenarios.
- Blocks.
- Domains.

In IRQA we will call the attribute's scope to the concrete elements that it is applied to. They can be all elements of one or several of the previous types, or one or several specific blocks of those elements. This means that the elements in IRQA can be characterised as precisely as necessary, using attributes assigned to specific element types. For example, a Priority attribute assigned to all the project's requirements can be defined, as well as a Requester attribute assigned only to user requests, a Test Status attribute assigned to test scenarios, etc.

Attribute views management

To open the views of attributes the user must access the menu Engineering process>Analysis>Attributes, or click on the fold-down menu to the right of the button on the bar for Requirements capture and Analysis.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of attributes is as follows:
The views of attributes are formed by a maximum of three panels:

- **Grid panel**: A column always appears with the name of the attributes. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management), though in this case only columns with predefined attributes and organization elements (baselines and domains) can be added. If the repository supports reuse, reuse elements (components, source element, etc.) can also be seen.

The list of attributes can be sorted out according to the following criteria:

- List.
- Access Partition.

- **Description panel**: Shows the description of the attribute selected on the grid panel (see section Requirements description panel).

- **Tab panel**: The following tabs appear, showing information of the attribute selected on the grid panel:
  - Details.
  - Scope.
  - Related Domains.
  - Values.
  - Versions.

### Details Tab

Shows information concerning the attribute selected. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The lower part of the tab shows specific characteristics of the attributes:

- **Attribute type**: This value can be modified by selecting a new type in the drop-down menu. This menu will only show the attribute types for which the user carrying out the modification has at least reading permission. Pressing the **Type views** button it will open the attribute type view with the type of attribute selected. In this view the user can define a new type or modify an existing one.
Default value. This is the value that an attribute initially takes for the elements belonging to its scope. It is not obligatory, meaning that there can be attributes that do not take any value for elements in their scope, unless the user deliberately assigns this value. To add a default value to the attribute, the user should press the *Add value* button and enter or select the desired value. If the attribute is multi-valued, more than one default value can be added. Using the *Delete* button it is possible to delete the selected default value. Any modification of the default value means that the elements in the scope of the attribute for which the value of the attribute was not manually modified by the user, will take the new default value (no value if the default value is left blank).

Multi-valued option. If this option is checked, the attribute can take several different values for the same element. This option cannot be selected if the attribute is a Boolean one, or if it is associated to a workflow. This option cannot be unchecked if the attribute has several default values. In this case, the default values should be removed until there is only one remaining, before being able to eliminate the multi-valued characteristic of the attribute.

Mandatory option. If this option is checked, the value of the attribute must be filled in manually by the user before checking in the elements belonging to the scope of the attribute for the first time. Additionally, if the scope of the attribute is a type of elements (requirements, services, etc.), the attribute will be seen in the creation dialogue box of those elements, so that the user can assign the desired value.

**Scope Tab**

This tab allows to define the elements that will be characterised by the attribute.

In the upper part of the tab, one or several element types can be selected. This selection means that all elements of the selected type can take a value for the attribute. The *Select all* and *Unselect all* options are used to select all types of elements together or cancel the selection of all of them together.

In the lower part of the tab, one or several blocks can be selected. This selection means that only the elements that belong to those blocks can take a value for the attribute.

The list of blocks available for selection only shows the blocks of elements that are not selected at the top of the tab, i.e., there is no point in selecting the Services element and a block of services at the same time, since all services will have a value for the attribute, whether they belong to the block or not.

Blocks with generalization relationships inherit attributes from the parent blocks. In this case, they appear enhanced in blue. Nevertheless, it is possible also to assign the attribute directly to the block. The consequence is that, if the generalization link is deleted or the attribute is deassigned from the parent block, the attribute will still be assigned to the child block.

It is mandatory that blocks are checked-out in order to be selected as scope of an attribute. That is, users need to have write rights on a block to be able to assign attributes to it. And the attribute does have to be checked-out by the user.

**Note:** Selecting domains as part of the scope means that the attribute will be used to characterise each of the project’s domains. This operation is different from including the attributes in domains: the latter means that the attribute that can be used to characterise requirements or other elements, belongs to the domain and so that when the domain is activated, the attribute continues to be visible.

Selecting blocks as part of the scope of an attribute, means that the attribute will be used to characterise each of the project’s blocks (i.e. it will be a property of the blocks). This operation is different to selecting a block as the scope of the attribute, which implies that the attribute will be used to characterise elements contained in the block.

**Related Domains Tab**

This tab allows to include the selected attribute in one or several domains of the project.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view. In the case of attributes there is no management of suspect links.

**Values Tab**
This tab allows to consult and modify the values that takes the attribute selected for the individual elements that belong to its scope. To modify the value that a non-multi-valued attribute takes for an element, the user should double click on the corresponding value in the list of elements.

If the user selects an element for which the attribute's value is different from the default one, the Default value button is activated. If this button is pressed, the element will take the default value or values of the attribute.

For multi-valued attributes, modifying the values is carried out as follows:

- When selecting an element, the Add value button is activated. Pressing this button a dialogue box is shown in which the user can select a value of the attribute for the selected element.

- When selecting a value from those that take an attribute for an element, the Delete button is activated. Pressing this button it is possible to eliminate this value of the list of values which takes the attribute for the element.

In the Element Type menu, the type of elements that are to be seen in the list can be selected. In the menu only the types of elements that correspond to the attribute's scope are shown.

In the Blocks menu, a block can be selected so that in the list of elements only those that belong to the selected block are shown. This menu only shows the blocks that contain elements of the type selected in the Element Type menu.

Versions Tab
This tab shows information about the selected attribute’s versions and the differences between them (see the Individual element version control section).

Definition of attributes
To add, edit and delete attributes in the Attributes view, the options available are the same as described in the Inputting requirements section.

The process of creating a new attribute is as follows:

When selecting the Add option, the dialogue box of the following figure can be seen:

![New Attribute Dialogue Box]

The following data is to be entered:

- **Name.**
- **Access partition.**
- **Type:** In this drop-down menu the user should choose one of the types that already exist in the project. If the attribute is associated to a workflow, the attribute’s type cannot be modified.
- **Default value:** By pressing the Add Value button, a dialogue box will be shown in which the user can select a value that will be the one that the attribute takes by default for all elements belonging to its scope. This dialogue will be different depending on the attribute’s type. To modify the assigned default value, the value should be selected and then the Delete button pressed. Next, the user should add the new default value that is to be assigned. It is not necessary to define a default value for an attribute; this means that the attribute will not take any value for the elements in its scope while the user does not manually assign it.
- **Multi-value option.** This option cannot be selected if the attribute is of Boolean type. If the attribute is selected as multi-valued, it is possible to add more than one default value. When the attribute has several assigned default values, it is not possible to eliminate the multi-valued option.
- **Required option.**

**Note:** As of IRQA version 3.5, text-type attributes can have up to 4,000 characters, but only if the database has been created with this version or a later one. If the database was created with version 3.4 or any other previous version, the maximum length of the text attributes is 253 characters; the tool will show the message indicating if the user is trying to add more characters than allowed. To be able to manage attributes of more than 253 characters in databases created in versions prior to 3.5, they must be migrated to a version.
Attribute types

The type of an attribute defines the possible values that the attribute can take. The base types that can be used in IRQA® are: Integer numbers, Real numbers, Date, Text, Boolean and Enumerated. In an IRQA project, there are five default attribute types that correspond to the integer, real, date, text and Boolean base types.

To open the views of attribute types, the Engineering Process>Analysis>Attribute Types menu should be accessed, or alternatively the drop-down menu to the right of the button on the Requirements Capture and Analysis bar should be clicked.

This menu presents the same options as for other IRQA® elements (see the Requirements view section).

The default view of attribute types is as follows:

The views of attribute types are made of up to three panels:

- Grid panel: A column always appears with the name of attribute types. The options available for managing this panel are analogous to other IRQA® elements (see the Requirement grid panel and Requirements view management sections), although in this case only columns with pre-defined attributes and organization elements (baselines) can be added.

  The list of attribute types can be organised in the following ways:
  - List
  - By access partition

- Description panel: This shows the description of the attribute type that is selected in the grid panel (see the Requirements description panel section).

- Tabs panel: The following tabs can then be seen. In these the information of the attribute type selected in the grid panel, is shown:
  - Details
  - Attributes
  - Versions

Details tab

Shows information concerning the type selected. The meaning of the fields and options available in this tab are the
same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The specific information on attribute types is the following:

- **Base Type.** This data cannot be modified once the attribute type has been created.

- **Range.** In the attribute types that have date, integer or real as the base type, it is possible to specify an allowed value range. For this, the *Set Range* option should be checked and then the initial and final values should be entered. The numerical values should be written directly into the *From, Until* fields. The date type values should be selected in the dialogues that appear when pressing the buttons on the right of *From, Until* fields. If the *Set Range* option is not selected, the values of that type’s attributes have no restrictions, other than corresponding to the base type.

- **Values list.** In this field, the possible values for the attribute types that have enumerated type base are shown.

**Attributes tab**

This tab shows information about the attributes of the project with the selected type. The name of each of the attributes is shown, as well as the access partition it belongs to, whether it is multi-valued or not and whether it is required or not.

**Versions tab**

This shows information about the versions of the selected attribute type and the differences between them (see the Individual element version control section).

**Defining attribute types**

To add, edit and delete attribute types in the Attribute types views, the options available are the same as described in the Inputting requirements section.

The creation process of a new attribute type is as follows:

After selecting the *Add* option, the dialogue box of the following figure will be seen:
The following data is to be entered:

- Name.
- Access partition.
- Base type. The available base types are: Enumerated, Integer, Real, Date, Text and Boolean. This data cannot be changed once the attribute type has been defined.
- Range. This is available for the integer, real or date base types. To enter a range, proceed as described in the Details tab.
- Values list. For the enumerated types, the desired values should be added, and at least one must be entered. To achieve this, the desired value should be written in the Value field and next the Add Value button should be pressed. To eliminate a value that has already been included in the values list, the user should select the value in question and then press Delete. The value can be deleted only if there is no element which active version takes this value for some attribute. A colour can be assigned to each value of the enumerated attribute, by selecting the value and pressing the Color button. In the elements list that can be seen in the grid panel, each value of the attribute with the assigned colour in the definition of the type will be shown. This makes it easier to distinguish elements of the specification that have specific values of the attributes.

To access quick editing of enumerated types, the user should press Edit Values. A dialogue box can then be seen, in which the user can write different values of the enumerated type, by writing each one in a different line.

From this window the user can:

- Modify values
- Eliminate values
• Create new values
• Simultaneously paste (Ctrl + V) a set of values (e.g. a list of countries) from an external source (txt file, Excel file, etc.)

The user should press the OK button to save changes in the values of the enumerated attribute type.

After entering all information of the attribute type into the New Type dialogue box, the user should press OK.

An attribute type of the project cannot be deleted if there is any attribute associated to this type.

**Edit common attributes**

It is possible to assign the same value of an attribute to a group of elements belonging to a block.

To do so, the user must select the group of elements on the grid panel and then click the button on the Blocks bar, or select the option Edit > Edit Common Attributes.

Then the following dialog box appears:
At the top, the user must select the list of elements to modify the values of attributes. If the option “See all” is checked, this list will show all selected elements. If the option is not checked, the list will show only those elements which attributes can be modified.

On the bottom, there is then a list of common attributes of the elements selected. In the Value column, the user must establish the value of the attributes to be assigned to the elements selected and then click on the button OK. If no value at all is selected for any of the attributes which appear on the list, the elements will keep their previous values for those attributes.

By marking the Default value box, the default value of the attribute appears in the Value column.

Filters

IRQA® has a powerful built-in filtering module that allows filters of different types to be composed for lists of elements.

To access the filter dialog, click on the button on the Elements bar, or select the option Filter Elements of the menu Edit. This dialog box may also be accessed through the option Filter elements which appears on the contextual menu that folds down on clicking on the right button of the mouse on the grid panel of any element. This dialog is used to view the filters of the relevant element of the view we are in by accessing the filter dialog. The filters created by a user are stored so the user may activate them when considered necessary.
There are two types of filters: simple and compound.

To create a simple filter, click on the button ![Add](image) to show a fold-down menu with all the possible types of simple filters that may be created for the element of the view where we are. Filters may be created by author, ranges of dates, access partition to which the element belongs, elements with which it may be related, by word search of code, name and description of the element (text filter), etc.

Depending on the type of element being filtered, the search criteria vary. In the case of requirements, the available filtering criteria are:

<table>
<thead>
<tr>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
</tr>
<tr>
<td>Dates</td>
</tr>
<tr>
<td>Access partition</td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>User attributes</td>
</tr>
<tr>
<td>Concept</td>
</tr>
<tr>
<td>Concept / Attribute</td>
</tr>
<tr>
<td>Concept / Operation</td>
</tr>
<tr>
<td>Relationships between concepts</td>
</tr>
<tr>
<td>Service</td>
</tr>
<tr>
<td>Test Scenario</td>
</tr>
<tr>
<td>Actor</td>
</tr>
<tr>
<td>Parent requirement</td>
</tr>
<tr>
<td>Domain</td>
</tr>
<tr>
<td>Blocks</td>
</tr>
<tr>
<td>Checked in</td>
</tr>
<tr>
<td>Checked out by:</td>
</tr>
<tr>
<td>Elements in Baseline</td>
</tr>
<tr>
<td>Elements with active version in Baseline</td>
</tr>
<tr>
<td>Suspect links</td>
</tr>
<tr>
<td>Suspect links by motive</td>
</tr>
<tr>
<td>Reused Elements</td>
</tr>
</tbody>
</table>

For example, to create a filter to search all the requirements where the author is the administrator, click on the
button \textit{Add} and select the option Author. A new element appears on the list of filters, where the criteria is Author and the column Value of the fold-down menu is displayed to select one of the project users.

The filter being created may optionally be assigned a name by placing the pointer on the column Name. Once the chosen author is selected, the filter may be applied in two ways:

- By eliminating the elements that do not fulfill the filter criteria from the list. To do so, you must select the filter and click on the button \textit{Filter On}.
- By red marking the elements that fulfill the filter criteria. To do so, you must select the filter and click on the \textit{Color ON}.

When the filter is applied with the button \textit{Filter On}, the Elements bar shows information on the filter that has been applied: the name, if it has one, or, on the contrary, the actual filter criteria. In any case, the tooltip for this field always shows the complete filter criteria.

Once a filter has been applied with the button \textit{Filter On}, a color filter with a different criteria may be applied to the filtered list. When another filter is selected from the list and the button \textit{Filter On} clicked, the new filter criteria replaces the previous one. Likewise, no more than one color filter may be applied at a time.

If you need to apply more than one selection criteria, you must resort to compound filters; these may be obtained from simple filters or other compound filters, related to each other by the operators AND, OR and NOT.

For example, to create a filter that selects the requirements whose author is not the administrator, first the simple filter will be created “Author = Admin”, select and click on the button \textit{NOT}.

To create compound filters with the criteria AND, OR, two filters for composition must be selected using the keys Shift and Ctrl, according to whether the two filters are next to each other on the list or not. Once the two filters are chosen, the options AND and OR in the filter dialog box are activated. The appropriate one is chosen and the new compound filter added to the list of available filters.

Compound filters may be created by selecting any two filters from those created, whether simple or compound. Thus, one may create filters as complex as required.

The button \textit{Delete} is used to delete the filters selected. Multiple filter selection is allowed, so one or several of the filters created may be deleted. When they are deleted, the filters disappear from the list of the user's filters.

When any filter is applied or deactivated, the tool closes the filter dialog. To deactivate a filter, the relevant options available in the filter dialog must be used.

The button \textit{Filter Off} is used to deactivate the filter applied at that moment by using the button \textit{Filter On}.

The \textit{Color OFF} deactivates the color filter applied at that moment.

The filter applied with the button \textit{Filter On} to the view of an element is maintained on the tabs of other views that show the list of the element concerned. For example, if a filter is applied to the view of requirements, the tab Requirements Resolved of the services view, only shows the requirements that fulfill the filter criteria.

It is possible to modify any of the characteristics (name, criteria, operator or value) of a filter previously created. \textbf{Note: If the filter is being used in a view configuration, in a traceability matrix configuration, or in a compound filter, the user can not modify or delete the filter.}

The filters dialog described also appears when a filter is selected in configuration on the grid panel and on the traceability matrix, although in these, the color filter option is not available.
Users belonging to the Administrators group may share their filters, so as they are also available for other users. The steps to follow are:

- Select the filter to be made available for other users.
- Click on the Share button.
- Select the group or user groups with which the filter will be shared.

**Note:** This option will only work correctly for users that are NOT connected to the project while the administrator user is performing these steps.

**Warning:** Sharing filters is not possible in IRQA 4 version 1.

### Individual element version control

IRQA® manages versions and historic record of all elements and diagrams.

The operating mode for elements will be explained in requirements version management, being exactly the same in the other elements.

#### Elements Check-in / Check-out

When a new requirement is created, it is in checked-out mode and belongs to the user who created it. That means only that user may perform modifications to predefined and user attributes of the element, and to assign the element to a block or domain. However, it is possible for other users to establish relations between the requirement concerned and other elements of the specification, as long as they have the necessary rights in the access partitions.

The access rights depend on the configuration set by the project administrator:

- Writing rights, at least, on the access partition one of the two elements to be linked belongs to.
- Writing rights on the access partitions both elements to be linked belong to.

Once the desired data for the requirement is input, it may be placed in checked-in mode. When an element is in that mode, neither its predefined nor user attributes values nor assignment to blocks or domains may be changed. Again, it is possible to create or delete links with other elements as long as the user has the required access rights. The element appears shadowed in grey on the grid panel.

To check-in requirements, select the element in the grid panel and click on the button on the Versions bar, or the option Check-in on the menu Edit to display the following dialog box:
The elements to be checked-in must be selected from the list that appears, and then the button Check-in must be clicked on. Then a dialog box appears to optionally input a comment. That comment will be linked to the version of the requirement that is being checked-in; thus, it may be used to record information on the evolution of the history of requirements.

If the user tries to check in a requirement with required attributes which values have not been assigned manually by the user, an error message will appear and the requirement will not be checked-in. If the required attribute has a default value, the user will be able to keep this value but he will have to assign it manually, same as any other value of the attribute.

To be able to modify the attributes values on a requirement, or its assignment to blocks or domains, it must be in checked-out mode. To do so, the user must select the requirements to be checked-out on the requirements grid panel and click on the button on the tool bar, or the option Check-out on the menu Edit.

Then a dialog box appears to confirm the check-out. The user must choose the requirements to check-out, and click on the button Check out.
**Note:** No action will have an effect on elements that have already been checked-out.

Whenever a requirement is checked-out, a new version of it will be created.

Once the requirement is checked-out, the appropriate modifications will be performed.

To undo the modifications performed, the user must click on the button ![check-out](image) on the Version tool bar, the option Undo check-out on the menu Edit. The requirement returns to its situation prior to the last check-out, and is placed in checked-in state again.

When this option is selected, the user is asked whether he wishes to eliminate the suspicions associated with the requirement. In that case, the suspicions will be eliminated in all the relations of that requirement, whether or not they were caused by the last version creation.

If the user decides not to eliminate the suspicions, all the suspect links of the requirement will be maintained, regardless of the cause due to which they are marked as such.

**Note:** If the check-out operation is applied to an attribute, when undoing check-out, the elements in the attribute’s scope get again the values of the attribute they had before the checking out. Now, the attribute will be assigned the current version of the type of attribute it had before being checked-out, even if the type has been modified. For instance, if the following operations are performed:

- An enumerated attribute is checked-out and a new attribute type is assigned to it,
- The attribute type it had before is checked-out and it is modified by deleting one of the possible values,
- The undo check-out operation is performed for the enumerated attribute,

the attribute gets again the type it had before being checked-out but in its current version. So, the deleted value is not available anymore for the attribute, and the elements that took this value before, now will take the default value.

**Versions history**

The different versions of a requirement recorded may be seen from the tab Versions of the requirements view. This tab provides a list of the versions of the requirement selected in the panel on the left.

This feature is also available in the option Requirements of the menu Tools>Configuration management.
The list of versions is marked with the symbol * in the version of the requirement that is active at that moment. The field Description of the change shows the text on the comment input when Checking-in the version selected.

By selecting a version, the user may see its code, name, access partition and description at the bottom of the window.

The list of project baselines to which the selected version belongs is also displayed.

This view contains the following options:

- **Delete**: Deletes the version of the requirement selected. It is not possible to delete the active version. It is not possible either to delete a version that is included in any baseline previous to the current one. The Delete option will be available only if the element is checked-in.

- **Diff**: Allows comparison of two versions, showing the differences between them.

In order to activate this button, the two versions to compare the differences must be activated. Comparison between two versions of a requirement may be seen in the following figure, where the fields in which there are differences between the two versions are marked in red:
This window can be resized on each of its four sides to allow a better visualization.

The fields that form part of the version of a requirement and that thus are compared in this dialog box are as follows:

- Code.
- Name.
- Description.
- Author of the version.
- Date and time of creation of the version.
- Values of attributes.

Names of attributes with different values for both versions will appear enhanced in red.

If there are differences in the description, the details can be shown clicking on the button between both descriptions. The following window appears, where a field is shown with the element description, enhancing the differences between both versions.
If there is more than one difference between both versions (it could happen if the text is long and there are several paragraphs), they can be enhanced one by one using the buttons.

Clicking on the View descriptions button another window is shown, in which both descriptions appear separately. From this window it is possible to show the previous one clicking on the View differences button.

If there are differences in a text attribute, when this attribute is selected in any of the two versions, the View differences button between both attribute windows becomes active. Clicking on this button, the differences in the attribute value for both versions are shown, same as for the description field.

**Diagrams Check-in / Check-out**

Same as for elements, when a new diagram of any type (use case diagram, block diagram, use case diagram, etc.) is created, it is in checked-out mode and belongs to the user who created it. That means only that user may perform modifications to the diagram. Other users with the required access rights could open it but they are not allowed to modify it in any way.

When the diagram is in checked-in status, any user with write access rights on it may check it out and then modify its predefined attributes (name, description, access partition), and the diagram itself.

In order to check-in or check-out a diagram, the user must open the diagrams management dialog box:
This dialog box shows a list of the diagrams in the project, in this case, the sequence diagrams. The check-in, check-out options have the same operation modes in all types of diagrams in the tool.

In this dialog the following options appear:

- **Check In**: Allows to check-in the selected diagram.
- **Check out**: Allows to check-out the selected diagram.
- **Undo Check Out**: Allows to check-in the selected diagram going back to the previous version.

**Report generation**

IRQA® allows generation of reports in different formats that can include all the elements input in IRQA® projects. For more information on this feature, see the document IRQA Report Manager. User Guide.

The Reports menu in IRQA® toolbar have the following options:

- Predefined Reports.
- Corporate Reports.
- Advanced Reports.

**Predefined reports**

Predefined reports are pre-established in the tool. They are provided with the IRQA® standard installation. It is a set of common-used reports, such as requirements hierarchy, list of tests, etc. They are grouped in sub-menus according to the main element appearing in the report.

The user selects a report and it will be automatically generated by IRQA®.

Then, IRQA Report Manager® opens showing a preview of the report. From this window the report can be exported to the format the user decides among the set available in the reports tool.

**Corporate reports**

Corporate reports are a set of reports created in the organization and stored in a folder that must be available to the IRQA® user. They can be grouped in sub-folders according to any criteria decided in the organization.

Same as with predefined reports, the user selects a report and it will be automatically generated by IRQA®.
There are two options for report generation:

- If the corporate report is a report template in IRQA Report Manager® (*mrt* file), the reports tool opens showing a preview of the report. From this window, it can be exported to the format the user decides among the set available in the reports tool.

- If it is an *rpt* file, the report is generated by IRQA Report Manager® with the format and options included in the configuration of the *rpt* file. This way, a MS Word file, an html page, etc. can be directly generated.

**Advanced reports**

This option starts IRQA Report Manager®, where predefined or corporate reports can also be generated or modified, new reports can be created, etc.
Advanced organization of the specification

Access partitions

Access partitions are partitions of the specification on which user access permissions are based. Each element of an IRQA® project (requirements, services, attributes, diagrams, etc.) belongs to a single access partition.

The user can consult the existing access partitions in the project and assign elements to them from the text view. Only project administrators can define or modify the definition of access partitions.

Access partition views management

To open the access partition views, select Project > Project organization > Access partitions.

This menu presents the same options as for the rest of the IRQA® elements (see the section on Requirements view).

The default view of access partitions looks like this:

![Access partition view]

The access partitions views are made up of a maximum of three panels:

- Grid panel: A column always appears with the partition names. The available options for managing this panel are the same as those for the rest of the elements of IRQA® (see the sections on the Requirement grid panel and Requirements view management), although in this case only columns with predetermined attributes can be added, since the partitions in IRQA® cannot be classified or categorized by attributes.

- Description panel: Shows the description of the selected partition in the tab panel (see the...
section on the Requirements description panel).

- Tab panel: The following tabs appear, displaying the information for the selected access partition in the tab panel:
  - Details.
  - Elements Included.

Details Tab

Shows the following information on the selected access partition:

- User who created the access partition.
- Creation date and time.
- Types of elements that the access partition can contain.

The user may click on the button next to the Author field to display information on the project user who created the partition.

The table below shows the details regarding the types of elements that can be assigned to the access partition, depending on the type that is checked in the information shown in the tab:

<table>
<thead>
<tr>
<th>Checked element</th>
<th>Can be included in the partition:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements</td>
<td>Requirements, Motives, Concepts, Concept Diagrams, Entities,</td>
</tr>
<tr>
<td>Concept Model</td>
<td>Entity-Relationship Diagrams, Implementation Classes</td>
</tr>
</tbody>
</table>
None of the information in the Details tab can be modified once the partition has been created.

**Included Elements Tab**

Allows the desired specification elements to be included in the selected access partition.
At the top of the Included Elements tab, there is a drop-down menu where the user can select the type of elements to display.

Once the type of element has been selected, the list of elements of that type that are available in the project is displayed: the top box shows those that do not belong to the access partition and the ones that do belong are shown in the lower box. The elements in the top box include the partition to which they belong. In this box it is possible to sort the list of elements by code, name or access partition by clicking once on the criterion at the header of the list.

In the lower box are shown the elements that belong to the access partition. For the elements that can be restored or destroyed after deletion (requirements, actors, services and any type of diagrams), deleted elements that belong to the access partition can be shown checking the Show deleted box.

If selected element type is requirements, concepts, services, actors, scenarios, or test scenarios, the Blocks menu is activated and the user can filter the displayed elements.

The user must click the button ![Icon](image) to assign elements to the partition that is selected in the tab panel. Since each element belongs to just one partition, the effect of this action is to exclude the element from the partition to which it belonged and include it in the selected partition.

The button ![Icon](image) is always deactivated; an element cannot be removed from the access partition to which it belongs without assigning it to a new partition, because an element must always belong to a partition.

It is only possible to modify the access partition to which an element belongs if the user has write permission for both the partition to which the element currently belongs and the new partition to which it will be assigned.
Elements can only be assigned to a new access partition if they have been checked-out by the user who is carrying out the reassignment.

In any case, the tab will only show the partitions and the elements on which the user has at least read access. Besides, the button will only be active when the user has permission to reassign the selected element to the access partition marked in the tab panel.

If an element is selected from either of the two lists, the description will be displayed in the lower part of the tab.

If the user double-clicks on an element in either list, IRQA® will open the corresponding view, with the element in question selected.

Management of access partitions

To add, edit and delete access partitions in the Access partitions views, the options available are the same as described in the Inputting requirements section.

Access partitions only have predefined attributes: name and type of elements that can be included in the partition.

Access partitions can be deleted only if they do not contain any elements. In some cases, elements that belonged to the partition have been deleted but not destroyed, so they could be restored to the project. In this case the partition cannot be deleted until these elements have been destroyed or restored and assigned to another access partition. It is possible to know which are these elements checking the Show deleted option in the Included Elements tab.

It is not possible either to delete access partitions if they contain any element belonging to a previous baseline.

Only users belonging to the project’s Administrator group can define new access partitions, modify the name and description of existing partitions, or delete existing partitions.

These operations can also be carried out from the IRQA® Administration Center.

Domains

A domain is a set of any elements of the specification that have any characteristic of the business in common.

The fundamental objective of domains is to allow organization of the specification into subsystems, each one of which may contain elements of different types: requirements, services, business concepts, diagrams, etc. Domains are not exclusive, that is, a same element may belong simultaneously to several domains or subsystems.

On the other hand, organization in domains facilitates browsing through the specification: when a domain is selected, only the different views are displayed on the tool of the elements that belong to it.

The user may define and consult domains from a graphic view or from text views.

Domain views management

To open the domain views, access the menu Project>Project Organization>Domains, or click on the fold-down menu to the right of the button on the Domains bar.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of domains is as follows:
The views of domains are formed by a maximum of three panels:

- **Grid panel:** A column always appears with the name of the domains. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management).

- **Description panel:** Shows the description of the domain selected on the grid panel (see section Requirements description panel).

- **Tab panel:** The following tabs appear, showing information on the domain selected on the grid panel:
  
  - Details.
  - Included Elements.
  - Blocks and Attributes.
  - Versions.

**Details Tab**

Shows information concerning the domain selected. The meaning of these fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).
Included Elements Tab

Allows to include elements of the specification in the domain.

The domains may contain the following types of elements:

- Requirements.
- Concepts/entities.
- Concept diagrams/Entity-Relationship diagrams.
- Services.
- Actors/external entities.
- Use case diagrams.
- Context diagrams.
- Sequence diagrams.
- Scenarios.
- Test Scenarios.
- Block diagrams.
- Attributes.
- External elements.

When a diagram is included in a domain, the user may choose whether he also wants to include the elements belonging to the diagram in the domain.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of
the requirements view. When elements are included in domains, there are no suspect links.

Blocks and Attributes Tab
Shows information concerning the attributes which scope includes domains. This list is different from inclusion of attributes in domains established in the Included Elements tab; the meaning of that relation is that the classification criteria represented by the attribute belongs to the domain concerned. However, the tab Blocks and Attributes qualifies a domain using an attribute, in the same way as done with the rest of the elements of the specification.

The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view, but the upper part of the tab will not be active because domains can not belong to blocks.

Versions Tab
Shows information on the versions of the service selected and the differences between them (see section Individual element version control).

Definition of Domains
To add, edit and delete domains in the Domains views, the options available are the same as described in the Inputting requirements section.

The only predefined attributes for domains are name and access partition.

Active domain selection
There is the possibility of selecting a domain as an active one. That selection is performed on the fold-down menu which appears on the Domains bar. By default, there is no active domain, thus, the complete specification is shown.

Activation of a domain has the following consequence:

- Each one of the views of IRQA® only shows the elements belonging to that domain.
- When new elements are introduced in any view in IRQA®, those elements are automatically assigned to the active domain.

Domain diagrams

The user may access the domain diagrams management dialog box using the button on the tool bar, or the option Domain diagrams on the menu Project>Project Organization.

Then a dialog box appears showing the list of domain diagrams available in the project and that belong to an access partition in which the user has, at least, read rights.

The options available are the same as described for concept diagrams (see the Concepts diagrams (Object Oriented) section).

When a domain diagram is open, the specific options available in the tool bar are the following:

- Create and include a new domain in the diagram.
- Include a domain that already exists in the project in the diagram.
- Create and include a new relation between domains in the diagram.
- Include an existing relation between domains in the diagram.
Select an active domain.

The relations between domains may only be managed on the domain diagram editor.

To see the detail of the tool bars common to all graph editors, see the sections Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams.

The domain diagram editor displays the following screen:

![Diagram with two domains connected by a relation]

When selecting a domain, two special options will appear on the contextual menu:

- Select as an active domain: The domain concerned appears on the fold-down menu on the Domains bar showing the active domain.
- Properties: The domain view opens with the domain concerned selected.

If the element selected is a relation between domains, the option Properties appears, that shows the relation definition dialog box, where the properties of the relation selected may be changed.

**Blocks**

A block is a set of elements of the same type (requirements, concepts, test scenarios…), that have a common characteristic.

The blocks may contain elements of the following types:

- Requirements.
- Concepts/entities.
- Services.
- Actors/external entities.
- Scenarios.
- Test Scenarios.

The fundamental objective of the blocks is to intuitively define the structure of the specification of requirements and allow the definition of inherent attributes of a specific type of elements.

Blocks are not exclusive, that is, a same element may belong simultaneously to several blocks.

Organization in blocks facilitates browsing through the specification: when a block is activated, a view of the element concerned is opened and it only shows the elements belonging to the block. Moreover, if a new element is introduced, IRQA® automatically assigns it to the active block.

The user may define and consult blocks from a graphic view or from text views.

**Block views management**

To open the block views, access the menu Project>Project Organization>Blocks, or click on the fold-down menu to the right of the button on the Blocks bar.

This menu has the same options as the rest of the elements of IRQA® (see section Requirements view).

The default view of blocks is as follows:

The views of blocks are formed by a maximum of three panels:

- Grid panel: A column always appears with the name of the blocks. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management), although in this case the user may only add columns with predefined attributes, organization elements (baselines), block properties and block diagrams. If the repository supports reuse, reuse elements can also be seen (components, source element, etc.).

- Description panel: Shows the description of the block selected on the grid panel (see section Requirements description panel).

- Tab panel: The following tabs appear, showing information on the block selected on the grid panel:
  - Details.
  - Element attributes.
• Block properties.
• Included Elements.
• Relationships.
• Versions.

Details Tab
Shows information concerning the block selected.

The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The type of element the block contains is selected when creating a new block and may not be modified later.

The option Include all elements means that the block will contain all elements belonging to the relevant type. If this option is not checked, elements will have to be manually assigned by the user in order to belong to the block.

Element attributes Tab
Attributes can be associated with blocks, so each one of the elements belonging to the block acquires these characteristics, and their value may be customized for each individual element.

In this tab two lists of attributes can be seen; the list on the top contains the attributes defined in the project that are not directly associated to the block selected, and the list at the bottom contains those which are.

By selecting the attributes and clicking the buttons and , the user may associate attributes or eliminate their association. These options are only active if the user has checked-out the block.

If the scope of an attribute that is not associated to the selected block, is the type of elements that the block
contains, then it is not possible to associate directly the attribute with the block. In this case, when selecting the attribute, the button does not become active.

On the bottom of the tab, there is the option Show inherited attributes, that is marked by default. These are the attributes that are associated with the elements of the block, not directly, but because they belong to the parent blocks of the one selected. These attributes are shown in color and are only shown for the purposes of information and may not be selected to eliminate their association from the elements of the block.

Nevertheless, it is possible to assign the attribute also directly to the block. The consequence is that, if the generalization link is deleted or the attribute is deassigned from the parent block, the attribute will still be assigned to the child block.

The operations that may be performed from this tab are as follows:

- **New Type**: Allows creation of a new attribute associated with the block selected. When clicking the button, the dialog for attribute creation is shown (see the Attributes section). The newly created attribute is automatically associated to the selected block.

- **New Attribute**: Allows creation of a new attribute type. These new types can be used when creating attributes associated to the block. When clicking the button, the dialog for creation of attribute types is shown (see the Attribute types section).

The attribute type and its default value are shown in the relevant columns. To modify these values, the attributes or types view should be accessed. By double clicking on the name of an attribute, the attributes view is opened with the relevant attribute selected. In the same way, double clicking on an attribute type, the attribute types view is opened with the relevant type selected.

**Block properties Tab**
Properties of the block are attributes that acquire a specific value for the block.
This tab manages the properties assigned to the block. These properties are defined as attributes which scope is Blocks.
In the tab appears the list of attributes which scope is Blocks, with the value that they take for the selected block. This value can be modified by the user as long as he has write access on the block.
The attribute type is shown in the relevant column.
To modify the attribute type, the attributes view should be accessed. By double clicking on the name of an attribute, the attributes view is opened with the relevant attribute selected. In the same way, double clicking on an attribute type, the attribute types view is opened with the relevant type selected.

Included Elements Tab
Permits to include the desired elements in the block.

The top of the tab shows the type of element contained in the block.
It shows the list of elements that type available in the specification: the top table shows those that do not belong to the block and the bottom one those that do.
The buttons and may be used to include or exclude elements of the block.
By selecting an element on either of the two lists, their description is shown on the bottom of the tab.
By default the Remove hierarchy option is not checked. That is, when an element is excluded from a block that inherits from others, the element remains included in the blocks upper in the hierarchy. If the Remove hierarchy
option is checked, when excluding an element from a block, it is excluded at the same time from all blocks in the upper hierarchical levels.

**Relationships Tab**

The Relationships tab shows the relations with other blocks in which the block selected participates.

![Properties Tab](image)

Each one of the rows on the list represents a relation in which the block selected participates (marked with color blue). Each row contains the following information:

- **Name.** Contains the name of the relation, if it has one. If the relation has no name, this field will be shown with the value Anonymous.
- **Origin.** Original block of the relation.
- **Destination.** Destination block of the relation.
- **Generalization.** Indicates whether the relation between two blocks is generalization or not. If the relation is a generalization, the origin block is the most general block.

The following two operations may be performed from this tab:

- Delete the relation selected by clicking the button **Delete**.
- Activate the relation selected by clicking the button **Activate**. Activation of a relation will show the existing relations between the individual elements contained in the blocks involved in that relation on a traceability matrix. A relation may be activated only if it is NOT a generalization.

**Versions Tab**

It shows information on the versions of the block selected and the differences between them (see section Individual element version control).
Definition of Blocks

To add, edit and delete blocks in the Blocks views, the options available are the same as described in the Inputting requirements section.

The predefined attributes for blocks (besides name and access partition) are:

- Type of elements included in the block: The user must select a type in the drop-down menu to this end. It is not possible to modify it once the block is created.
- Include all elements: The user must decide if the block will contain all elements belonging to the relevant type, or if elements will have to be manually assigned by the user in order to belong to the block. This feature is available to be modified at any time in the Details tab.

Active block selection

There is the possibility of selecting a block as an active one. That selection is performed on the fold-down menu which appears on the Blocks bar. By default there is no active block.

The list of blocks available in this menu can be filtered using the dropdown menu, which shows a list of the project's block diagrams. If one of these diagrams is selected, the dropdown menu for the selection of the active block will only display the blocks included in that diagram. This restriction applies to both the menu in the Blocks toolbar and to the block selection menus that appear in the related elements tabs.

Activation of a block has the following consequences:

- In the views in IRQA® of the type of element of the block, it only shows the elements belonging to that block.
- When new elements are input in the views of the type of element of the block, those elements are automatically assigned to the active block.

Block diagrams

The block diagram management dialog box may be accessed using the button on the tool bar, or the option Block diagrams of the menu Project>Project Organization.

Then a dialog box appears showing the list of block diagrams available in the project and that belong to an access partition in which the user has, at least, read rights.

The options available are the same as described for concept diagrams (see the Concepts diagrams (Object Oriented) section).

When a block diagram is open, the specific options available in the tool bar are the following:

- Create a new block.
- Include an existing block from the project in a block diagram.
- Create a new relation of association between blocks.
- Include an existing relation of association in the diagram.
- Create a new generalization relation between blocks.
- Include an existing relation of generalization in the diagram.
Shows an indirect traceability matrix between the two blocks selected.

Selects the block or relation of association selected as the active element.

The relations between blocks may only be managed in the block diagram editor.

To see the detail of the tool bars common to all graph editors, see the Diagram zoom bar, Diagram graphics bar, Diagram layout bar and General options in the diagrams sections.

The block diagram editor displays the following screen:

![Diagram of block diagram editor](image)

When an association between two blocks is created, if the two blocks to be related contain requirements or test scenarios, a dialog box appears to select the motive for the relation between both blocks from a fold-down menu where the free motives of relation in the project appear. The motives creation dialog may be accessed from that dialog box to define a new one if necessary.

In any other case of relation between blocks, the dialog box which appears must be used to simply input the name and the description of the relation to create, none of which is obligatory.

If the relation just created is between blocks of requirements or of test scenarios, the relation is shown as an arrow which direction indicates the direction of the relationship.

It is only possible to create relations of association between blocks that contain types of elements that may be related in IRQA®.

The relations of generalization between blocks are created in the same way as those of association by clicking the button. It is only possible between two blocks that contain elements of the same type.

A motive for the relation has to be selected, same as in the case of associations between requirement or test scenario blocks.

Creation of a relation of generalization between two blocks implies that the child block inherits the attributes...
associated with the parent block. There may be several hierarchy levels in a block diagram, that is, a block may be a child of another and, in turn the parent of other blocks. However, it is not possible for a block to have more than one parent block.

It is not possible for a block that contains all elements of the relevant type to be a child of another block.

When a generalization link between two blocks is created, the elements already assigned to the child block, will be automatically assigned to all blocks in the upper levels of the hierarchy. A warning message is shown to the user, allowing the option to cancel the creation of the link.

When a generalization link between two blocks is deleted, the elements previously assigned to these blocks will still belong to both of them. The user should exclude the elements manually for them to stop belonging to any of the blocks.

By selecting an element on the diagram, there is a contextual menu which appears by right clicking, which may be used to pick any of the graphic options also shown on the button bar.

If the element selected is a block, two special options appear on the contextual menu:

- Select as an active block.
- Properties: The block view is opened, with the block concerned selected.

If the element selected is a relation between blocks, two special options appear on the contextual menu:

- Select as an active relation.
- Properties: Shows the definition of relations, where the properties of the relation selected may be changed.

Active block selection in a block diagram

This option is available in the contextual menu obtained by selecting a block in a block diagram and clicking the button on the tool bar in the graphic view, as long as there is a block selected in the diagram displayed.

![Block Diagram Example](image-url)
When this option is selected, IRQA® automatically browses to the predetermined view of the element of the block, showing only the elements that belong to the active block.

When new elements are input in the block element type views, those elements are automatically assigned to the active block.

That activation of the block is equivalent to that which may be done on the fold-down menu on the bar for Blocks. In fact, the block selected as active on the diagram is shown in this menu.

The active block shown is emphasized with a thick line on the block diagram. If the active block has hierarchical relations with other blocks, the whole hierarchy is emphasized.

**Selection of active relation**

This option is available on the contextual menu obtained on selecting a relation of association in a block diagram and clicking the button on the tool bar in the graphic view, as long as there is any relation of association selected in the diagram displayed.

By selecting that option, IRQA® automatically browses to the relevant traceability matrix for the relation selected, where one may view, establish or eliminate relations between the different elements comprising both blocks.
Indirect traceability

On a block diagram one may view the traceability matrix between any two blocks that appear in the diagram, as long as there is at least one path joining both blocks, although not a direct relation.

If there is more than one possible path joining the two blocks selected, one must first select the desired traceability.
path.

Clicking the button displays the following dialog box showing the first of the paths identified:

![Diagram showing path selection dialog box]

The diagram enhances the blocks and relations that define the path showed in the dialog box.
The user may view the different possible paths by clicking on the buttons [next], [back], [last], [first].

The fold-down menu may be used to change the color that marks the path shown between the two blocks.

By clicking the button [Select path] one may view the relevant traceability matrix for the path selected. That matrix is only for consultation; relations may not be established or deleted manually. It may be exported to Excel.

Locate elements in blocks

It is possible to associate, exclude or change a group of elements to blocks by selecting the set of elements in the relevant view and using the available options on the menu Edit>Locate block elements.
Associate elements to a block

A way to include elements in a block is to use the button or the option Associate elements to a block on the menu Edit>Locate block elements. To do so, we must select the elements to associate and then the button or the option indicated above. Then the following dialog box appears:

![Associate elements to a block dialog box]

The fold-down menu shows the list of blocks that may be associated with the elements selected.

When the button is clicked, the elements selected will be included in the block chosen.

Exclude elements from a block

It is possible to exclude a group of elements from a block. To do so, first one must select the elements to exclude and then click on the button on the Blocks bar, or the option Exclude elements from a block on the menu Edit>Locate block elements.

At the top of the dialog box, there are the elements selected and at the bottom one must select the block from which one wishes to exclude the elements.

On clicking the button, the elements belonging to the block selected shall be excluded from it.

One must bear in mind that, when elements of a block are excluded, they stop having the values of attributes of the block, and are excluded from the blocks inheriting from the selected block.

If the elements are re-assigned later to a block from which they were excluded, they retrieve the values of attributes they had when they were excluded (that is, the attributes are not initialized to the default value).
Move elements to another block

It is possible to change a group of elements from one block to another. To do so, one must first select the elements to change in the relevant view and then click on the button on the Blocks bar, or the option Move elements to another block on the menu Edit>Locate block elements.

Then the following dialog box is displayed:

The top shows the elements selected that are to be changed from one block to another. These must be selected on the fold-down menu on the left, marking the block from which the elements are to be excluded, and in the menu on the right, the block they are to be included in.

The button makes it possible to visualize the common attributes of the two blocks, as when the change of elements from one block to another is performed, these elements conserve only the values of the attributes that are common to both blocks. In order for this button to be activated, both blocks must have been selected.

On clicking the button the elements will be changed from one block to another.

Workflows

A workflow in IRQA® allows the project’s administrators to define the set of allowed transitions between different values of a listed attribute, and restricting these transactions from being carried out, only to user groups that are authorised for it. A workflow is thus associated to a listed attribute.

Concrete elements that are affected by workflow-defined restrictions are those that take values for the attribute associated to that workflow; i.e., the scope of the workflow is the same as for the attribute. In this way, workflows can affect the following element types:
- Requirements.
- Concepts/entities
- Services
- Actors/external entities
- Scenarios
- Test scenarios
- Blocks
- Domains

For example, if the scope of the attribute is a requirements block, the workflow will only affect requirements that belong to that block.

Transactions among values of the attribute allowed by a workflow are graphically represented using a state diagram.

The user can define and consult workflows from text views.

**Managing workflow views**

To open workflow views, the menu *Project* > *Project Organization* > *Workflows* should be accessed, or otherwise the user should select the drop-down menu right of the button of the Project bar.

This menu introduces the same options as for other IRQA® elements (see the Requirements view section).

The default workflow view is the following:

The workflow views are made up of up to three panels:

- Grid panel: A column can always be seen with the name of the workflows. The options available to manage this panel are similar to the other IRQA® elements (see Requirement grid panel and Requirements view management), although in this case only columns with pre-defined attributes
can be added, as well as baselines and domains to that the workflow belongs.

- Description panel: This shows the description of the workflow selected in the grid panel (see the Requirements description panel section).

- Tabs panel: The following tabs, in which the information of the workflow selected in the grid panel, can be seen:
  
  - Details.
  - Values.
  - Related elements.
  - Versions.

Details tab

This tab shows information about the selected workflow. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).

The specific information for workflows is:

- Attribute associated to the workflow.
- Diagram associated to the workflow.

The only data of this tab that can be manually modified by the project's administrators is the access partition and the diagram associated to the workflow. Other users can see the information of the workflows (as long as they
have at least reading permission on the access partition that the workflow belongs to) but they cannot modify them.

To modify the diagram, press the *Edit* button below that diagram.

**Values tab**

This shows the list of elements affected by the workflow and the values that the attribute associated to the workflow takes for each one of them.

By default, all elements in the workflow’s scope are shown.

![Values tab screenshot](image)

This list can be filtered using the drop-down menus on top of the list, which can be used to select a single element type or a single block.

In this tab it is also possible to modify the value of the attribute for one of the elements that appear in the list. This modification will take restrictions of allowed values and authorised user groups defined by the workflow into account.

**Related elements tab**

This tab allows to include or exclude the workflow selected in one or several domains of the project.

To achieve this, select the domains and press the ![Add](image) and ![Remove](image) buttons to set or eliminate relationships with the
selected workflow.

**Versions tab**

This tab shows information about the selected workflow’s versions and the differences between them (see the Individual element version control section).

**Workflow definition**

To add a new workflow into the Workflow view, press the toolbar’s button. The following dialogue box will be seen:

![Add workflow dialogue box](image)

In this screen the name and the access partition for the workflow should be entered. The drop-down menu of access partitions will show only those that can contain workflows.

The attribute associated to the workflow should also be selected. This attribute should fulfill the following conditions:

- Mandatory.
- Enumerated.
- Not multi-valued.
- Not associated to any workflow.

If there is no attribute in the project that fulfills all necessary conditions, the tool will show a message that warns the user of this, giving the possibility of directly creating an attribute to associate to the new workflow.
Once the attribute has been created, the creation process of the new workflow can be continued.

If the attribute that is associated to the workflow is already being used in the project and there are elements that have values for the attribute, which are different to the default value, then these elements keep the value of the attribute that they had before the workflow was created. This means that there can be elements in the project that introduce transitions that do not fulfil conditions defined in the workflow.

The workflow creation dialogue box will always be visible when we want to enter new workflow values or edit already existing ones. In this case, the user should press the button. Only the name of the workflow and the partition that it belongs to can be modified. A new associated attribute cannot be selected.

The user should press the button to delete the selected workflows after asking for confirmation from the user. It is not possible to duplicate workflows using the Copy and Paste buttons.

Managing workflows is only available for users of the project’s administrators group. Other users can see the workflow’s information (whenever they have at least reading permission on the access partition that the workflow belongs to) but they cannot modify them or create new ones.

**Diagram associated to workflows**

To define transitions between different values of the enumerated attribute that are allowed by the workflow, these transitions should be represented in a state diagram. This diagram is seen in the Details tab of the workflow view. By default, the diagram represents the possible values of the attribute associated to the workflow as states, without any transition between them.

To modify the diagram, the user should press the button in the Details tab. The tool shows a graphic editor with the state diagram that is associated to the workflow. This editor is very similar to the one of state diagrams associated to services, although it has less available options (see the State Diagrams section).
In this diagram, the state that corresponds to the default value of the attribute is enhanced. This will be the initial state of the workflow. The user should define possible transitions between different values of the attribute. When a new transition is created between two states, the following dialogue box is shown:

In this dialogue box, the following data can be entered:
- User groups: In the left window, all of the project’s user groups can be seen (except for the administrators group). The user should select the user groups that are authorised to carry out the transition, and transfer them to the right window. The administrators group does not appear in this dialogue box because it is always authorised to carry out all transitions.

- Event: This is a free text field in which the user describes the external event that causes the transition, if there is one.

- Condition: This is a free text field in which the user describes the condition necessary to carry out the transition. The tool does not do any checking associated to this condition.

- Script: This can be an external file that the user can select using Windows Explorer, in which one or several procedures should be seen. It can also be a text written directly in the Script window. The user should first check the Activate option and then either select the external file or write the script.

- Procedure: This is an executable program included in the script. It receives parameters that characterise the transition, and it is run when the transition occurs. The parameters sent to the procedure are the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>IRQAFace Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>dsn</td>
<td>DSN</td>
</tr>
<tr>
<td>project</td>
<td>Project</td>
</tr>
<tr>
<td>element</td>
<td>Requisite, Service, Agent, Scenario, TestScenario, Class</td>
</tr>
<tr>
<td>attribute</td>
<td>DynamicAttribute</td>
</tr>
<tr>
<td>oldValue</td>
<td>DynamicEnumValue</td>
</tr>
<tr>
<td>newValue</td>
<td>DynamicEnumValue</td>
</tr>
<tr>
<td>user</td>
<td>User</td>
</tr>
<tr>
<td>userGroup</td>
<td>UsersGroup</td>
</tr>
</tbody>
</table>

As an example, let us see the procedure P1. It shows a message where the previous data appears linked together: repository, project, element for which the value of the attribute was modified, modified attribute, initial value of the attribute, new value of the attribute, user who modified the attribute, user group to which the user belongs.

Sub P1()
    'Dim strMsg as String
    strMsg= "P1()"
    'DSN
    strMsg= strMsg & vbCRLF & "DSN       : " & dsn.Name
    'Project
    strMsg= strMsg & vbCRLF & "Project   : " & project.strName & " (" & project.lCode & ")"
    'Element
    'Attribute
    strMsg= strMsg & vbCRLF & "Attribute : " & attribute.strName & " (" & attribute.lCode & ")"
    'Old value
None of the fields linked to the transition is obligatory. If no user group is entered, only administrators can carry out the transition.

When a user modifies the value of the attribute associated to a workflow for an element, the tool checks if the user belongs to a group authorised to carry out a transition from the current value, and which is the value or values allowed for transitions in the workflow. Only those transitions will be allowed by the tool and only if the user is authorised to carry them out.

```vbnet
strMsg= strMsg & vbCRLF & "Old value : " & oldValue.strName & " (" & oldValue.lCode & ")"

' New value
strMsg= strMsg & vbCRLF & "New value : " & newValue.strName & " (" & newValue.lCode & ")"

' User
strMsg= strMsg & vbCRLF & "User : " & user.strLogin & " (" & user.lCode & ")"

' User group
strMsg= strMsg & vbCRLF & "User group: " & userGroup.strName & " (" & userGroup.lCode & ")"

MsgBox strMsg
End Sub
```
Reusability with IRQA

Introduction

Integral Requisite Analyzer 4 offers the possibility of reusing requirements and other specification elements between different projects that belong to the same repository. This can be carried out at different levels: a copy of the elements of a project can be incorporated into another in such a way that the elements are totally independent in both projects, once the copy has been made; another option is that the elements can be truly shared, in such a way that they can only be modified in the project in which they were defined and those modifications spread to projects that are reusing them.

Requirements, services and test scenarios are the elements that can be reused between projects.

These elements are grouped into reuse units that we call components. Within projects, components can be created. A component is a group of requirements, services and/or test scenarios, with relationships between them and one or several of their attributes. These components can be made available for other projects of the repository for their reuse. In principle, any user of a project can create a component, as long as that user has writing permission in an access partition that can contain components.

Administrators of the project that a component belongs to (we will call it the source project) are responsible for deciding in which other projects of the repository will it be possible to reuse the component in question. These will be the target projects.

Administrators of the target project can decide which are the components among those available in the repository that they want to effectively reuse in the project. In general, it is also possible to select which elements of the component are going to be reused. However, the user that creates a component can define it as non-partitionable, i.e. that it cannot be partially reused according to what is decided in each project, but it has to be reused as a whole.

The administrator of the target project can also decide the mode or level of component reuse. There are three possibilities:

- **Share**: The elements of the component cannot be modified in the target project. They can only be characterised using local attributes of the target project and can be related to other elements of the target project. If a new version of the component is created in the source project, this will be reported in the target project and it can be decided if the elements are to be updated to the new version.

- **Copy and Link**: The component's elements can be modified in the target project without any restriction. However, same as when the component is shared, if a new version of the component is created in the source project, this will be reported in the target project and it can be decided if the elements are to be updated to the new version.

- **Copy**: Elements of the component can be modified in the target project without any restrictions and no information will be received if modifying the component in the source project.

When the administrator creates a new repository, it will also have to be decided if support will be given for the reuse functions in this repository. It will only be possible to define components and reuse them in the projects belonging to those repositories.

Implementing the reuse function in an organization will involve the following steps:

- **Creating the component**: An analyst creates a component from the set of requirements, services and/or test scenarios that have already been defined in a project. This will be the source project of the component.

- **Publishing the component**: An administrator of the project in which the component has been created, makes that component available to other projects of the same repository (target projects). This function can only be carried out in IRQA Administration Centre.

- **Reusing the component**: An administrator of a target project analyses the component and selects its
elements that will be effectively reused in that project. The administrator also decides the reuse mode (share, copy and link, or copy) for the component in the target project.

- Analysts of the target project work with the elements of the reused component. Depending on the reuse mode, more or less modifications can be carried out on those elements.
- Modifying the component: An analyst of the source project creates a new version of the component.
- Publishing the new version of the component: An administrator of the source project publishes the new version of the component for other projects of the same repository. These can be the same ones that were already target projects of the component, or other new ones. This function can only be carried out in IRQA Administration Centre.
- Notification that a new version of the component is available: The tool shows the component for which a new version has been published, as well as its elements, as suspect in the target projects in which the component is being reused.
- Updating the component: An administrator of the target project analyses the new version of the component and decides whether or not to incorporate this new version into the target project.
- Modifying the reuse mode: An administrator of the target project in which a component is being used, can decide at any time to modify the reuse mode from share to copy and link, or from copy and link to copy option.

In the description of these steps, it can be seen that several of the actions to be carried out, correspond to the project’s administrator profiles. This means that implementing reuse functions into an organization requires some control and a centralised decision making process.

Components

In all projects that belong to a repository with reuse support, it is possible to create components that can be made available to the rest of the repository’s projects, in order to be reused.

Components view management

To open the components view, the Project>Project Organization>Components menu should be accessed, or otherwise the drop-down menu on the right of the button of the Reuse bar should be displayed.

This menu introduces the same options as for other IRQA® elements (see the Requirements view management section).

The default view of the components is as follows:
Views of components are made up of up to three panels:

- **Grid panel**: A column can always be seen with the name of the components. The options available to manage this panel are analogous to other IRQA® elements (see the Requirement grid panel and Requirements view management sections), although in this case only columns with pre-defined attributes can be added.

- **Description panel**: This panel shows the description of the component selected in the grid panel (see the Requirements description panel section).

- **Tabs panel**: Information of the component selected in the grid panel is shown within the following tabs:
  - Details
  - Requirements
  - Services
  - Test scenarios
  - Blocks
  - Attributes
  - Projects
  - Versions

**Details tab**

This tab shows information about the selected component. The meaning of the fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter)

**Requirements tab**
This tab shows the list of requirements that belong to the selected component.

For every requirement, the code, name, version included in the component, and author of this version, can be seen. When a requirement is selected in the list, its description can be seen at the bottom of the tab.

Services tab
This tab shows the list of services that belong to the selected component. The information about services shown in this tab is the same as in the Requirements tab.

Test scenarios tab
This tab shows the list of test scenarios that belong to the selected component. The information about test scenarios shown in this tab is the same as in the Requirements tab.

Blocks tab
This tab shows the list of blocks that belong to the selected component. The information about blocks shown in this tab is the same as in the Requirements tab (except for the code).

Attributes tab
This tab shows the list of attributes that belong to the selected component. The information about attributes shown in this tab is the same as in the Requirements tab (except for the code).
Projects tab
This tab shows the projects included in the repository for which the component has been published.

Versions tab
This tab shows information about the versions of the selected component and the differences between them (see the Individual element version control section).

Definition of components
To create a component, the user should press the toolbar’s button in the Components view. The following dialogue box will then be seen:

The following data should be entered into this screen:

- Component’s name.
- Access partition for the component. The drop-down menu of access partitions will only show those that can contain components and that the user defining the component has writing permission over.
- Baseline. The menu will show all baselines that exist in the project. Selecting a baseline means that the default versions of the elements to be included in the component, will be those that belong to that baseline. The current baseline is selected by default.
- Partitionable option. If the user checks this option, the component will be able to be partially reused in other projects, i.e. those elements of the component that are to be included in the project, can be selected. If this option is not checked, it is not partitionable, i.e. if the component is reused in another project, all of its elements must be reused. By default, this option is not checked, i.e. the component cannot be partitioned.

Once this data has been selected, the user should click . The following dialogue box is then shown:
In this dialogue box, the starting point for elements that are going to belong to the component should be selected. This means that the elements that the tool proposes by default to be included in the component will belong to the selection carried out in this dialogue box. The user will then be able to select which ones will be truly included in the component among those elements, but no new elements can be added.

When the selection has been carried out, the user should press \textbf{Next}. The following dialogue box is then shown:

In this screen the user should select the requirements that are going to belong to the component. The tool proposes the list of requirements that belong to the element (domain, block, component) that was selected in the previous screen. The following data is shown for each of them:

- Code of the requirement.
- Name of the requirement.
- Author of the active version of the requirement.
- Proposed version number to be included in the component. It will be the one belonging to the baseline selected as the starting point in the component’s creation dialogue box. However, the user can select a different version in the drop-down versions menu.

- Requirement’s version status. It can be checked in or checked out. Only requirement versions in checked in status can be selected to be included in the component.

When a requirement of the list is selected, its description is shown in the bottom of the dialogue box.

In the left column, the user can select the requirements to be included in the component. By default, all checked in requirements are selected, i.e. all those belonging to the domain, block or component, which version belonging to the selected baseline is checked in.

If a requirement appears in a checked out version, it is not possible to select it; it can only be included in the component when selecting a previous version that is checked in.

When the requirements have been selected, the user should press \( \text{Next} \). The tool then shows the services and test scenarios selection dialogue boxes, which work same way as the requirements selection dialogue box.

The following dialogue box proposes the blocks to be included in the component:

- If the starting point for the component is a block, only this block is proposed.

- If the starting point for the component is a domain, the blocks that contain at least an element among the ones previously selected for the component are proposed.

- If the starting point for the component is another component, only the blocks belonging to the component selected as starting point are proposed.

Same as described for requirements, services and test scenarios, only checked-in versions of blocks can be selected to be included in the component.

After pressing \( \text{Next} \), the tool shows the attributes selection dialogue box. The attributes proposed to be included in the component are those for which the elements previously selected for the component have values.

Same as described for the rest of elements, only checked-in versions of attributes can be selected to be included in the component.

Finally, the user should press \( \text{Finish} \) to create the component based on the data selected by the user in previous screens.

The user must check-in the component after creation. Otherwise, it will not be available to be published for other projects in the Administration Center.

**Note:** Elements belonging to a component can not be modified (versions have to be checked-in), but it is possible to modify later the links between them even with the elements in checked-in status. It must be taken into account that the links that will be reused in the target projects will be the ones existing in the source project when the component is imported in the target (not the ones existing when the component was created).

**Edition of components**

To modify a component, the user should press the toolbar’s \( \text{Edit} \) button in the Components view.

The tool shows the same wizard as in the component creation. All data can be modified and elements can be added or removed.

Like the rest of elements in IRQA®, it is not possible to modify a component if it is not checked-out by the user who wants to modify it.

If the version of the component before modification is not being actually reused in any target project (or if it has not been published), the new version created after edition, will be the only version of this component available for publication and reuse.
Deletion of components

To delete a component, the user should press the toolbar’s button in the Components view. The tool asks for confirmation.

Like the rest of elements in IRQA®, it is not possible to delete a component if it is not checked-out by the user.

It is not possible to delete components that are actually reused (in share or copy and link modes) in any of the projects, for which they have been published.

Reusable components

In each project that belongs to a repository with reuse support, there is a view of reusable components, in which the user can manage components that were created in other projects of the repository when they have been published for the project in question.

Managing reusable component views

To open the reusable component views, the user should access the Project>Project organization>Reusable components menu, or press the drop-down menu right of the button of the Reuse bar.

This menu introduces the same options as for other IRQA® elements (see the Requirements view section).

The default view of reusable components is as follows:

The reusable components view is made up of a maximum of three panels:

- Grid panel: A column can always be seen with the name of the components and another column can be seen with an icon indicating if the component is simply available for the project or if it is being currently reused in it. The options available to manage this panel are similar to other IRQA® elements (see Requirement grid panel and Requirements view management). In this case only columns with pre-defined attributes can be added, including reuse specific fields such as:
• The source project of the component.
• Its reuse mode when it is being actually reused in the project.
• Latest version of the component in the source project that has been published for the target project.
• Latest version of the component actually reused.

- Description panel: This shows the description of the reusable component selected in the grid panel (see the Requirements description panel section).
- Tabs panel: The following tabs, in which the information of the reusable component selected in the grid panel, can be seen:
  • Details
  • Requirements
  • Services
  • Test scenarios
  • Blocks
  • Attributes

**Details tab**

This tab shows the following information about the selected component:

- User that created the component in the source project.
- Date and time when the component was created in the source project.
- Access partition. This is the partition that the component in the target project is assigned to, when the component is imported for its effective reuse in the project. If it has not yet been imported, the access partition is blank and the component is only visible for administrators of the project.

The information about the source project or the reuse mode in case the component is being reused in the project, can be seen by configuring the corresponding columns in the grid view.

**Requirements tab**

This tab shows the list of requirements that belong to the selected component. For each requirement, the following information can be seen: code, name, version number and author of the version included in the component. When selecting a requirement in the list, its description can be seen in the bottom of the tab.

**Services Tab**

This tab shows the list of services belonging to the selected component. The information shown for each one is the same as described in the Requirements tab of this view.

**Test scenarios tab**

This tab shows the list of test scenarios that belong to the selected component. The information shown for each one is the same as described in the Requirements tab of this view.

**Blocks tab**

This tab shows the list of blocks that belong to the selected component. The information shown for each one is the same as described in the Requirements tab of this view (except for the code).

**Attributes tab**

This tab shows the list of attributes that belong to the selected component. The information shown for each one is
the same as described in the Requirements tab of this view (except for the code).

Managing reusable components

It is not possible to create, modify or delete reusable components in the target projects. To add reusable components into target projects, the components should be created in the source projects and then they should be published for the target projects in IRQA Administration Centre.

Data shown in the views of reusable components cannot be modified in the target project. If a new version of the component has been created in the source project before the component has been imported in the target, then the data of the component will be automatically updated in the target project.

If the component has been imported in the target project (that is, it is being actually reused), then the component becomes suspect and the administrator should decide if updating to the new version of the component or not.

The access partition that the component is assigned to when being imported in the target project, can not be modified either.

A reused component cannot be deleted in the target project. To stop seeing the component in this view, it must stop being published for the project. This operation can only be carried out in IRQA Administration Centre.

Importing components

In order to actually reuse the elements that belong to a component in a project, the component should be imported into the target project.

This process is carried out in the following way:

- The user selects the component that is to be imported. Next the Import Component option should be selected in the Project>Project Organization menu, or alternatively the Reuse bar’s button can be pressed.
- The following dialogue box is then shown:

![Components dialogue box]

The user should select the following data:

- Access partition of the target project that the reused component and its elements reused in the project, are going to belong to. Based on this partition, the users’ access permissions on the component and...
its elements are managed in the target project.

- Domain. Optionally, the user may select a domain in the target project where the reused elements will be included.

- Reuse mode of the component. One of the following three available options should be selected: Share, Copy and link, Copy.

When this data has been selected, the user should press Next >.

- The following dialogue box is then shown:

The user should select the requirements to be reused in the project, within this dialogue box, by checking them in the left column. If the component is not partitionable, the selection of any requirements cannot be unchecked; all elements must be imported from the component or the importing operation must be cancelled.

Selecting a requirement of the list, its description is shown at the bottom of the dialogue box.

When the requirements have been selected, the user should press Next >.

The tool then shows the service, test scenario, block and attribute selection dialogue boxes that work same as the requirements selection dialogue box.

When all elements have been selected, the user should press Finish. Next, all elements of the component that have been selected are imported into the target project. Links between those elements are also imported.

**Note:** Only links by motives already existing in the target project are imported. No new motives are created in the target project, that is, no links are imported if the motive does not exist.

**Note:** The links that will be imported in the target project will be the ones existing in the source project at the moment of importing the component.

Requirements, services and test scenarios imported in a project in share mode can only come from a component. If a component is being imported in share mode and contains an element that was previously imported from another component also in share mode, the following options may appear:

1. Both components are partitionable and the element belongs to both but in different
versions. Then a message is shown for the user to decide if the element will be updated to the version in the new component, if it will be kept in the version belonging to the previously imported component, or if the import is cancelled.

2. The component previously imported is non partitionable and the one being imported is partitionable. In this case, the element can not be imported anew but the component import could continue as long as this element is not imported. A message is shown for the user to decide if the import will be continued without importing the repeated element, or if the import is cancelled.

3. The component previously imported is partitionable and the one being imported is non partitionable. In this case, the element has to be updated in order to import the component. A message is shown for the user to decide if the import will be continued updating the repeated element, or if the import is cancelled.

4. Both components are non partitionable. In this case a message is shown to indicate that the component cannot be imported.

Reused elements (requirements, services and test scenarios) on share mode will appear in the target project with the same code as in the source project.

Reused elements in copy or copy and link mode will be assigned a code like the one in the source project, adding the suffix "(1)", or a higher number if necessary.

From then on, the imported elements can be managed in the target project, with corresponding restrictions taking into account the reuse mode of the component.

Information on blocks and attributes is imported into the target project with the following characteristics:

- If the block exists in the target project with the same name and containing the same type of elements, then the imported elements that belonged to it in the component are assigned to this block.
- If the block exists in the target project with the same name but containing another type of elements, then information on the block is not imported; the imported elements are not assigned to the block.
- If the block does not exist in the target project, then a new block (in version 1) is created with the same name and type of elements and the imported elements that belonged to it in the component are assigned to the new block.
- If the attribute exists in the target project with the same name and type, then the values of the attribute in the component are assigned to the imported elements in the target project.
- If the attribute exists in the target project with the same name but different type, then the values of the attribute for the elements are not imported.
- If the attribute does not exist in the target project, then a new attribute (in version 1) is created with the same name and type. The values of the attribute in the component are assigned to the imported elements.

Managing reused elements

When a component has been imported in a target project, the requirements, services and test scenarios belonging to the component will appear in the corresponding views.

These elements will be checked-out by the user that has performed the import function.

If the reuse mode was Copy, the will be no information on reuse available for these elements.

If the reuse mode was Share or Copy and Link, the elements will appear with an icon to the left of the code, and it is possible to see information on reuse (like source component, source element, etc.).

The operations to be performed on reused elements depend on the reuse mode:

- If the reuse mode is Copy or Copy and Link, the elements can be fully modified in the target project.
If the reuse mode is Share, the only allowed modifications are:

- Relationships with other specification elements.
- Inclusion in domains and blocks.
- Values of attributes.

The reused blocks and attributes imported from the component will appear in the corresponding views. They will be checked-out by the user that has performed the import function. It is always possible to modify blocks and attributes, no matter the reuse mode.

**Updating components**

When a new version of a component for a target project has been published, the elements of that component being reused in the project can be updated to the version of those elements that belong to the component’s new version. This process is carried out as follows:

- In the reusable components view, the user should select a component that has been imported into the project and that is seen as suspect (enhanced in red).

  **Note:** All elements reused from the component that are different in the new version, also appear as suspect (enhanced in red) in the relevant view.

- The user selects the **Update component** option in the **Project>Project organization** menu, or otherwise press the Reuse bar’s button.

- The following dialog is shown:

  ![Component Update dialog](image)

  In this dialog, the user can see the list of requirements belonging to the new version of the component. The status can be:

  - Unchanged: The requirement is not modified with respect to the previous version of the component.
- New: The requirement did not exist in the previous version of the component.
- Changed: The requirement has been modified with respect to the previous version of the component.
- Deleted: The requirement does not exist in the new version of the component.

When selecting a requirement, its description can be seen in the field below the list.

The user may decide to update to the new version of the component. If it is not partitionable, it is only possible to update all elements or none. If the component is partitionable, the user can select which requirements will be updated.

- Clicking on next new dialogs are shown for services, test scenarios, blocks and attributes in the component. These dialogs present the same options as the requirements one.

**Modifying the reuse mode of a component**

It is possible to modify the reuse level of a component in the target project. This operation implies modifying the reuse mode of the component’s elements that have been imported into the project.

The available modifications of the reuse mode are the following:

- From Share to Copy and Link.
- From Copy and Link to Copy.

This process is carried out as follows:

- In the reusable components view, the user should select a component that has been imported into the project.
- The user selects the Modify reuse mode option in the Project>Project Organization menu, or presses the Reuse bar’s button.
- The tool asks for confirmation and modifies the reuse mode to the new one (Copy and Link if the previous one was Share, or Copy if the previous one was Copy and Link).

From this moment, the reuse mode for all elements belonging to the component will be the new one.

**Comparing components**

It is possible to compare two components that have been published for the same project.

The user must select both components in the Reusable Components view and click on the button in the Reuse bar or select the Compare components option in the Project>Project Organization menu.

The tool shows a dialog where the list of elements belonging to both components is shown.
Elements marked in white belong to both components and no changes were made.

When an element is marked in green, it belongs to the first component only, and not to the second. When it is yellow, it belongs to the second, but not to the first.

When an element is marked in red, it means that it belongs to both components, but there are differences between the versions belonging to each.

After selecting an element, the line is highlighted in blue. Double-clicking on it, a new window will open with the element details, which will show the fields with differences in each version in red.

If there are differences in the description, the details can be shown clicking on the button between both descriptions. A window appears, where a field is shown with the element description, enhancing the differences between both versions.

If the selected line corresponds to differences in relations, double-clicking on it (it will be displayed in blue), a screen will open with two traceability matrices: the matrix for component 1 and the matrix for component 2, with red marks on the relations that have changed. These matrices may be exported to Excel using the button.
Integration with software design tools

Export Model UML to XMI 1.0

Integral Requisite Analyzer provides the possibility of communicating with design tools by XMI exporting the ULM elements supported by the tool, so that possibility will only be possible in the object oriented view of the project. The diagrams that are exported are as follows:

- **Concept diagrams.** These diagrams are exported as class diagrams.
- **Use Case diagrams.**
- **State diagrams.**

To access this function, one must select the option Export UML model to XMI on the menu Engineering Process>Integrations. After selecting that option, the following dialog box appears:

![Export UML Model 1.3 to XMI 1.0 dialog box]

As may be seen, some of the export features may be configured in the dialog box.

IRQA® offers two recommendations concerning the type of XMI file generated, depending on the design tool from which that file is later to be imported. There are two options: recommended option for Rational Rose and recommended option for Together Control Center.

There is also the possibility of exporting all the services of IRQA® as use cases or only the high level services (that is, those not included in the diagrams of states).

Once the exportation is adequately configured, a location and a name will be chosen for the file generated. If the exportation has been satisfactory, the user will be shown a confirmation message.

**Note:** Not only is the graphic information exported, but also all the properties of the elements participating in those diagrams.

Import from XMI 1.0 to model UML

This is the feature provided by IRQA® to import the UML elements from a file in XMI format, normally generated by a design tool supporting UML.

Importation of an XMI file is performed by selecting the option Import from XMI to model UML on the menu Engineering Process>Integrations. When this option is selected, the following dialog box will appear, to select the file containing the UML model one wishes to import:
After clicking Open, IRQA® will import the following elements: Classes, Use Case Diagrams, Use Cases and Actors. All the classes read in the XMI file are imported as implementation classes (see section Implementation classes). As to the rest of the elements, these are only imported when not previously created in IRQA®.

If an implementation class is included in one or several packages whose names are the same as those of any existing concept or service in the IRQA® project, the importation process will interpret that the class imported is derived from the concept or service associated with the package. That will have the consequence of the implementation class imported automatically being associated with the requirements related to the concepts and/or services from which they derive (see section Implementation classes).

**Implementation classes**

The element “implementation class” managed in IRQA® represents the classes of design in which the items of the conceptual model of classes defined during the specification phase of IRQA® evolves. The implementation classes of IRQA® are simply an image of the classes that have been created in a design tool. As they are design elements, they may not be edited in IRQA®, as IRQA® is limited to the scope of the phases of requirements and analysis.

The implementation classes are input in IRQA®, importing them from a file in XMI format generated with an Object Oriented based design tool such as Rose, Together, etc. (option “Import from XMI to model UML” of the menu Engineering Process>Integrations). This element may only be viewed if the project is opened in Object Oriented mode.

To open the implementation classes views, one must access the menu Engineering process>Integrations>Implementation classes, or click on the fold-down menu to the right of the button on the bar for Integrations. This menu has the same options as the rest of the elements of IRQA® (see section Requirements view). The default view of implementation classes is as follows:
The views of implementation classes are formed by a maximum of three panels:

- **Grid panel:** A column always appears with the name of the implementation classes. The options available to manage this panel are the same as those of the rest of the elements of IRQA® (see sections Requirement grid panel and Requirements view management), although in this case one may only add columns with predefined attributes as the implementation classes may not have attributes. As in the concepts view, the list of implementation classes may be shown in tree format where, under the name of each class, there are its attributes and operations. To do so, select the option **Attributes and Operations** as a first level organization criteria.

- **Description panel:** Shows the description of the implementation class selected on the grid panel. This description may not be modified.

- **Tab panel:** The following tabs appear, showing information on the implementation class selected on the grid panel:
  - Details.
  - Related Requirements.
  - Derived from.

**Details Tab**
This will show the author, creation date, author of the active version, creation date of the active version, user that has checked the implementation class out, and access partition it belongs to. The author is the user who captures the XMI file.

None of these data items may be modified.

**Related Requirements Tab**
Allows requirements to be associated with the implementation class selected.

The characteristics and options available on this tab are the same as those shown on the Related Elements Tab of the requirements view. The menu Blocks is active to allow the list of requirements to be filtered.

In the case of implementation classes, there is no management of suspect links.

**Derived from Tab**
This shows the concepts and services that the implementation class derives from (see section Import from XMI 1.0 to model UML).

None of these data items may be modified manually.
Warning: In IRQA 4 version 1 the XMI export/import is not available.
External Elements

Introduction

In IRQA® external elements can be managed. These elements can only be created through the API, not manually. They will come from other tools, different from IRQA®.

When external elements are created through the API, blocks can be created that contain the external elements. These blocks can be related through generalization links. Also, those blocks can be included later in block diagrams, and can be linked with other blocks in the project. Blocks of external elements can be related with blocks containing the following elements:

- Requirements.
- Services.
- Concepts.
- Test scenarios.

Attributes can be assigned to those blocks. The attribute values will be assigned to the external elements included in the block.

The only operations that can be performed with external elements in IRQA® are:

- To include external elements in domains.
- To modify values of attributes for external elements.
- To link external elements with: requirements, services, concepts, test scenarios.

External elements View

To open the external elements view, the user can open the menu Engineering Process>Integrations>External elements, or click on the fold-down menu to the right of the button on the bar for Integrations. In either of the two cases, a menu is displayed, initially with three options:

- Predetermined: Opens the predetermined external elements view.
- View management: Opens the external elements view management dialog box.
- Default: Opens the external elements default view. Initially, this is also the predetermined view.

If you click directly on the button on the bar for Integrations, the predetermined view opens. The user may determine what external elements view to mark as predetermined.

This menu will also show the new views of external elements created by the user, to allow him to select the one he wishes to open.

The external elements views may have up to three panels:

- External elements list. This panel will always appear.
- Property tabs of the external element selected.
- Description window of the external element selected.

The grid panel always appears at the top left of the screen. The other two panels may be resized and placed in the place on the screen the user considers most appropriate. If either of the two panels is placed at the top, the grid
Default view of external elements

The default view of external elements is shown on the following screen:

The external elements grid panel is displayed on the left of the screen and has two columns: code and name of the project external elements, arranged in alphabetical order by codes.

The tab panel is displayed on the right, and the description one on the lower left of the screen.

When an external element is selected, the tabs and the description panel show the information for that external element.

The default view cannot be changed or deleted.

External elements grid panel
The panel with the external elements list will be displayed in all the views the user may define. That panel consists of a series of columns showing attributes and characteristics of the external elements. There are only two columns in the default view, showing the code and the name of the external elements.

The external elements are shown with the color configuration for versionable elements explained in section Requirement grid panel.

The attributes columns, if listed, may show different values of the attribute. These colors may be configured when defining the attribute type (see section Attribute types).

**Column inclusion and exclusion**

In the external elements views, at least the columns code and name will be displayed, which are obligatory. To include new columns, the user must select the option Configure clicking the button "Configure" on the tool bar located directly above the grid panel. The following menu is displayed:

There are several types of fields that may be included as columns on the external elements grid panel:

- *Predefined attributes.*
- *Organization elements.*
• **Attributes.**

The available options for configuration of the external element grid view are the same as for requirements (see the Column inclusion and exclusion section in the requirements chapter).

### Filter selection

A filter may be applied to the external elements list. To do so, click on the button in the configuration dialog box of the grid panel. A window will be displayed that may be used to create the filter desired and to select it so the external elements list shows only the elements that fulfill a certain condition.

### External element organization

In the configuration dialog box of the grid panel, the user may decide what criteria are to be used to organize the external elements on the list to be displayed.

The available options are the same as in the requirements view (see the Ordering requirements section).

### Edit modes in the grid panel

They are the same as in the requirements view (see the Edit modes on the grid panel section in the requirements chapter).

### Options available on the grid panel

The buttons tool bar for modification of the external element view is the same as in the requirements view (see the Available options on the grid panel section in the requirements chapter).

The External elements Classification Bar has the following appearance:

<table>
<thead>
<tr>
<th>List Level: List:</th>
<th>2nd Level:</th>
</tr>
</thead>
</table>

The bar contains a first fold-down menu for a first level classification, with the following options:

- **List.** Shows the unclassified external elements, in list format, solely with the order criteria input in the panel configuration.

- **Attributes.** When this option is selected, the fold-down menu on its right is activated, showing a list of the enumerated attributes of the project. The menu is used to select the attribute for ordering. The fold-down menu **Second level** is also activated to allow selection of another enumerated attribute as second level classification criteria.

- **Access Partitions.** This option organizes the external elements on the list according to the access partition where they are included.

- **Requirements.** Shows the external elements grouped according to the requirements they are related to.

- **Services.** Shows the external elements grouped according to the services they are related to.

The Filter Bar shows the identification of the filter included in the definition of the grid view.

### Special options on the grid panel

They are the same as the ones available for requirements (see the Special options on the grid panel section in the requirements chapter).

### Filtering the list of external elements
The list of external elements on display may be filtered by clicking the button on the tool bar.
The same dialog box is shown as in the case of configuring the filter for the grid panel as described above.
Note that this filter is temporary, that is, it only remains active while the user decides not to deactivate it, but it is not part of the panel configuration.

Management of external elements views
The user may create external elements views, modify or suppress them using the operations described below.

Creation of external elements views
To create a new external elements view, the user must create the desired configuration using the options of the
Configuration and Classification Bars of the grid panel, and then click the button on the Configuration Bar.
Then the dialog box to save views appears, with the same options as described for requirements (see the Creation of
requirements views section in the requirements chapter).
The parameters saved in the configuration are the same as described for requirements (see the Creation of
requirements views section in the requirements chapter).

Modification and deletion of external elements views
To modify or delete external elements views one must select the option View management shown on the menu
Engineering process>Integrations>External elements, or on the fold-down menu on the right of the button on the bar for Integrations. A dialog will appear with the same options available as the ones available for requirements (see the Modification and deletion of requirements views section).

Selection of external elements views
To open a external elements view that has already been created, that view must be selected on the menu
Engineering process>Integrations>External elements, or on the fold-down menu on the right of the button on the bar for Integrations.
Another possibility is to select the option View management that also appears on that menu. Then, in the views
management dialog box, select the one to open and click on the .

Sharing external elements views
To share a external element view the Views management option must be selected on the menu Engineering
process>Integrations>External elements, or on the fold-down menu on the right of the button on the bar for Integrations.
The process to follow to share a view and the behaviour of the tool as a consequence of this process is the same as in the case of requirements (see the Sharing requirements views section).

External elements description panel
The Description panel allows viewing the description of the external element marked on the grid panel.
The characteristics and options available on this panel are the same as described in the section Requirements description panel.

External elements views tab panel
On the right side of the external elements default view, there is the information panel of the external element marked on the list on the left. As in the case of the description panel, this may be hidden, the size and its location on screen changed, or it may be turned into a tab that opens up when the pointer is placed on it.

This panel is formed by a set of tabs that show the information in an organized manner. These tabs are as follows:

- Details.
- Related Elements.
- Blocks and Attributes.
- Versions.

A description of the function of each one of these tabs is now provided.

**Details Tab**

This shows us the following information about the external element selected:

![Details Tab](image)

The meaning of these fields and options available in this tab are the same as the ones available for requirements (see the Details Tab section in the requirements chapter).
Related Elements Tab

Allows the external element selected to be associated with other elements of the specification.

A fold-down menu is displayed at the top of the Related Elements tab that may be used to select the type of elements to be viewed. The available options are:

- Concepts (Entities, in functional mode).
- Domains.
- Test Scenarios.
- Requirements.
- Services.

The characteristics and options available on this tab are the same as the ones available for requirements (see the Related Elements Tab section in the requirements chapter).

Blocks and Attributes Tab

It shows information concerning the blocks to which the external element belongs and the values taken for the external element by the attributes associated with it.
The characteristics and options available on this tab are the same as those shown on the Blocks and Attributes Tab of the requirements view.

**Versions Tab**

Shows information on the versions of the external element selected and the differences between them (see section Individual element version control).
Additional Features

Language selection

The user may select the language in which he wishes to view the menus and messages in IRQA®. This is performed using the option View>Language on a fold-down menu where the language may be selected. As shown in the message displayed, after making the selection, the language change will not take place until the next time IRQA® is opened.

User interface theme

The user may select the appearance of the user interface: aspect of the bars, buttons and menu options, background colors, shading, etc. This is performed using the option View>Themes. A fold-down menu appears that may be used to select the aspect or theme the user prefers. That menu has different options, such as:

- Office 2000.
- Office XP.
- Windows XP.
- IRQA.

The default option is IRQA. The appearance change takes place immediately after the selection is made.

Tool bar configuration

The user may select the shortcuts on the button bar to be displayed on screen. This is done with the option View>Toolbars, that shows a menu to mark the bars one wishes to see. The available bars are those described in the section General tool bars.

On the other hand, just as explained in the section General options of the buttons bars, the last button of each one has an arrow on the lower right with the option “Add or remove buttons”. That option allows the user to configure the tool bars and menus displayed in IRQA®.

Initial view configuration

The user may decide what view he wishes displayed when opening a project. To do so, he must select the option Tools>Configuration>Initial view. The following screen will be displayed:
In this dialog the user must mark the view he wants from the following options:

- Requirements view: When the project is opened, it will show the predetermined requirements view. This is the default option.
- Services view: When the project is opened, it will display the predetermined services view.
- Blocks Diagram: In this case, the user must also select a block diagram among the existing ones in the project. When the project is opened, it displays the block diagram selected.
- Domains Diagram: In this case, the user must also select a domain diagram from the existing ones in the project. When the project is opened, it displays the domain diagram selected.

Desktop configuration

IRQA® allows the user to save different desktop configurations, a desktop configuration being understood as a windows layout.

Each user usually tends to organize the views in a certain way to perform a specific task. By means of that feature, IRQA® provides the facility to save those different configurations and recover them at will.

For example, let us suppose that in order to perform a certain task, the user organizes the views of IRQA® as follows:
To save that views organization, the option User desktops is chosen in the Window menu, which displays the following dialog box:

![Dialog box for saving present workspace]

To save the present window configuration, one selects the option (Save present workspace), inputting a name to identify that configuration.

If, on the contrary, what one wishes is to reestablish a previously saved window configuration, this is chosen on the list of available configurations. After clicking the button OK, the window configuration selected is displayed on screen.

E-mail configuration

The project manager may activate the option for automatic notification of changes in elements by sending e-mails. In order for that option to work, it is also necessary to configure the mail on each one of the IRQA® clients from which those messages are to be sent.

To be able to configure the e-mail, one must select the option E-mail of the menu Tools>Configuration. The
following dialog box will open:

```
Email configuration

User
Login: 
E-mail: 
E-mail From: 
Authentication mode: AUTH LOGIN
Name: Edward Collins
Password: 

Server
Machine/ IP Address: visure
Port: 

Dial up
Auto connect to the Internet
Bind to: ANY_IP_ADDRESS

Save Exit
```

This window is used to fill in the user data, the server data, if any, and that of the Dial when connected by modem. The user data shown are the name, address, and the address that will appear as sender of the e-mail.

If the “E-mail from” field is empty, the address that will appear for the person responsible for the sending will be the user’s e-mail address. This information is configured in the Administration Center and cannot be modified in this dialog.

The authentication method must be chosen from those shown on the fold-down menu, which are: CRAM MD5, AUTH LOGIN, LOGIN PLAIN or (NONE). It is also necessary to input the user name and password for the mail server to be used.

In the server data, one must input the name or IP address and port number.

As for the modem connection data, the address to be linked to must be chosen from the fold-down menu.

Repository names management

This feature allows deletion or name change of the DSNs or connections to existing repositories, also showing the relevant type of driver (reference ODBC to data bases of Microsoft Access, SQL Server, Oracle, MySQL).

To do so, one must select the option Manage repository names in the Project menu. Then the following view is shown:
If the Filter box is not selected, the fold-down will show all the DSNs in the system that can be viewed with the current user. With the Filter box selected, only the DSNs of IRQA® will be shown, that is, those with the prefix “IRQA_”.

The column “System” indicates the type of DSN, that is, System DSNs are marked with a symbol “*”; the rest are User DSNs.

When a DSN is selected from the list, there is the possibility of disconnecting it from IRQA or renaming it. To rename a DSN, it must previously be selected and the name changed in the lower box. When the name is changed, the button Rename is activated and must be clicked for the name change to be effective.

One must bear in mind that the option Delete DSN only eliminates the connection to the data base (DSN) but does not delete the repository where the projects are located.

System check-up

This feature is accessible by selecting the option Check system on the menu Tools. It checks different aspects of the system, showing the version of each one.

Each one of them will be shown in red if the version is not appropriate for correct operation of IRQA®, and will show a message concerning the reason why that version is not adequate. The aspects the system checks are as follows:

- **Version of the operating system.**
- **Version of Internet Explorer.**
- **Version of the file Comctl32.dll**: Failure to update this file causes deficient viewing of certain controls such as the buttons on the tool bar. This is due to an non-updated version of the Microsoft browser (Internet Explorer).
- **Version of the file HHctrl.ocx**: This is a necessary file to be able to read the Microsoft help file (HtmlHelp). The help files in IRQA® are in that format, which requires a file (hh.exe) within the Windows directory.
- **Version of MS Access ODBC Driver**: There are some versions of the ODBC driver in which the test
equipment of IRQA® has detected certain bugs.

- **Version of SQL Server ODBC Driver.**
- **Version of Oracle ODBC Driver.**
- **Version of MySQL ODBC Driver.**
- **Version of Windows Sockets 32bits 2.0:** An error may arise if the operating system of the client machine is Windows 95 and it does not have the library winsock2.dll in the directory windows\system32.
- **Version of the parser XML.**

If any of these elements is shown in the color blue, it means that the version detected may not be adequate for operation with IRQA®, but one may not assure that only by checking the version number.

The window of the system checking window has the following appearance:

![System Checking Window](image)

---

**Changing license server**

The user may change the IRQA® license server he is connected to by performing the following steps:

- Select the option Tools>Disconnect from license server.
  
  This action has the effect that the next time IRQA® is opened, that is, in the present session IRQA® will remain connected to the server it is working on up to that moment.

- Select the new license server in the dialog box that appears the next time an attempt is made to open the IRQA® client. This process is the same as followed the first time IRQA® is run after the installation process.

- A dialog box appears with the following message:
When you click on “Yes”, the following dialog box will appear, to choose the new machine to act as license server and connection port:

![Client dialog box]

**List of windows**

The Window menu shows a list of the views and diagrams that have been opened by the user.

When a view is selected on this menu, the user will return to it as it was, the last time it was displayed. It is helpful to click the *Refresh Information* button on the Elements toolbar to guarantee that the information displayed includes all of the changes that you may have made while moving through other views.

The diagrams show changes that are made in other views automatically, for example, the modification of the name of an element included in the diagram.

**Automatic refresh**

When selecting a window in the Window menu, the information is automatically refreshed only if this option is active.

To activate it, the user must select the option Tools > Configuration > Automatic refresh.

By default this option is not active.

**Hotkeys**

**Grid panel**

- Ctrl + X : Cut
- Ctrl + C : Copy
- Ctrl + V : Paste
- Ctrl + Z : Undo
- Ctrl + O : Open
- Ctrl + P : Print
Shift + SUPR: Delete element  
F1: Help (of the selected element)  
F5: Refresh + adjust column width  
Ctrl + TAB: Next view  
Ctrl + Shift + TAB: Previous view  
F6: Next view  
Shift + F6: Previous view  
INS: Insert element  
Shift + INS: Insert child of the selected element (available for requirements and test scenarios)

**Tabs panel**

Ctrl + Tab: Next tab  
Ctrl + Shift + Tab: Previous Tab

**Description panel**

The description panel uses the following shortcuts:

**Font**

Alt + 0: Normal  
Ctrl + B: Bold  
Ctrl + U: Underline  
Ctrl + D: Double Underline  
Ctrl + I: Italics  
Alt + 4: Superscript  
Alt + 5: Subscript  
Alt + 6: Strike  
Alt + 10: Fonts…  
Ctrl + H: Hidden  
Alt + H: Hyperlink

** Paragraph**

Alt + 8: Center  
Alt + 9: Right Justify  
Alt + L: Indent Left  
Alt + R: Indent Right  
Alt + T: Hanging Indent

**Edit**

Ctrl + X: Cut
Ctrl + C: Copy
Ctrl + V: Paste
Ctrl + Z: Undo
Ctrl + Y: Redo

Insert
Alt + F8: Link Picture

Tools
Ctrl + F: Search forward
Ctrl + Shift + F: Search backwards
F6: Replace
F10: Jump…

Copying elements

Through the buttons Copy and Paste (or the Ctrl + C and Ctrl + V keys), it is possible to copy one or several elements and perform the following operations:

- Paste them in a text editor.
- Paste them in the view of the same element in the same project, meaning that these elements will be duplicated in the same project.
- Paste them in the view of the same element in another project, meaning that the elements of an IRQA project will be copied in another one.

Copying elements

In general, the following information is copied:

- Code (for those elements that are identified using a code).
- Name.
- Description.

If the identifier of the element to be copied (code or name) already exists in the project where it will be pasted, the code or name will correspond to the copied element, with the characters “(1)” added at the end.

When the selected elements are going to be pasted, the user must select the access partition to which the newly created elements will belong. By default, the tool always proposes the first available partition in alphabetical order.

If there is an active block and/or domain, the newly-created elements will be assigned to the domain and/or block if possible.

As far as versions are concerned, the following considerations must be taken into account:

- If any of the elements that are going to be duplicated have more than one version, you will be asked to specify whether you want to copy the last active version or the entire version log of the selected elements.
- The newly-created elements will be in “Checked-out” status by the user who made the copy.
- For some elements, the copy option has special characteristics:
- Copy of scenarios and test scenarios include the detailed description with steps. If the actor appearing in...
some step does not exist in the project, it is newly created.

- Attributes: It is not possible to copy the entire version log; only the active version is copied. In order to copy an attribute, there must exist in the project an attribute type with the same name and base type as the original attribute.

- Attribute types: It is not possible to copy the entire version log; only the active version is copied.

- Blocks and domains: Copy of blocks and domains does not imply that in the newly created element, the elements belonging to the original block or domain are also included.

- Blocks: It is not possible to copy the entire version log; only the active version is copied.

### Special copy of elements

There exist a special copy option that allows duplication of elements together with copy of their attributes and relationships. Generally speaking, the copied information is the following:

- Code (for those elements that are identified using a code).
- Name.
- Description.
- Associated files.
- Values of attributes.
- Inclusion in domains.
- Relationships between requirements, services and test scenarios.

The specific function of this option depends on the type of element that is copied, applying the previous rules in each case. For instance, if actors are copied, the copied features are only name, description, attributes and inclusion in domains.

When the special paste is used between two different projects, the following considerations should be taken into account:

- Hierarchical links between the selected elements are also created between the newly-created elements. This is the only hierarchy that is copied. For instance, if the selected elements are children of a requirement (or test scenario) that is not selected, this hierarchical link is not kept.

- Values of attributes will be copied only if attributes previously exist in the target project, with the same type as in the source project.

- Even if the attribute exists, if the value of the attribute that is to be copied does not exist or is out of range in the target project, the attribute value will not be copied, and the element will take the default value for the attribute in that project, in case it belongs to the scope of the attribute.

- Only links between copied elements or with elements already existing in the target project are copied. For instance, if requirements are copied, other requirements or services or test scenarios are not created in the target project just because they are related to the copied requirements in the source project.

To use this option, after selecting the elements and clicking on the Copy button, the Special paste option in Edit menu must be selected.

The tool will ask for confirmation, warning that also attributes and related elements are going to be copied. If the user decides not to confirm it, the elements are not duplicated.

### Copying diagrams

Diagrams are copied as follows:
- In an open diagram, graphically select the elements and the relationships between them that you want to duplicate.
- Click Copy.
- A diagram of the same type will be opened in the same or another project.
- Click Paste.
- Select the access partition with which the newly-created elements will be associated.

The elements and relationships selected in the original diagram will be included in the diagram.

If the elements to be included in the diagram do not exist in the destination project, they will be created as new elements in that project. In the case of versionable elements, the newly-created elements will be checked-out by the user who makes the copy.

If an active block and/or domain exist in the project where the copy is pasted, the newly-created elements will be assigned to the block and/or domain, if possible.

**Warning:** In IRQA 4 version 1 copy/paste of diagrams is not available.
Annex I. IRQA® connectivity to Data Bases

IRQA® uses open commercial data bases as project repositories, thus taking advantage of the facilities these offer, which allows it to avoid the difficulties and problems of proprietary repositories. IRQA® supports various architectures, depending on where the license server and data base used as a repository by IRQA® are located. The access to these archives may be obtained through a local network or by Internet. On the other hand, different types of Relational Data Base Management Systems (RDBMS) may be used to store the IRQA® projects.

The following is a description of the connection mode of the tool with a data base and the different data base managers that may be used with IRQA®.

Connection to data bases

IRQA® may use different RDBMS to store projects. IRQA® will use ODBC to connect to the different RDBMS. DSNs will be used for project connection and identification.

ODBC (Open Database Connectivity) is a standard protocol for access to the information in SQL data bases, such as, for example, Microsoft SQL Server, in a uniform manner. IRQA® allows some projects to be stored in a specific RDBMS (e.g. MS Access) and others in another RDBMS (e.g. Oracle), which provides an enormous flexibility and scalability.

DSN (Data Source Name) is the name used by IRQA® to identify a data base with which it communicates.

The information needed in each case to create the DSNs will be provided by the administrator of IRQA® projects.

The data base managers supported by IRQA® are:

- **Microsoft Access**
  The information of IRQA® projects will be stored in a Microsoft Access data base (.mdb file), that is created by IRQA® when it creates a project repository.

  To create the DSN for connection to the repository, it is only needed to select this file, which should be available in a folder to which the user has access. The user should also have writing rights on the file in order that IRQA® allows the creation of the DSN.

- **Microsoft SQL Server**
  To create the DSN for connection to the SQL Server repository, the following data must be input:
  - Name of the server in which SQL Server is installed.
  - Name of the SQL Server data base that stores the IRQA® projects.
  - User and password valid to access this data base.

- **Oracle**
  The requirements to access IRQA® projects stored in ORACLE are as follows:
  - ORACLE client.
  - ORACLE ODBC driver. This driver can be found in the IRQA® installation CD.
  - ORACLE Universal Installer. It is needed to install the aforementioned ODBC driver.

  To create the DSN for connection to the ORACLE repository, the following data must be input:
  - User and password for connection to the ORACLE data base.
• Service. It is the name of the Local Network Service used to access the ORACLE database.
• Tablespaces where tables and indexes are stored inside the ORACLE database.

MySQL
To create the DSN for connection to the MySQL repository, the following data must be input:
• Name of the MySQL server that contains the repository.
• Connection port to the MySQL server.
• Name of the MySQL database that stores the IRQA® projects.
• User and password valid to access this database.
Annex II. IRQA® 4 Good practices

The objective of this chapter is to summarize suggestions to make IRQA 4 users feel more comfortable working with our product.

It is important to understand that these practices do not constitute by themselves "a solution" to future incidents; however, they can help significantly to improve the impression perceived by the final user.

Working with large projects

Architecture

When LAN connection between subsidiaries is not fast enough we recommend adopting remote access technology like Citrix or remote desktop.

The double challenge when using remote access technology is to support growth with fast delivery of business applications and reduce the response times when LAN connection between subsidiaries is not quick enough.

Client Hardware requirements

When working in a production environment we recommend PC Pentium IV with 120 MB free disk space and dedicated 1GB RAM.

Supported databases

After five cycles of performance tests were made, we recommend running IRQA 4 over ORACLE. Our second option is SQL Server.

The IRQA repository should be included on the corporate database administration process: tuning, maintenance and backup process.

Warning: We recommend assigning the value 256.000 to ORACLE driver setting ‘Fetch Buffer Size’. This value of fetch buffer size lets IRQA4 have a better performance reducing the traffic between IRQA database and client.
IRQA Administration Center

We recommend working with different repositories; the number of repositories should be determined according to the type of project. It does not make sense to have only one repository with a lot of projects that have nothing in common.

IRQA Client

In order to reduce the time response when working with the IRQA client, we recommend:

1. Open the description panel and the properties window only when it’s really necessary.
2. When browsing through requirements with the properties window open, select the appropriate tab: for example, Related Elements tab takes more time to load than the Details tab.
3. Requirements with very long descriptions penalize performance: the requirement description should be concise and the files associated to the requirements should be included on Associated Files tab. The Document View is specially affected by requirement description size.
4. Work always with views that really contain the necessary elements: if possible, reduce the number of elements included on the view. This recommendation is especially useful when working with the Document View.
5. When filtering the Document View we recommend apply Active Block filter instead of common filter, it should be more efficient.
6. Related elements are more quickly deployed as a column in the grid of the view than in the tab of the Properties window.
7. Creating several views for analyst reviewing: changes between views with the same or different filter are now faster because it was reduced the database access using the client cache.
8. Use the new text filter: this new feature allows filtering through the entire grid information.

**Warning:** When working with IRQA 4 it is possible that the project opening takes now more time than in previous versions; more consistency checking and cache refreshing was included on this process.
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access partition (user management)</strong></td>
<td>Grouping elements of IRQA®. The elements are structured in this way in order that different users may have different access permissions to different groups of elements.</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Each one of the actions carried out by an actor (in the case of OO modeling) or an external entity (in the case of functional modeling) of a scenario.</td>
</tr>
<tr>
<td><strong>Active baseline</strong></td>
<td>Baseline that is selected by the user in IRQA® client. If the active baseline is different from the current baseline, no data can be modified.</td>
</tr>
<tr>
<td><strong>Active project</strong></td>
<td>Project being worked on at a specific moment. When there are several projects open simultaneously, the active project is that which has one of its views active.</td>
</tr>
<tr>
<td><strong>Actor</strong></td>
<td>Any entity (person or system) outside the system, that interacts with it.</td>
</tr>
<tr>
<td><strong>Admin</strong></td>
<td>User created by default in all the projects. Has administrator privileges.</td>
</tr>
<tr>
<td><strong>Aggregation</strong></td>
<td>Type of relation between concepts, involving a meaning of dependence on the concept contained, in relation to the concept containing it.</td>
</tr>
<tr>
<td><strong>Analysis</strong></td>
<td>Phase concentrating on construction of the Domain Model of the Problem, along with Classification of the requirements in relation to the elements of that model.</td>
</tr>
<tr>
<td><strong>Associate</strong></td>
<td>To relate elements together (requirements, concepts, services, etc.).</td>
</tr>
<tr>
<td><strong>Association</strong></td>
<td>Type of relation between concepts that indicates that there is a relation of some kind between the concepts related: logical, semantic, physical, of communication, etc., that is not hierarchical (heritage) or by aggregation.</td>
</tr>
<tr>
<td><strong>Attribute (I)</strong></td>
<td>This appears in the model of concepts or entities; it refers to a characteristic of a concept or entity, so each concept or entity has a value for each one of its attributes.</td>
</tr>
<tr>
<td><strong>Attribute (II)</strong></td>
<td>The attributes of elements are characteristics associated with specification elements, so each one of the elements acquires those characteristics, and their value may be specified separately for each individual element. The scope of the attribute determines the set of elements for which the attribute will take values.</td>
</tr>
<tr>
<td><strong>Author</strong></td>
<td>User of the project who is responsible for creation of an element.</td>
</tr>
<tr>
<td><strong>Baseline</strong></td>
<td>Set of all elements of an IRQA® project, where each of them appears in a specific version. All links between elements also belong to the baseline.</td>
</tr>
<tr>
<td><strong>Binary association</strong></td>
<td>Relation of association involving two concepts.</td>
</tr>
<tr>
<td><strong>Bit Map</strong></td>
<td>Graphic in BMP format.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>This is a group of elements of the same type, with some common characteristic.</td>
</tr>
</tbody>
</table>
Capture

Phase in which the requirements are input into the project.

Cardinality

Cardinality is a concept of a relation that indicates how many instances of that concept are related with a sole instance of the other concept.

Classification

Type of relation between concepts. See Inheritance.

Component

Reuse unit in IRQA®. It is a set of requirements, services and test scenarios, including the links between them and one or several of their attributes. These components can be available to be reused in other projects of the repository.

Concept

Represents a relevant entity of the domain of the problem analyzed, encompassing its structure and behaviour.

Concept diagram

Graphic representation of the object oriented opening of the problem, representing views of the concepts and their relations. May be used to represent the conceptual data model at system high level.

Concept functional model

Describes the structure of the entities of the problem: their identity, their content (attributes) and their relations with other entities.

Concept model

Describes the structure of the concepts of the: their identity, relations with other concepts, their attributes and their operations.

Context Diagram

DFD at a higher level. Represents the system as a whole, along with the external entities with which it exchanges information.

Contextual menu

See floating menu.

Criteria

The requirements are filtered on the basis of selection criteria that match the different types of elements of the project and its values: author, date of creation, concept, etc.

Current baseline

Baseline containing the most updated version of the Project elements. It is the default active baseline, that is, the one selected by default when a project is open.

Data Base

Information storage system for one or several projects.

Data Flow

Set of data exchanged as input or output of a process.

Data store

Data archive that is accessed by the processes to consult or input information.

Date

Information associated with the elements, that shows the date on which they were created or modified. In addition to that, the tests cases are displayed as associated information, showing their date of execution.

DFD (Data Flow Diagram)

Graphic representation of a software system showing the origin of data, processes and logical flows of data. The Yourdon classical notation is used.

Diagram

Graphic representation of a model. See Graphic editor of the concepts and functional model, and Graphic editors for services specification.
**Dissociate**

To eliminate a relation between elements of the project.

**Domains**

A domain is a set of any elements of the specification that have any characteristic of the business in common. The organization of domains is a way to classify the elements of the specification on the basis of criteria related to aspects of the problem that is being analyzed.

**Element**

Any of the concepts managed within IRQA®, such as requirements, concepts, services, attributes, diagrams, etc.

**Entity**

In an entity-relation model, the main object on which information is gathered. In functional modeling, it matches the Concept in object oriented modeling.

**Entity-Relationship Diagram**

Graphic representation of the problem model in functional mode, where views of the entities and their relations are represented. It may be used to represent the conceptual data model at system high level.

**Event**

Event that occurs at a specific moment and time and that triggers off a process.

**Exclude**

Eliminate an element of a diagram, but not of the project.

**External entity**

Agent outside the system, that communicates with it by sending and receiving flows of data.

**Field**

Contains a specific, indivisible part of the information of an element.

**Filter**

Specifies the set of selection criteria to filter all the elements to be viewed. For example, a filter may be applied to view only the requirements input by a specific author, or associated with a specific value of an attribute.

**Floating menu**

Menu that appears when right clicking with the mouse.

**Graphic editor of concepts model**

Window that allows graphic definition of the concepts of the model and the relations between them.

**Graphic editor of Data Flow Diagram**

Window that allows graphic definition of the detailed description of the services using the processes and data flows notation (Yourdon notation).

**Graphic editor of Entity-Relationship model**

Window that allows graphic definition of the entities of the model and the relations between them.

**Graphic editor of sequence diagram**

Window that allows graphic definition of the concepts and actors of the model and the messages exchanged between them. It can be used to allow graphic definition of the detailed description of services using the sequence diagram notation (UML notation), or to describe graphically the business model of the problem under study.

**Graphic editor of state diagram**

Window that allows graphic definition of the detailed description of the services using the state machines notation (UML notation).
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic editor of use case</td>
<td>Window that allows graphic definition of the detailed description of the</td>
</tr>
<tr>
<td>diagram</td>
<td>services using the use cases notation (UML notation).</td>
</tr>
<tr>
<td>Grid</td>
<td>Background grid used in all the diagrams that facilitates linking the</td>
</tr>
<tr>
<td></td>
<td>movement of the graphic elements and resizing them to a size which is a</td>
</tr>
<tr>
<td></td>
<td>multiple of the grid squares.</td>
</tr>
<tr>
<td>Image</td>
<td>Graphic representation of an aspect of the requirement, that is included</td>
</tr>
<tr>
<td></td>
<td>in a file with any graphic format and which may associated with the</td>
</tr>
<tr>
<td></td>
<td>requirement.</td>
</tr>
<tr>
<td>Implementation class</td>
<td>These represent the design classes in which the concepts of the conceptual</td>
</tr>
<tr>
<td></td>
<td>model defined during the specification phase of IRQA® are evolved. The</td>
</tr>
<tr>
<td></td>
<td>IRQA® implementation classes are simply an image of the design classes that</td>
</tr>
<tr>
<td></td>
<td>have been created in a design tool. Due to this, they cannot be edited in</td>
</tr>
<tr>
<td></td>
<td>IRQA®.</td>
</tr>
<tr>
<td>Include</td>
<td>Add an element that has already been created in the project to a diagram.</td>
</tr>
<tr>
<td>Inheritance</td>
<td>Type of association that indicates a hierarchy between concepts in which</td>
</tr>
<tr>
<td></td>
<td>one of them inherits the structure and/or behaviour of the other (called</td>
</tr>
<tr>
<td></td>
<td>base concept).</td>
</tr>
<tr>
<td>Login</td>
<td>User name formed by a chain with a maximum of 32 characters.</td>
</tr>
<tr>
<td>Management</td>
<td>Monitoring requirements based on their multidimensional classification in</td>
</tr>
<tr>
<td></td>
<td>relation to the set of attributes for management defined by the user.</td>
</tr>
<tr>
<td>MDI</td>
<td><em>Multiple Document Interface</em>: Integral Requisite Analyzer is a MDI</td>
</tr>
<tr>
<td></td>
<td>application that allows several projects to be opened simultaneously.</td>
</tr>
<tr>
<td>Model</td>
<td>Abstraction of the real world aimed at understanding the problem before</td>
</tr>
<tr>
<td></td>
<td>materializing a solution.</td>
</tr>
<tr>
<td>Multidimensional classification</td>
<td>Technique of classification that is applied to the requirements in relation</td>
</tr>
<tr>
<td></td>
<td>to the elements of the domain model of the problem.</td>
</tr>
<tr>
<td>Operation</td>
<td>Method provided by a concept. A method may be for access and modification</td>
</tr>
<tr>
<td></td>
<td>of attributes of an implementation concept, or may represent a more complex</td>
</tr>
<tr>
<td></td>
<td>behaviour of a concept.</td>
</tr>
<tr>
<td>Permission</td>
<td>Rights assigned to a user of a project to be able to read, create or</td>
</tr>
<tr>
<td></td>
<td>modify own elements or those of others.</td>
</tr>
<tr>
<td>Problem Domain Model</td>
<td>Abstraction of the real problem to establish the fundamental elements that</td>
</tr>
<tr>
<td></td>
<td>define the problem and how they are related. Includes a structured textual</td>
</tr>
<tr>
<td></td>
<td>representation with all the information and a graphic representation by</td>
</tr>
<tr>
<td></td>
<td>means of one or several diagrams that manage that information. The model</td>
</tr>
<tr>
<td></td>
<td>will be called Concept Model (if Object Oriented Methodology is applied),</td>
</tr>
<tr>
<td></td>
<td>or Entities Model (if Functional Methodology is applied).</td>
</tr>
<tr>
<td>Process</td>
<td>Function or capacity of a system consisting of a series of operations</td>
</tr>
<tr>
<td></td>
<td>performed on flows of input data that transforms them into output data.</td>
</tr>
<tr>
<td>Project</td>
<td>Basic working unit of the Integral Requisite Analyzer. Within a project,</td>
</tr>
<tr>
<td></td>
<td>the elements of IRQA® that collaborate together to characterize a problem</td>
</tr>
<tr>
<td></td>
<td>to solve are globalized.</td>
</tr>
</tbody>
</table>
Property of a block  The properties of a block are attributes associated with a block, with a specific value in each case.

Reflexive association  Relation of association in which a same concept is involved twice, with two different roles.

Report  Document that contains part of the information on the project and which may be viewed, printed or exported to different document formats.

Requirement  Unit specification of the behaviour the system must have. It is an informal specification, but one that is sufficiently clear to be able to be used to identify the elements of the models based on it.

Requirements Model  Set of characterized and organized user requirements.

Reusable Component  Component that has been created in another project of the repository and that has been published so that it can be reused in the project in which it is being viewed.

Reuse Mode  Level of reuse for a component that is being reused in the target project. There are three options: share (the component can only be modified in the target project in a very limited way; if a new version of the component is published, the target project gets notified and elements can be updated), copy and link (the elements of the component are copied to the target project, where they can be modified unrestrictedly; if a new version of the component is published, the target project gets notified and elements can be updated), copy (the elements of the component are copied to the target project, where they can be modified unrestrictedly; if a new version of the component is published, no information is sent to the target project).

Role  Role played by a concept or entity in a specific relation.

Scenario  Description of a series of events that take place sequentially. These may be scenarios of services or tests, allowing description of services as well as test cases.

Scope  Set of elements for which an element attribute takes individual values. It can be all elements of a given type (requirements, test scenarios, etc.) or one or several specific blocks (for example, user requirements, performance tests, services of subsystem 1, etc.).

Service  Specification of a unit function of the system. It is the way in which the system fulfils a responsibility.

Services Model  Set of services defined to obtain a specification of the requirements.

Sequence Diagram  Graphic representation of the interaction between concepts and between them and actors. It shows messages exchanged between these elements in a sequential order.

Source project  Project in which a component is created.

State  This is a condition in the life of a concept or an interaction during which a condition is satisfied, an action is performed or one waits for an event to occur.
State Diagram

Describes the possible behaviours of any dynamic of the model. Represents the different states and the transitions between them. The behaviour is modeled with state nodes interconnected by one or more transition arcs, triggered off by a series of events.

Static Model

Model that describes the static behaviour of the concepts of the problem, without taking into account their evolution in time or specific situation.

System

Entity being modeled that will be responsible for fulfilling the requirements imposed.

Target project

Project in a repository for which a component is published, meaning that its elements can be reused in this project.

Tertiary association

Relation of associations involving three concepts.

Test Case

Materialization of a test environment to determine, hardware, instrumentation, tools, simulators and other supports required to test a system or component of the system. In our case, it will allow one to test the requirements contained in the specification.

Tool Bar

Set of commands in button format that provide access to some operations on the elements of each screen.

Tree

Structure displaying the elements of a model in hierarchical format.

Type

Category of an attribute or an operation within a concept.

Type of attribute

Category of an attribute of elements or a block property.

UML (Unified Modeling Language)

Notation used in graphic editors of concepts, state machines, sequence diagrams and use cases.

Use case

Defines the behaviour of a system without revealing its internal structure Each use case specifies a functionality the system may use, interacting with external actors.

Use case diagram

Shows the services in the system and their interaction with the actors.

User

Each one of the persons with permission to work on a data base with IRQA® projects.

View

Screen that shows each part of the information on a project. The project is comprised of several views that may be shown simultaneously and remain synchronized between each other, so if one element appears in several views, if it is modified in one of them it is updated in the others.

Workflow

Transitions allowed between the possible values of an enumerated attribute, and that can only be performed by authorized user groups.

Window

See View.